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The following is a history of the Model 3550/3560 Series Integrating 
Nephelometer Instruction Manual, part number 1933563. 
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A May 1996 
B April 1997 
B1 July 1998 
C December 2000 
D April 2001 

 
This manual was first published, in preliminary form, February 
1994. 
 
This manual was published as a preliminary 1 in August 1994. 
 
This manual was published as a preliminary 2 in September 1994, 
additions of text and figures were made throughout manual, 
Chapter 5 was added, and Chapter 8, “Troubleshooting Guide,” was 
deleted. 
 
The manual was published as a Final after Chapter 5, “Using 
Nephelometer Software (Windows)” was added in November 1994. 
 
In revision A, TSI’s “Limitation of Warranty and Liability” on page iii 
was updated.   
 
In revision B, Tables A-1 and A-2 in Appendix A were revised. 
 
In revision B1, TSI’s area code changed from 612 to 651. 
 
In revision C, TSI’s Limitation of Warranty and Liability and TSI’s 
Software License were updated. 
 
In revision D, Analog Outputs were removed.  
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Part Number 1933563 / Revision D / April 2001 

Copyright ©TSI Incorporated / 1994–2001 / All rights reserved. 

Address TSI Incorporated / 500 Cardigan Road / P.O. Box 64394 / St. Paul, MN  55164 / 
USA 

Fax No. (651) 490-3860 

Email Address particle@tsi.com 

Limitation of Warranty 
and Liability 
(effective July 2000) 

Seller warrants the goods sold hereunder, under normal use and service as 
described in the operator's manual, shall be free from defects in workmanship and 
material for (12) months, or the length of time specified in the operator's manual, 
from the date of shipment to the customer. This warranty period is inclusive of any 
statutory warranty.  This limited warranty is subject to the following exclusions: 

a. Hot-wire or hot-film sensors used with research anemometers, and certain other 
components when indicated in specifications, are warranted for 90 days from 
the date of shipment. 

b. Parts repaired or replaced as a result of repair services are warranted to be free 
from defects in workmanship and material, under normal use, for 90 days from 
the date of shipment. 

c. Seller does not provide any warranty on finished goods manufactured by others 
or on any fuses, batteries or other consumable materials. Only the original 
manufacturer's warranty applies. 

d. Unless specifically authorized in a separate writing by Seller, Seller makes no 
warranty with respect to, and shall have no liability in connection with, goods 
which are incorporated into other products or equipment, or which are modified 
by any person other than Seller.  

The foregoing is IN LIEU OF all other warranties and is subject to the LIMITATIONS 
stated herein. NO OTHER EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR 
PARTICULAR PURPOSE OR MERCHANTABILITY IS MADE. 

TO THE EXTENT PERMITTED BY LAW, THE EXCLUSIVE REMEDY OF THE USER 
OR BUYER, AND THE LIMIT OF SELLER'S LIABILITY FOR ANY AND ALL LOSSES, 
INJURIES, OR DAMAGES CONCERNING THE GOODS (INCLUDING CLAIMS BASED 
ON CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY OR OTHERWISE) SHALL 
BE THE RETURN OF GOODS TO SELLER AND THE REFUND OF THE PURCHASE 
PRICE, OR, AT THE OPTION OF SELLER, THE REPAIR OR REPLACEMENT OF THE 
GOODS. IN NO EVENT SHALL SELLER BE LIABLE FOR ANY SPECIAL, 
CONSEQUENTIAL OR INCIDENTAL DAMAGES. SELLER SHALL NOT BE 
RESPONSIBLE FOR INSTALLATION, DISMANTLING OR REINSTALLATION COSTS 
OR CHARGES. No Action, regardless of form, may be brought against Seller more 
than 12 months after a cause of action has accrued.  The goods returned under 
warranty to Seller's factory shall be at Buyer's risk of loss, and will be returned, if at 
all, at Seller's risk of loss. 

Buyer and all users are deemed to have accepted this LIMITATION OF WARRANTY 
AND LIABILITY, which contains the complete and exclusive limited warranty of 
Seller. This LIMITATION OF WARRANTY AND LIABILITY may not be amended, 
modified or its terms waived, except by writing signed by an Officer of Seller. 
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Software License  
(effective March 1999) 

1. GRANT OF LICENSE. TSI grants to you the right to use one copy of the 
enclosed TSI software program (the “SOFTWARE”), on a single computer. You may 
not network the SOFTWARE or otherwise use it on more than one computer or 
computer terminal at the same time. 

2. COPYRIGHT. The SOFTWARE is owned by TSI and is protected by United 
States copyright laws and international treaty provisions. Therefore, you must 
treat the SOFTWARE like any other copyrighted material (e.g., a book or musical 
recording) except that you may either (a) make one copy of the SOFTWARE solely 
for backup or archival purposes, or (b) transfer the SOFTWARE to a single hard 
disk provided you keep the original solely for backup or archival purposes. 

3. OTHER RESTRICTIONS. You may not rent or lease the SOFTWARE, but you 
may transfer the SOFTWARE and accompanying written material on a permanent 
basis, provided you retain no copies and the recipient agrees to the terms of this 
Agreement. You may not reverse-engineer, decompile, or disassemble the 
SOFTWARE. 

4. DUAL MEDIA SOFTWARE. If the SOFTWARE package contains multiple types 
of media, then you may use only the media appropriate for your single-user 
computer. You may not use the other media on another computer or loan, rent, 
lease, or transfer them to another user except as part of the permanent transfer 
(as provided above) of all SOFTWARE and written material. 

5. U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE and 
documentation are provided with RESTRICTED RIGHTS. Use, duplication, or 
disclosure by the Government is subject to the restrictions set forth in the “Rights 
in Technical Data and Computer Software” Clause at 252.227-7013 and the 
“Commercial Computer Software - Restricted Rights” clause at 52.227-19. 

6. LIMITED WARRANTY. TSI warrants that the SOFTWARE will perform 
substantially in accordance with the accompanying written materials for a period 
of ninety (90) days from the date of receipt. 

7. CUSTOMER REMEDIES. TSI’s entire liability and your exclusive remedy shall 
be, at TSI’s option, either (a) return of the price paid or (b) repair or replacement of 
the SOFTWARE that does not meet this Limited Warranty and which is returned 
to TSI with proof of payment. This Limited Warranty is void if failure of the 
SOFTWARE has resulted from accident, abuse, or misapplication. Any 
replacement SOFTWARE will be warranted for the remainder of the original 
warranty period or thirty (30) days, whichever is longer. 

8. NO OTHER WARRANTIES. TSI disclaims all other warranties, either express or 
implied, including, but not limited to implied warranties of merchantability and 
fitness for a particular purpose, with regard to the SOFTWARE and the 
accompanying written materials. 

9. NO LIABILTY FOR CONSEQUENTIAL DAMAGES. In no event shall TSI be liable 
for any damages whatsoever (including, without limitation, special, incidental, 
consequential or indirect damages for personal injury, loss of business profits, 
business interruption, loss of information or any other pecuniary loss) arising out 
of the use of, or inability to use, this SOFTWARE. 

Service Policy Knowing that inoperative or defective instruments are as detrimental to TSI as they 
are to our customers, our service policy is designed to give prompt attention to any 
problems. If any malfunction is discovered, please contact your nearest sales office 
or representative, or call TSI’s Particle Instrument Division at 1-800-874-3893 (USA) 
or (651) 490-3893. 

 



Safety  

v 

This section gives instructions to promote safe and proper handling 
of the Model 3550/3560 Series Integrating Nephelometers. 
 
 

!
 

C a u t i o n  
High temperatures that can cause burns.  

 To avoid personal injury, disconnect power to the Nephelometer and allow the 
halogen lamp and the lamp housing to cool before handling.  

 
 

 

W A R N I N G  
High voltages that can shock or burn. 

 The box that houses the photomultiplier tubes (PMT) contains a high voltage 
source. Components within this box should only be serviced by a qualified 
technician. Disconnect all power to the Nephelometer and contact TSI personnel 
before disassembling the PMT box. 

 
 

!
 

C a u t i o n  
Light sensitive components.  

 To avoid damage to the photomultiplier tubes (PMT), remove power from the 
Nephelometer and open the PMT box in subdued lighting. Exposing the 
photomultiplier tubes to direct light may affect tube performance.  

 
 

!
 

W A R N I N G  
Moving parts that can cause serious personal injury. 

 Disconnect power to Nephelometer before inserting anything into the aerosol 
inlet. The ball valve and position sensor are motorized and can move if power is 
applied. 
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L a b e l s  
Figure 1 shows the special warning and caution labels and their 
approximate location inside the Nephelometer. 
 

HIGH
TEMPE RATURES

LAMP AND SHIELD
M AY BE HO T

AND C AUSE BURNS.
TURN U NIT  OFF
AND  ALLOW  TO

CO O L BEFO RE
HAN DLING .

HIG H  VO LTAG E CO M PO NEN TS INSID E

D O  N O T O PE R AT E UN IT
W ITH  CO VER  REM O VED

 
Figure 1 
Nephelometer Warning and Caution Labels 
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P u r p o s e  
This is an instruction manual for the operation and maintenance of 
the Model 3550/3560 Series Integrating Nephelometers. 
 
 

 

R e u s i n g  a n d  R e c y c l i n g  

 

As part of TSI Incorporated’s effort to have a minimal negative 
impact on the communities in which its products are 
manufactured and used: 

❑  This manual uses recyclable paper. 

❑  This manual has been shipped, along with the instrument, in a 
reusable carton. 

 
 

 

S u b m i t t i n g  C o m m e n t s  
TSI values your comments and suggestions on this manual. Please 
use the comment sheet, located on the last page of this manual, to 
send us your opinion on the manual’s usability, to suggest specific 
improvements, or to report any technical errors. 
 
If the comment sheet has already been used, mail or fax your 
comments on another sheet of paper to: 

 
Particle Instrument Division 
TSI Incorporated 
P.O. Box 64394 
St. Paul, MN 55164 
Fax:  (651) 490-3860 
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N o t a t i o n a l  C o n v e n t i o n s  
This manual uses the following conventions when describing 
software: 

<Enter> Denotes the “Return” or “Enter” key on the 
keyboard. 

<xx> Denotes an alphanumeric key on the keyboard. For 
instance, <F4> means press the function “F4” on the 
keyboard.  

examples Examples of what you see on the screen and the text 
you type are shown in monospace type resembling 
computer output. 

italic Variable information in computer responses, 
commands, and options you must supply and type 
are shown in italics in a font that resembles 
computer font. 

UPPERCASE Uppercase letters indicate names of programs, files 
or commands. 

Bold Bold type indicates names of fittings as they appear 
on the instrument and commands appearing on the 
display. 

 
 

 



C H A P T E R  1  

Product  Overv iew 

1-1 

This chapter contains a product description and a list of features 
for the Model 3550/3560 Series Integrating Nephelometer, as well 
as a brief description of how the instrument works. 
 
 
 

P r o d u c t  D e s c r i p t i o n  
The Model 3550/3560 Series Integrating Nephelometer, shown in 
Figure 1-1, is designed for long-term monitoring of visual range and 
air quality in ground-based and airborne studies. It continuously 
monitors the light scattering coefficient of airborne particles. 
 

 

Figure 1-1  
TSI Incorporated's Nephelometer 
 
 
 

A p p l i c a t i o n s  
TSI Integrating Nephelometers are designed specifically for studies 
of direct radiative forcing of the Earth’s climate by aerosol particles, 
or studies of ground-based or airborne atmospheric visual air 
quality in clean areas. They may also be used as an analytical 
detector for aerosol particles whenever the parameter of interest is 
the light-scattering coefficient of the particles after a pretreatment 
step, such as heating, humidification, or segregation by size. 
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The light-scattering coefficient is a highly variable aerosol property. 
Integrating Nephelometers measure the angular integral of light 
scattering that yields the quantity called the scattering coefficient, 
used in the Beer-Lambert Law to calculate total light extinction. 
 
 

Beer-Lambert Law 
I/Io = e(-σx) 

 
where: 

Io = intensity of light source 
I = intensity of light after passing through atmospheric path 
x = thickness of medium through which light passes 
σ = total extinction coefficient 
 (= scattering coefficient + absorption coefficient) 
 
 
 

H o w  t h e  N e p h e l o m e t e r  O p e r a t e s  
A small, turbine blower draws an aerosol sample through the large 
diameter inlet into the measurement volume (Figure 1-2). There, 
the sample is illuminated over an angle of 7 to 170° by a halogen 
lamp directed through an optical light pipe and opal glass diffuser.  
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Figure 1-2 
A Cross-Section View of the Nephelometer 
 
 
The sample volume is viewed by three photomultiplier tubes (PMT) 
through a series of apertures set along the axis of the main 
instrument body. Aerosol scattering is viewed against the backdrop 
of a very efficient light trap. The light trap, apertures, and a highly 
light-absorbing coating on all internal surfaces of the instrument 
combine to give a very low scatter signal from the walls of the 
instrument. 
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Dichroic filters, in front of the PMT tubes, split and direct the light, 
which has been scattered by aerosol. The light is directed into three 
bandpass filters, blue, green and red. A constantly rotating 
reference chopper has separate areas to provide three types of 
signal detection. The first area gives a measure of the aerosol light-
scattering signal allowed by an opening in the rotating chopper. The 
second area blocks all light from detection and gives a 
measurement of the PMT dark current that which is subtracted 
from the measurement signal. The third area is a translucent 
portion of the chopper, illuminated by the halogen lamp, which 
provides a measure of the light-source signal. In this way, over 
time, any change in the light source or in detector efficiency is 
compensated. 
 
In backscatter mode, the backscatter shutter rotates under the 
lamp to block light in the 7 to 90° range. When light is blocked, 
only light scattered in the backward direction is transmitted to the 
PMT detectors. The backscatter signal can be subtracted from the 
total signal to calculate forward-scattering signal data. When this 
measurement is not of interest, the backscatter shutter can be 
“parked” in the total scatter position. 
 
Periodically, an automated valve built into the inlet can be activated 
to divert all of the aerosol sample through a high-efficiency (HEPA) 
filter. This gives a measure of the clean-air signal for the local 
environment. This signal is subtracted, along with the PMT dark-
current signal, from the aerosol-scatter signal to give only that 
portion of the scatter signal provided by the sample aerosol. 
Particle-scattering parameters for all three wavelengths of total and 
backscatter signal are continuously averaged and passed to a 
computer or data logger for permanent storage. 
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Unpacking and Set t ing  
Up the  Hardware  

2-1 

Use the information in this chapter to unpack and set up the 
hardware components of a Model 3550/3560 Series Integrating 
Nephelometer.  
 
This chapter contains these main sections: 

❑  Packing List 

❑  Unpacking instructions 

❑  Connecting power 

❑  Connecting a computer 

❑  Mounting the Nephelometer 

❑  Connecting an external blower 
 
 
 

P a c k i n g  L i s t  
Table 2-1 gives a packing list for the Nephelometer and the power 
supply module. The packing list for the Data Analysis Center is 
included in one of the two or three Data Analysis Center shipping 
cartons. 
 
Table 2-1 
Packing List with Accessories 

Qty Description Part Number 
1 Nephelometer 3551, 3553, 
   3561 or 3563 
1 Power supply module 3590 
1 Power supply cable 1035564 
1 Power cord (24 volts dc) 1035551 
1 Blower bypass 1035545 
1 Serial data cable (9-pin, 12 ft.) 962002 
1 Serial cable adapter (25F-9M) 962003 
1 Program disk (3.5 in. format) 1906118 
1 Instruction manual 1933563 
1 White HEPA filter 1602051 
1 Blue DQ filter 1602080 
1 Set (2) fan filters (foam inserts) 1602071 
1 Lamp (halogen) 2201111 
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U n p a c k i n g  I n s t r u c t i o n s  
The power supply module and power cord are in one box; the 
Nephelometer sensor, power cable, manual, software disk, and 
other accessories are in another box. Keep the packing material in 
case you have to send the Nephelometer back to TSI.  
 
The Nephelometer sensor comes fully assembled. If anything is 
missing or appears to be damaged, contact your TSI representative, 
or contact Customer Service at 1-800-874-3893 (USA) or (651) 490-
3893. Chapter 9, “Contacting Customer Service,” gives instructions 
for returning the Nephelometer to TSI Incorporated. 
 
 
 

C o n n e c t i n g  P o w e r  
This section describes connecting power to the power supply 
module and connecting the power supply module to the 
Nephelometer sensor, as well as using another power source for the 
Nephelometer sensor. 
 
 

Connecting Line Voltage to the Power Supply 
Module 
Use the line cord (supplied) to connect the TSI power supply 
module to any line voltage from 85–260 volts AC at 50–60 Hz 
(Figure 2-1). The auto-switching power supply automatically 
adjusts to the AC voltage provided.  
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Figure 2-1 
Power Supply Module 
 
 

Connecting the Power Supply Module to the 
Nephelometer 
The power supply module includes a 4-meter (12-ft.) cord with four-
conductor, quarter-turn quick connectors. Before connecting the 
cord, make sure the power switch is in the Off position. Connect 
the pin end to the power supply and the socket end to the POWER 
AC INPUT connector (Figure 2-1) on the Nephelometer sensor.  
 
The TSI power supply module can be oriented in any direction, but 
the cooling fan intake and exhaust vents should be free from 
obstructions at all times (Figure 2-2). 
 
Note: The power supply module contains no user-serviceable parts. 

If the module is not operating properly, use the information in 
Chapter 9, “Contacting Customer Service,” to contact TSI. 
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(25 mm)
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Figure 2-2 
Ventilation Requirements 
 
 

Using Another Power Supply  
As an option, you can connect the Nephelometer sensor to a 24–28 
volts DC source. The lamp power is maximum at the higher end of 
the DC range. You may order an extra cable (1035564) and wire 
one end by connecting the red wire to +, the white wire to –, and the 
green wire to chassis ground.  
 
 
 

C o n n e c t i n g  a  C o m p u t e r  
Connect the serial port of an IBM-compatible computer to the 
COM PORT connector on the Nephelometer sensor (Figure 2-3). Use 
the 4-meter cable provided, and if you need additional length, use a 
standard IBM 9-pin, serial extension cable.  
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Note: Refer to Chapter 4 for instructions on using TSI software and 
refer to Chapter 6 for information on using serial data 
commands.  

 

COM PORT 

 

Figure 2-3 
COM PORT Connector 
 
 
 

M o u n t i n g  t h e  N e p h e l o m e t e r  
You can mount the Nephelometer in a variety of positions 
depending on the application. Normally, the Nephelometer rests on 
its feet (Figure 2-4), but the best position is a vertical mount with 
the PMT box at the top and the light trap end at the bottom 
(Figure 2-5).  
 
Note: Other positions are possible but consider dust collection 

opposite the lamp or on the lens. Dust raises the background 
noise level and necessitates cleaning more often. 
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Figure 2-4 
Nephelometer Resting on its Feet 

 

 

Figure 2-5 
Nephelometer in the Optimal Orientation 
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Space Requirements 
The Nephelometer sensor requires a rectangular space (Figure 2-6). 
You also need to allow room for the power supply module, air 
ventilation, and a cable to reach the sensor. If you are using a 
computer to set up the sensor, allow space for that as well. 

 

12.2 in.
(310 mm)

11.8 in.
(300 mm)

.38 in.
(9.5 mm)

41.5 in.
(1055 mm)

9.5 in.
(241 mm)

11.5 in.
(292 mm)

1.0 in.
(25 mm)

10.0 in.
(254 mm)

34.6 in.
(879 mm)

Inlet and Outlet Ports

Mounting Holes

(a)

(b)

(c)

 

Figure 2-6 
As-Built Dimensions (Space Requirements) 
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Mounting Holes 
Use the four mounting holes, two on each leg, to mount the 
Nephelometer sensor (Figure 2-6c). Use four 6 mm (¼ in.) diameter 
bolts or screws to mount the instrument to a secure bracket, if 
needed. 
 
 

Inlet and Outlet Ports 
The inlet and outlet ports are 1 in. diameter female NPT (pipe 
threaded) fittings (Figure 2-6a). These fittings can be used with 
adapters to mate to smaller or larger rigid tubing or can be fastened 
directly to 1 in. pipe with a 1 in. NPT end. Rigid PVC tubing is often 
used to bring a sample into the instrument and to exhaust the 
sample from the instrument. 
 
Keep in mind that the inlet and outlet tubing should have at least 8 
inches of straight length to allow the cover to be easily removed for 
maintenance. 
 
 

Environmental Concerns 
The Nephelometer is a highly sensitive instrument that detects 
light-scattering from air (gas) molecules and particles present in the 
sample chamber. The Nephelometer also detects undesirable 
scatters from insects, birds, and rodents that may come into the 
sampling chamber. Pests can severely limit the Nephelometer’s 
ability to measure scattering from particles.  
 
One way to minimize pests is to use insect screens, fly, or insect 
traps in the upstream sampling line to prevent insects or small 
pests from coming into the sampling chamber. Use metal screens to 
prevent larger pests from coming into the sampling chamber.  
 
It is good to keep in mind that humidities above 50–70% will 
enhance scattering extinction (normally assumed to be small) by 
particles. You may want to consider a heater or desiccant on the 
inlet flow to keep the humidity below this level. Although the 
Nephelometer incorporates a heater in the body, this is intended to 
compensate for any cooling effects of the instrument body. It is not 
intended to reduce the humidity through the instrument. 
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If the instrument will be used to sample from a warm, moist 
environment, while located in a cooled enclosure, you should 
consider insulating the inlet tubing and using the Nephelometer 
heater feature (see H command in Chapter 6). 
 
In designing the inlet and plumbing systems, be aware that 
changes in building pressure or a venturi effect caused by high 
winds, can cause flow changes and reversals through the 
Nephelometer. 
 
Note: Minimize flow restrictions and particle loss when taking these 

measures. 
 
 
 

C o n n e c t i n g  a n  E x t e r n a l  B l o w e r  
You can use the Nephelometer with an external blower to move the 
sample though the instrument. If you use an external blower, you 
can remove the onboard blower and replace it with the blower 
bypass fitting to reduce pressure drop through the sampling 
volume.  
 
Note: You need custom software to control the external blower. As of 

this date, TSI software does not include an interface to control 
an external blower.  

 
To remove the onboard blower and install the external blower: 

1. Remove the top cover of the Nephelometer using the 
instructions in Chapter 8, "Performing Maintenance."  

2. Remove the two screws attaching the blower bracket to the 
Nephelometer (Figure 2-7). 

3. O-ring seals on the ports hold the blower in place. Firmly pull 
the blower away from the mounting plate.  

4. Insert the blower bypass fitting into the pair of holes previously 
occupied by the blower. 
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Figure 2-7 
Blower Bracket 
 

5. Install the external blower bypass fitting by pressing it into the 
hole in the mounting plate (Figure 2-8) and reattaching the 
blower bracket. 

 

 

Figure 2-8 
Mounting the External Blower 
 
 
 

Blower Bracket Screws (2) 

Mounting Hole 

Blower Bypass Fitting 
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C a l i b r a t i n g  t h e  N e p h e l o m e t e r  
After you set up the Nephelometer, take a sample reading and 
make a printout of the reading. To check the Nephelometer 
calibration, use the sample reading to compare with a reading 
taken during calibration. See the "Performing Calibration" section 
in Chapter 4 for the calibration procedure. 
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Operat ions Overv iew 

3-1 

Before you set up the Nephelometer, it is important to consider how 
you will use the data you collect. This chapter provides an 
operations overview with these main sections: 

❑  Serial Communications 

❑  Hardware Components 

❑  Setting Up Parameters 
 
For more detailed information on operating and timing parameters, 
refer to Chapter 6, "Using Serial Data Commands." 
 
 
 

S e r i a l  C o m m u n i c a t i o n s  
Nephelometer operation is controlled though the serial 
communications interface (COM PORT). After the Nephelometer is 
configured, data can be logged by a computer connected to the 
serial interface (COM PORT).  
 
Data gathered by a computer connected to the serial interface 
provides the greatest flexibility in the post processing of data.  
 
 
 

H a r d w a r e  C o m p o n e n t s  
This section describes some of the main hardware components of 
the Nephelometer from an operations standpoint. Refer to 
Chapter 8, “Performing Maintenance," for information on taking the 
Nephelometer apart and cleaning or replacing components. 
 
 

Power Failures 
The Nephelometer is designed to be a long term monitoring device 
with watch-dog circuitry. This circuitry allows the Nephelometer to 
restart itself automatically in the event of a power failure or 
disruption. Operating parameters are preserved in battery backed-
up RAM so that you do not have to reconfigure the Nephelometer 
after a power failure. 
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Lamp Power 
Lamp power is typically set to 75 watts power. This setting allows 
for a lamp life of approximately 2000 hours.  
 
In some cases, like airborne measurements of short duration, when 
fast response time (short averaging time) and high sensitivity are 
desired, you can increase the lamp power. Increasing the lamp 
power to 90 watts will improve sensitivity but will reduce the lamp 
life.  
 
 

Photomultiplier Tubes (PMTs) 
The Nephelometer PMTs convert scattered photons of light into 
electronic pulses that can be counted by internal processing 
electronics. The gain of each PMT is controlled by an applied 
voltage between 0 and 1200 volts DC. The voltages are set through 
serial data commands sent to the Nephelometer though its 
communications interface. PMT voltages are set at TSI for optimal 
sensitivity and usually do not require adjustment.  
 
Generally, increasing the voltage increases the gain, which results 
in higher sensitivity. However, increasing the voltage also increases 
the “dark current” of the PMT until a point is reached where the 
dark current is increasing faster than signal gain. As this occurs, 
sensitivity decreases.  
 
The PMT dark current is also affected by temperature. If the 
temperature of the environment is much above 70° F (21° C), as the 
dark current increases, sensitivity decreases and the PMT voltage 
may not be optimal. In this case, voltages may need to be lowered. 
 
 

Heater 
If the Nephelometer is installed in an air conditioned area and is 
sampling hot, humid air, use the Nephelometer heater to prevent 
condensation. Generally the Nephelometer produces enough heat to 
maintain a sample temperature that is equal to or above the inlet 
temperature. However, if the sample temperature is below that of 
the inlet temperature, condensation may occur, which affects 
particle scattering inside the instrument.  
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Blower Settings 
Unless the blower is turned off, the Nephelometer provides full 
power to the blower during an auto zero cycle. This allows the 
Nephelometer to have the blower set to a lower power during 
measurement (reducing contamination build-up) and a fast purge 
during the auto zero cycle. 
 
Response time is the time required for the Nephelometer to respond 
to a step change in aerosol scattering. Response time is a 
combination of the time for the actual aerosol to change within the 
instrument (as low as a few seconds) and the averaging time. The 
speed setting of the blower and restrictions in the flow path 
determine how long it actually takes the aerosol to be exchanged.  
 
 

Humidity and Temperature Sensors 
The Nephelometer has one humidity and two temperature sensors. 
The humidity sensor and one temperature sensor are located near 
the sample outlet and the other temperature sensor is located at 
the sample inlet.  
 
The outlet temperature sensor is positioned as close to the sample 
volume as possible to provide an accurate reading of the sample 
temperature. The outlet temperature sensor is used in the 
calculations as the sample temperature. 
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Temperature/Humidity Sensor

Temperature Sensor

 

Figure 3-1 
Humidity and Temperature Sensor Locations 
 
 
 

S e t t i n g  U p  P a r a m e t e r s  
This section discusses some considerations you should make 
before collecting data with the Nephelometer. This section contains 
these main subsections: 

❑  Operating Parameters 

❑  Timing Parameters 

❑  Polled and Unpolled Communications 
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Operating Parameters 
All of the Nephelometer's operating parameters are set with the 
serial interface through the COM PORT. While many of the 
operating parameters can be adjusted using a computer and the 
DOS-based software described in Chapter 4, all of the parameters 
can be set using the firmware commands described in Chapter 6 or 
by using the terminal emulation program on a computer.  
 
Note: Although many of the operating parameters are mentioned in 

this section, refer to Chapters 4 and 6 for instructions on 
actually setting the parameters. 

 
 
Sensitivity 

The aerosol scattering coefficient is the primary measurement of the 
Nephelometer. The coefficient is the light scattering by particles in 
units of inverse meters. Particle scattering is measured by taking 
the total scattering value of the sample and then subtracting 
contributions of scattering from air molecules (Rayleigh scattering) 
and the instrument background. Ultimately, the maximum 
sensitivity that can be achieved is relative to the amount of light 
detected or captured from the sample.  
 
Many factors relating to sensitivity have been addressed during the 
design of the Nephelometer. Sample averaging time and lamp power 
are the two primary user-controlled parameters affecting sensitivity.  
 
 
Backscatter Measurements 

Nephelometer Models 3561 and 3563 are equipped with a 
backscatter shutter. The motor-operated shutter either runs 
synchronously with the reference chopper (in backscatter mode) or 
is parked (in total scatter mode).  
 
When operating in backscatter mode, the Nephelometer is 
measuring total scatter half of the time and measuring the back 
scatter fraction the other half. In backscatter mode, Nephelometer's 
total scatter sensitivity drops by 0.7 [1 2/ ] because the sample 
time is effectively cut in half. For this reason the backscatter mode 
should be used only if backscatter data is desired.  
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Vibration can also be a consideration in choosing backscatter 
mode. During backscatter operation, vibration or rapid shifts in the 
position of the Nephelometer (when airborne, for example) can 
cause a loss of synchronization between the reference chopper and 
the backscatter shutter. No data is taken until synchronization is 
reestablished. Although loss of motor synchronization can be 
monitored via the status flags accessible through the serial 
interface (see RF command in Chapter 6), use the backscatter mode 
only when backscatter data is desired. 
 
 
Zero Baseline Measurements 

At times, the light scattering from particles can be very small 
compared to that of the air and the instrument background. The 
Nephelometer has built-in pressure and temperature sensors that 
provide compensation for the changes in the scattering of air as its 
density changes. This compensation, however, cannot correct for 
the value of the instrument's background scattering, which will also 
change over time as dirt and contamination from the sample 
deposit on the walls of the Nephelometer. 
 
The Nephelometer has a HEPA particle filter and a motorized valve 
that provide the ability to accurately measure the scattering from 
air and the instrument background. This zero baseline 
measurement (sometimes referred to as zero measurement) occurs 
when the Nephelometer switches the motorized valve at the inlet, 
causing all of the sampled air to flow through the high efficiency 
filter. Particles are eliminated from the air flowing through the 
Nephelometer and the scattering value measured by the 
Nephelometer is from air and instrument scatter.  
 
Particle-free air is measured for several minutes to obtain the zero 
baseline scattering value. The valve is again switched to remove the 
filter from the sample flow. Normal sampling resumes. The zero 
baseline value is used to obtain the actual instrument scatter. This 
value along with the scatter of air (determined from its temperature 
and pressure) are subtracted from the sample's total scatter signal 
to determine the scattering from particles.  
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Autozero Modes 

Zero baseline measurements can be initiated in three ways as 
determined by the autozero mode setting of the Nephelometer: 
manual, normal, and air-chop. Refer to the SMZ command in 
Chapter 6. 
 
 
Manual Mode 

In manual mode, an automatic zero measurement occurs only 
when initiated by a direct command to the communications port 
(see the Z command in Chapter 6).  
 
Once the command is received, the Nephelometer changes the 
position of the filtered air valve, measures the zero baseline value, 
and then repositions the valve for normal sampling.  
 
 
Normal Mode 

In normal mode, the Nephelometer makes an auto zero 
measurement at preset intervals (see "Time Parameters" in this 
chapter).  
 
 
Air-Chop 

Air chop mode is similar to normal mode, but the zero baseline 
calculation is based on two or more auto zero cycles. This mode is 
generally used in very “clean” (low particle scatter) environments. 
 
 

Time Parameters 
This section discuss the several user-controlled time parameters for 
Nephelometer operation. Also refer to Figures 6-2 and 6-3 in 
Chapter 6. These figures detail the Nephelometer timing sequences 
and the relationships between the time parameters described in 
this section. 
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Averaging Time 

The most important parameter is the “sample averaging time” or 
just “averaging time.” The averaging time value can be set between 
1 and 9999 seconds by using the software or by using the STA 
command (Chapter 6).  
 
Longer averaging times increase the Nephelometer's sensitivity at 
the sacrifice of response time. Sensitivity increases by the square 
root of the averaging time, so quadrupling of the sample time 
results in a doubling of the sensitivity. Typically, averaging times of 
less then 30 seconds are used only for testing purposes, or if the 
data is to be post-processed.  
 
 
Zero Time 

The “zero time” setting is the time the Nephelometer takes to make 
a zero baseline measurement. This time, which can be set between 
1 and 9999 seconds, is typically 300 seconds (see the STZ 
command in Chapter 6). Generally the zero time should not be less 
than the sample averaging time setting. 
 
 
Auto Zero Period 

The auto zero period occurs between subsequent zero 
measurements during normal or air chop modes. The auto zero 
period must be small enough to follow changes in instrument 
background due to the build up of contaminates. Generally a value 
of 3600 seconds is sufficient for ground-based measurements. For 
extremely clean environments where air chop mode is used, the 
auto zero period should be shorter to provide equal zero and 
measurement periods. See Table 3-1, “Typical Operating 
Parameter” in this chapter, and the STP command in Chapter 6. 
 
 
Valve Blanking Time 

When a zero measurement cycle is initiated, there is a period of 
time, called blanking time, during which the filtered air valve turns 
and the Nephelometer switches between clean and sample air (or 
visa-versa).  
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During blanking time, the data is in transition and should not be 
used. Blanking time represents the number of seconds in which 
data is disregarded and not used for either the zero or 
measurement data. Typically, blanking time is set to 30 seconds, 
but use a longer blanking time if the flowrate though the 
Nephelometer is reduced causing a longer purge or transition time. 
 
See the STB command in Chapter 6.  
 
 

Polled and Unpolled Communications 
The Nephelometer communicates in two ways: polled mode and 
unpolled mode. There are advantages and disadvantages with 
either mode. In polled mode, the Nephelometer waits for a 
command from an external computer or terminal and responds 
only when a command is sent. (TSI Nephelometer software uses 
polled mode.) In unpolled mode, the Nephelometer automatically 
sends data to the communications port once every averaging 
period.  
 
Although the Nephelometer updates data records as fast as once 
per second, this data is averaged in a running or boxcar average. 
The averaged data is completely updated once every averaging time 
period. Therefore, to avoid double averaging, the computer should 
poll the Nephelometer at a rate greater than the averaging time. 
 
To reduce the burden on the external computer to provide accurate 
timing, the Nephelometer has an unpolled communications mode . 
In unpolled mode the Nephelometer automatically reports selected 
data at intervals equal to the averaging time.  
 
When data is recorded in unpolled mode, you can use a shorter 
averaging time to provide more detail in the data (faster time 
response) at the expense of having more data to process. This also 
provides more flexibility in post processing of data as short 
averaged data can be combined into longer averages. This is useful 
in airborne work where several hours of fast response data may be 
taken. Ground-based measurements may opt for longer averaging 
times to reduce the amount of data gathered over long-term 
operation. 
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The following chart represents some typical settings for the 
previously mentioned time parameters. 
 
Table 3-1 
Typical Time Settings 

Parameter Ground Based Ground Based (clean) Airborne 

Avg Time 60 to 300 1500  30 
Zero 300 300  300 
Blanking 30 30  30 
AZ Period 3600 720  Manual 
AZ Mode Normal Air Chop (SMZ = 5) Manual 

 
 
When using long averaging times (greater than 300 seconds), all 
timing parameters should be set to integer multiples of the boxcar 
size (see the STA command under "Set Commands" in Chapter 6). 
This minimizes data loss that may occur if autozero transitions 
occur during the middle of a measurement boxcar. 
 



C H A P T E R  4  

Using Nephelometer  
Sof tware  (DOS)  

4-1 

This chapter contains installation and operating instructions for 
the DOS-based software, designed for exclusive use with the Model 
3550/3560 Series Integrating Nephelometer. 
 
This chapter contains these main sections: 

❑  Hardware and software requirements 

❑  Installing and starting the software 

❑  Keys and conventions 

❑  Menus and command options 

❑  Performing Calibration 
 
 
 

H a r d w a r e  a n d  S o f t w a r e  R e q u i r e m e n t s  
To operate the Nephelometer software you need an IBM personal 
computer or 100% IBM-compatible computer with the following: 

❑  80386 or higher processor 

❑  One hard drive with at least 100 Mb storage capacity 
(recommended for data logging) 

❑  One 3.5-in. floppy drive 

❑  4 Mb or more of random-access memory (RAM) 

❑  One RS-232 serial port for connection to the Nephelometer 

❑  DOS version 3.3 or higher. 
 
Note: The DOS-based Nephelometer software may be unstable if 

used with multiple applications under MicrosoftWindows.  
 
 
 

I n s t a l l i n g  a n d  S t a r t i n g  t h e  S o f t w a r e  
To load the Nephelometer software on the computer hard drive: 
 
1. Apply power to the computer. 
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2. Insert the 3.5 inch software disk in the floppy drive of the 
computer. 

3. Go to the root directory on the C drive (hard drive): 

 C:\> 

4. Make a subdirectory for the Nephelometer, like "nephdos": 

 C:\nephdos 
 
5. Copy the contents to the software disk into the subdirectory. 

These files are copied: 

NEPH.DAT 
NEPHCALB.EXE 
NEPHCFG.EXE 
NEPHCNFG.DAT 
NEPHMAIN.EXE 
NEPHPOLL.EXE 
NEPHSET.EXE 
NEPHTERM.EXE 
RAYSCAT.DAT 

 
6. Start the software by typing: 

 nephmain.exe 

 The main menu screen is displayed (Figure 4-1). 
 
+------------------------------------+ 

¦ TSI Nephelometer Software          ¦ 

+------------------------------------+ 

+---------Main Menu--------------+ 

¦ Set Commands Menu              ¦ 

¦ Calibration                    ¦ 

¦ Data Collection (Polled)       ¦ 

¦ Configuration Menu             ¦ 

¦ Terminal Mode                  ¦ 

¦ Com Port and Data Path         ¦ 

¦ Exit                           ¦ 

+--------------------------------+ 

Figure 4-1 
Main Menu Screen 
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Note: The DOS-based Nephelometer software may be unstable if 
used along with multiple applications under Microsoft
Windows.  

 
 
 

K e y s  a n d  C o n v e n t i o n s  
This section gives key functions, and command conventions for the 
Nephelometer software. Table 4-1 gives the keyboard functions; 
software command conventions are shown in Figure 4-1. 
 

Table 4-1 
Keyboard Functions 

Key Function 

Hot keys Type the first letter of a menu option to cursor to that option. 

F10  Press F10 to quit either the calibration, terminal, or polled mode. 

Esc  Press Esc to return at any time to the previous screen, or to return to the 
DOS prompt from the main menu screen.  

Arrow keys (←↑→↓)  Press an Arrow key to move within a screen field, or to move up and 
down a list of menu options. 

Tab Press Tab to move from field to field within a screen. 

Enter Use Enter in combination with other keys (like Arrow keys) or 
conventions (like <Read>) to select an option, to enter a parameter, or to 
read a parameter. 

 
 
+----------------------------------------------------¦ 

¦       < Set >       < Read >       < Cancel >      ¦ 

+----------------------------------------------------+ 

Figure 4-2 
Software Command Conventions 
 
 
<Set> Sends a parameter, set by the user, to the 

Nephelometer. 
 
<Cancel> Returns to the previous screen without entering any 

selections or new parameters. 
 
<Read> Reads the parameter that is currently being used by the 

Nephelometer. 
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M e n u s  a n d  C o m m a n d  O p t i o n s :  A  R e f e r e n c e  
G u i d e  

This section describes the software menus and command options in 
the order they appear on menu screens. Figure 4-3 shows a 
structural overview with the three menus (Main, Set Commands, 
and Configuration).  
 

Main Menu

Calibration
Data Collection
(Polled)

Terminal Mode
Com Port and
Data Path

Set Commands Menu Configuration Menu

K Calibration Constants

Calibration Label String

Mode for Backscatter Shutter

Lamp Power

Time for Averaging

Time and Date

Voltage on Photomultiplier Tube

Display Current Config. Data

Read Config. Data from Nephelometer

Read Config. Data from Disk File

Save Config. Data to Nephelometer

Save Config. Data to Disk File

Print Config. Data

 

Figure 4-3 
Software Menu Structure 
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Main Menu  
The Main Menu screen is displayed when you start the 
Nephelometer software (Figure 4-4). When you select any menu 
option, a message describing the option is displayed at the bottom 
of the screen.  
 
Note: Start the software by typing nephmain.exe under the 

subdirectory created for the Nephelometer program.  
 

+------------------------------------+ 

¦ TSI Nephelometer Software v1.x     ¦ 

+------------------------------------+ 

 

+---------Main Menu--------------+ 

¦ Set Commands Menu              ¦ 

¦ Calibration                    ¦ 

¦ Data Collection (Polled)       ¦ 

¦ Configuration Menu             ¦ 

¦ Terminal Mode                  ¦ 

¦ Com Port and Data Path         ¦ 

¦ Exit                           ¦ 

+--------------------------------+ 

Figure 4-4 
Main Menu Screen 
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Main/ 
Set Commands Menu  
The Set Commands Menu screen (Figure 4-5) contains options that 
allow you to set up the operating parameters for the Nephelometer. 
These options correspond to some of the set commands described 
in Chapter 6.  
 
Note: You can use the Terminal option under the Main Menu to enter 

any serial data commands for parameters not included in the 
Set Commands Menu. 

 
Go to the Set Commands Menu by selecting the Set Up 
Nephelometer option from the Main Menu screen. When you select 
an option from the Set Commands Menu, a message describing the 
option is displayed at the bottom of the screen.  
 
+-------Set Commands Menu------------------+ 
¦ K Calibration Constants                  ¦ 

¦ Calibration Label String                 ¦ 

¦ Mode for BackScatter Shutter             ¦ 

¦ Lamp Power                               ¦ 

¦ Time for Averaging                       ¦ 

¦ Time and Date                            ¦ 

¦ Voltage on Photomultiplier Tube          ¦ 

¦ Exit                                     ¦ 

+------------------------------------------+ 

Figure 4-5 
Set Commands Menu  
 

 

Set Command/ 
K Calibration Constants Option 
The K Calibration Constants option (Figure 4-6) allows you to 
choose calibration constants for each of the three detection colors 
(blue, green, and red). The K calibration constants , 1 through 4, 
are further defined in the SK command under "Set Commands" in 
Chapter 6. In order to read the current K Calibration Constants for 
a particular channel (blue, green, or red), you have to select the 
channel and then <Read> followed by <CR>. 

Note: Models 3551/3561 only require calibration constants for the 
green channel. 
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+--------------- K Constants --------------+ 

¦ K1 (1-65535 picoseconds):                ¦ 

¦+----------------------------------------+¦ 

¦0                                        ¦¦ 

+-----------------------------------------+¦ 

¦ K2 (Total Scatter):                      ¦ 

¦+----------------------------------------+¦ 

¦0.000E+0                                 ¦¦ 

+-----------------------------------------+¦ 

¦ K3 (Rayleigh Scatter):                   ¦ 

+-----------------------------------------+¦ 

¦0.000E+0                                 ¦¦ 

+-----------------------------------------+¦ 

¦ K4 (Backscatter):                        ¦ 

¦+----------------------------------------+¦ 

¦0.000E+0                                 ¦¦ 

+-----------------------------------------+¦ 

¦               -- Channel --              ¦ 

¦  (�) Blue                                ¦ 

¦  ( ) Green                               ¦ 

¦  ( ) Red                                 ¦ 

+------------------------------------------¦ 

¦    < Read >    < Set >    < Cancel >     ¦ 

+------------------------------------------+ 

Figure 4-6 
K Calibration Constants Option 
 
 
Set Command/ 
Calibration Label String Option 

The Calibration Label String option allows you to send an 
identifying label for the calibration constants to the Nephelometer 
(Figure 4-7). As an example, "Last Calibration 1/30/93". The 
Calibration Label String option corresponds to the SL command 
under "Set Commands" in Chapter 6.  
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+----------------- Calibration Label ----------------+ 

¦                                                    ¦ 

¦ Label String (up to 50 char.):                     ¦ 

¦+--------------------------------------------------+¦ 

¦SL                                                 ¦¦ 

+---------------------------------------------------+¦ 

¦                                                    ¦ 

+----------------------------------------------------¦ 

¦       < Set >       < Read >       < Cancel >      ¦ 

+----------------------------------------------------+ 

Figure 4-7 
Calibration Label Option 
 
 
Set Command/ 
Mode for BackScatter Shutter Option 

The Mode for BackScatter Shutter option (Figure 4-8) allows you to 
disable the backscatter shutter for total scatter measurements, or 
to enable the backscatter shutter so that you can take total scatter 
and backscatter measurements. This option corresponds to the 
SMB command under "Set Commands" in Chapter 6. 
 
Refer to the Backscatter Measurements section in Chapter 3, 
"Operations Overview," to determine how to set this option. 
 
+-- BackScatter Shutter Mode --+ 

¦                              ¦ 

¦           -- Mode --         ¦ 

¦  (�) Total Scatter Only      ¦ 

¦  ( ) Backscatter             ¦ 

¦                              ¦ 

+------------------------------¦ 

¦ < Set > < Read > < Cancel >  ¦ 

+------------------------------+ 

Figure 4-8 
BackScatter Shutter Mode Option 
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Set Command/ 
Lamp Power Option 

The Lamp Power option (Figure 4-9) allows you to set the intensity 
of the halogen lamp, which is used as a light source inside the 
Nephelometer. The setting for the Lamp Power option directly 
affects the life of the lamp. The Lamp Power option corresponds to 
the SP command under "Set Commands" in Chapter 6. 
 
Refer to the Lamp Power section in Chapter 3, "Operations 
Overview," to determine how to set this option.  
 
+-------- Lamp Power ---------+ 

¦                             ¦ 

¦  Power in watts (0 - 150):  ¦ 

¦                             ¦ 

¦   +--------------------+    ¦ 

¦   ¦0                   ¦    ¦ 

¦   +--------------------+    ¦ 

+-----------------------------¦ 

¦ < Set > < Read > < Cancel > ¦ 

+-----------------------------+ 

Figure 4-9 
Lamp Power Option 
 
 
Set Command/ 
Time for Averaging Option 

The Time for Averaging option allows you set the averaging time, in 
seconds, over which the sample is measured (Figure 4-10). The 
Time for Averaging option corresponds to the STA command under 
"Set Commands" in Chapter 6. 
 
Refer to the Averaging Time section in Chapter 3, "Operations 
Overview," to determine how to set this option.  
 
Note: Averaging times in the valid range that do not fall on a boxcar 

boundary, will be rounded up to the next valid boxcar 
boundary averaging time. That is, if set to 604, because the 
boxcar size is 3 seconds, the next valid averaging time is 606. 
The Nephelometer uses this number. 
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+------- Averaging Time --------+ 

¦                               ¦ 

¦  Time in seconds (1 - 9960):  ¦ 

¦                               ¦ 

¦    +--------------------+     ¦ 

¦    ¦0                   ¦     ¦ 

¦    +--------------------+     ¦ 

+-------------------------------¦ 

¦  < Set >  < Read >  < Cancel >¦ 

+-------------------------------+ 

Figure 4-10 
Time for Averaging Option 
 
 
Set Command/ 
Time and Date Option 

The Time and Date option allows you to set the time and date for 
the Nephelometer's internal clock (Figure 4-11). The Time and Date 
option can be accessed with the STT command, the RT command, 
or in unpolled mode with the UT command. Refer to the 
"Commands" section in Chapter 6. 
 
+--------- Date/Time ---------+ 

¦                             ¦ 

¦       Date:                 ¦ 

¦      +---------------+      ¦ 

¦      ¦05-10-1994     ¦      ¦ 

¦      +---------------+      ¦ 

¦                             ¦ 

¦       Time:                 ¦ 

¦      +---------------+      ¦ 

¦      ¦13:20:47       ¦      ¦ 

¦      +---------------+      ¦ 

¦                             ¦ 

+-----------------------------¦ 

¦ < Set > < Read > < Cancel > ¦ 

+-----------------------------+ 

Figure 4-11 
Time and Date Option 
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Set Command/ 
Voltage on Photomultiplier Tube Option 

The Voltage on Photomultiplier Tube option (Figure 4-12) allows 
you to set the voltage that drives each PMT tube, blue, green, and 
red. The range for this option is 1–1200 volts. This option 
corresponds to the SV command under "Set Commands" in Chapter 
6. In order to read the current Voltage on Photomultiplier Tube 
option for a particular channel (blue, green, or red), you have to 
select the channel and then <Read> followed by <CR>. 
 
Note: Models 3551/3561 only require voltages for the green tube. 
 
Refer to the Photomultiplier Tubes section in Chapter 3, 
"Operations Overview," to determine how to set this option.  
 
+-------- PMT Voltage --------+ 

¦         -- Color --         ¦ 

¦  (�) Blue                   ¦ 

¦  ( ) Green                  ¦ 

¦  ( ) Red                    ¦ 

¦                             ¦ 

¦    PMT Voltage              ¦ 

¦   +--------------------+    ¦ 

¦   ¦0                   ¦    ¦ 

¦   +--------------------+    ¦ 

¦                             ¦ 

+-----------------------------¦ 

¦ < Read > < Set > < Cancel > ¦ 

+-----------------------------+ 

Figure 4-12 
Voltage on Photomultiplier Tube Option 
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Main/ 
Calibration Option 
Refer to the "Performing Calibration" section at the end of this 
Chapter. 
 

 

Main/ 
Data Collection (Polled) Option 
The Data Collection (Polled) option allows you to read data records 
from the Nephelometer and display the records in a format that is 
easy to interpret (Figure 4-13). This option also enables you to store 
the data, in an unpolled record format, to a specified file as it is 
received from the Nephelometer. This format is displayed in the 
"Unpolled Record Formats" section in Chapter 6. The specified file 
is saved to a directory set by the Com Port and Data Path option 
(refer to that option in this chapter). 
 
Note: The display screen is updated approximately once per second 

but data is written to the data files at intervals set by the 
averaging time (see the "Time for Averaging Option" in this 
chapter). 
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+--------------Data Record-------------++--------------Status Record-----------+ 

¦Current Mode:    Normal Measurement   ¦¦Green Cal (in Hz)           3.196E+05 ¦ 

¦                 BackScatter          ¦¦                                      ¦ 

¦Time Remaining:   129                 ¦¦Pressure (MB)                  971.3  ¦ 

¦(current state)                       ¦¦Sample Temp. (K)               300.4  ¦ 

¦                                      ¦¦Inlet  Temp. (K)               297.6  ¦ 

¦       Scattering Coefficient         ¦¦Rel. Humidity(%)                33.8  ¦ 

¦   Total Scatter     Back Scatter     ¦¦Lamp Voltage                    12.9  ¦ 

¦                                      ¦¦Lamp Current                     5.9  ¦ 

¦B  -4.98700E-07       1.08700E-07     ¦¦BNC Input Voltage                 16  ¦ 

¦G   4.71600E-08      -1.45200E-07     ¦¦Status Flags                      OK  ¦ 

¦R  -9.66400E-08      -1.83400E-08     ¦¦                                      ¦ 

¦                                      ¦¦                                      ¦ 

+--------------------------------------++--------------------------------------+ 

+----------------Photon Frequency in Hz (Blue, Green, Red)---------------------+ 

¦          Total Scatter                    BackScatter                  Sample¦ 

¦       Cal     Meas     Dark           Cal     Meas     Dark       Press Temp.¦ 

¦                                                                              ¦ 

¦B   187332     1205       13        115844      601       10       971.3 300.4¦ 

¦G   317605     1031       26        197815      493       20       971.3 300.4¦ 

¦R   195066      534      219        120578      404      209       971.3 300.4¦ 

¦                                                                              ¦ 

+------------------------------------------------------------------------------+ 

(L)og Data   Log (F)ilename    (A)vg Time      Mode                  F10-Quit 

    OFF       LOGDATA.LOG          60          POLLED      9/20/1994  10:14:40 

Figure 4-13 
Data Collection Polled Option 
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Main/ 
Configuration Menu 
The Configuration Menu (Figure 4-14) contains options that allow 
you to display current configuration parameters, and to read the 
configuration file from either a disk or from the Nephelometer. The 
options under the Configuration Menu are useful if the 
Nephelometer configuration data is ever lost or corrupted. The 
options allow you to quickly analyze a situation because you are 
able to view all the parameters as a group. You can also store, then 
easily retrieve different configurations. 
 
Note: You cannot change the contents of Configuration screens 

using Configuration Menu options, but you can make changes 
using either the Terminal Mode option or using options under 
the Set Commands Menu 

 
+------Configuration Menu------------------+ 

¦ Display Current Config. Data             ¦ 

¦ Read Config. Data from Nephelometer      ¦ 

¦ Read Config. Data from Disk File         ¦ 

¦ Save Config. Data to Nephelometer        ¦ 

¦ Save Config. Data to Disk File           ¦ 

¦ Print Config. Data                       ¦ 

¦ Exit                                     ¦ 

+------------------------------------------+ 

Figure 4-14 
Configuration Menu 
 

 

Configuration/ 
Display Current Config. Data Option 

The Display Current Config. Data option displays the configuration 
data in the software buffer, either data read from the Nephelometer 
or data from the disk file (Figures 4-15 and 4-16). 
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+------------------Nephelometer Configuration Data------------------------------+ 

¦Analog Output Range:                Zero V    Full Scale                      ¦ 

¦          Relative Humidity   ->        0  -      0                           ¦ 

¦          Barometric Pressure ->        0  -      0                           ¦ 

¦          Sample Temperature  ->        0  -      0                           ¦ 

¦          Scattering          ->        0  -      0       (Offset=0.000E+00)  ¦ 

¦                                                                              ¦ 

¦Channel   Type                          Channel   Type                        ¦ 

¦    0     0 (External PC Control)           5     0 (External PC Control)     ¦ 

¦    1     0 (External PC Control)           6     0 (External PC Control)     ¦ 

¦    2     0 (External PC Control)           7     0 (External PC Control)     ¦ 

¦    3     0 (External PC Control)           8     0 (External PC Control)     ¦ 

¦    4     0 (External PC Control)                                             ¦ 

¦                                                                              ¦ 

¦Calibration Points:              Low Bits  Low Value   High Bits  High Value  ¦ 

¦          Relative Humidity  ->       0          0          0          0      ¦ 

¦          Barometric Pressure->       0          0          0          0      ¦ 

¦          Sample Temperature ->       0          0          0          0      ¦ 

¦          Inlet Temperature  ->       0          0          0          0      ¦ 

¦                                                                              ¦ 

¦Calibration Constants:   K1        K2            K3            K4             ¦ 

¦             Blue ->        0   0.00000E+00   0.00000E+00   0.00000E+00       ¦ 

¦             Green->        0   0.00000E+00   0.00000E+00   0.00000E+00       ¦ 

¦             Red  ->        0   0.00000E+00   0.00000E+00   0.00000E+00       ¦ 

+Screen 1 of 2------------------------------Press any key to Next Screen-------+ 

Figure 4-15 
Display Current Config. Data Option 
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+------------------Nephelometer Configuration Data-----------------------------+ 

¦Data Delimiter: Comma                                                         ¦ 

¦                                                                              ¦ 

¦Calibration Label:                                                            ¦ 

¦                                                                              ¦ 

¦Backscatter Shutter Mode:             Total Scatter Mode ONLY                 ¦ 

¦Autozero Baseline Measurement:        Manual Mode                             ¦ 

¦                                                                              ¦ 

¦Lamp Power (Watts)               :     0                                      ¦ 

¦Auxiliary BNC Output (millivolts):     0                                      ¦ 

¦                                                                              ¦ 

¦Time for Averaging  (sec.)          :     0                                   ¦ 

¦Time to Blank Valve (sec.)          :     0                                   ¦ 

¦Time between Autozeros (sec.)       :     0                                   ¦ 

¦Time for AutoZero Measurement (sec.):     0                                   ¦ 

¦                                                                              ¦ 

¦PMT Voltage: Blue  =     0                                                    ¦ 

¦             Green =     0                                                    ¦ 

¦             Red   =     0                                                    ¦ 

¦                                                                              ¦ 

¦Zero Baseline Values:  Total Scatter     BackScatter     Rayleigh Scatter     ¦ 

¦             Blue  ->     0.000E+00        0.000E+00        0.000E+00         ¦ 

¦             Green ->     0.000E+00        0.000E+00        0.000E+00         ¦ 

¦             Red   ->     0.000E+00        0.000E+00        0.000E+00         ¦ 

+Screen 2 of 2-------------------------Press any key to return to Menu---------+ 

 

Figure 4-16 
Display Current Config. Data Option 
 
 
Configuration/ 
Read Config. Data from Nephelometer Option 

The Read Config. Data from Nephelometer option allows you to read 
the configuration data residing in the Nephelometer to the software 
buffer. This offers a tool to help you quickly analyze any operating 
problems.  
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Configuration/ 
Read Config. Data from Disk File Option 

The Read Config. Data from Disk File option allows you to read the 
contents of the disk file into the software buffer. You can then 
select “Display Current Config. Data” to review this data before you 
send it to the Nephelometer.  
 
 
Configuration/ 
Save Config. Data to Nephelometer Option 

The Save Config. Data to Nephelometer allows you to save the 
configuration data residing in the software buffer to the 
Nephelometer. The operating parameters in this file become the 
operating parameters for the Nephelometer. 
 
 

Configuration/ 
Save Config. Data to Disk File Option 

The Save Config. Data to Disk File option allows you to save the 
configuration data residing in the software buffer to a disk file for 
easy access should the Nephelometer’s configuration become 
corrupt.  
 
 
Configuration/ 
Print Config. Data Option 

Sends a copy of the Config. Data to the printer attached to your 
parallel port. 
 

 

Main/ 
Terminal Mode Option 
The Terminal Mode option provides a basic serial interface to the 
Nephelometer, where you can type in serial data commands and 
send them directly to the Nephelometer. This option is useful for  
troubleshooting Nephelometer operating parameters, the calibration 
process, or configuration data. 
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Examples of the commands you might enter in terminal mode are 
commands that are normally set once, and not changed during the 
course of taking sample data. These include any of the set 
commands for mapping analog outputs (like SA, SB, and SX), 
action commands that control the mechanical components, read 
commands and unpolled commands (refer for Chapter 6, "Using 
Serial Data Commands").  
 

 

Main/ 
Com Port and Data Path Option 
The Com Port and Data Path option allow you select the serial 
communications port of the computer and to designate a data path 
for storage of data files (Figure 4-17). Use DOS conventions in 
naming a directory path. Any files stored will go to the directory set 
by this option. 
 
+---------------- Data Path ---------------+ 

¦               COM Settings               ¦ 

¦                                          ¦ 

¦  (�) Com1                                ¦ 

¦  ( ) Com2                                ¦ 

¦                                          ¦ 

¦  Directory Path For Data Files (*.dat):  ¦ 

¦                                          ¦ 

¦ +--------------------------------------+ ¦ 

¦ ¦C:\SOFT                               ¦ ¦ 

¦ +--------------------------------------+ ¦ 

¦                                          ¦ 

+------------------------------------------¦ 

¦         < OK >         < Cancel >        ¦ 

+------------------------------------------+ 

Figure 4-17 
Com Port and Data Path Option 
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P e r f o r m i n g  C a l i b r a t i o n  
You should calibrate the Nephelometer before an intensive 
experiment, calibrate periodically to verify no drift has occurred, 
calibrate if the reference chopper is dirty or scratched, or if you 
clean the chopper as part of periodic maintenance. 
 
The Calibration option under the Main menu allows you to easily 
calibrate the Nephelometer using two span gases. The Calibration 
option allows you to compare the results between air (low span) and 
CO2 (high span). 
 
 

Hardware Setup 
Set up the gas before begin you begin calibration. Gas should be 
approximately room temperature as it reaches the Nephelometer. 
One way to ensure this is to use a 6- to 9-meter (20- to 30-foot) 
length of 6-mm (¼-in.) diameter tubing from the CO2 tank to the 
Nephelometer. (The length of the tubing affects the temperature of 
the CO2.) Gas of 99.9% purity or better is typically used with 
ambient air for calibration. 
 

!
 

C a u t i o n  

 Use calibration gases only in a well-ventilated area or exhaust the gases outside. 
Many gases used for calibration can cause asphyxiation if used in a confined 
area. 

 

Using the Main/ 
Calibration Option 
Calibrate the Nephelometer by selecting the Calibration command 
from the Main Menu . The interactive calibration screen is 
displayed (Figure 4-18).  

❑  The top section of the calibration screen displays the current 
calibration settings stored in the Nephelometer and any new 
calibration settings not yet saved to the Nephelometer.  

❑  The middle section of the screen displays calibration data in 
frequency (Hz) for low span and high span gas in each 
wavelength (blue, green, and red). Calibration data is displayed 
for both total scatter and backscatter modes.  
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❑  The bottom section of the screen lists the steps you will use to 
calibrate the Nephelometer. Perform each step in the order 
given. As you complete each step, press <Enter>. A check (√) is 
displayed next to each command as the command is executed. 

 
+--------------Calibration Parameters Table------------------------------------+ 
¦         Current(B)  New(B)      Current(G)  New(G)      Current(R)  New(R)   ¦ 
¦K2      4.325E-03   0.000E+00   4.484E-03   0.000E+00   4.614E-03   0.000E+00 ¦ 
¦K4      9.533E-03   0.000E+00   9.717E-03   0.000E+00   1.035E-02   0.000E+00 ¦ 
+------------------------------------------------------------------------------+ 
+--------------Calibration Data in Hz------------------------------------------+ 
¦                   Total Scatter                 BackScatter                  ¦ 
¦           Cal        Meas        Dark         Cal        Meas        Dark    ¦ 
¦LOW SPAN GAS                                                                  ¦ 
¦Blue   0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00¦ 
¦Green  0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00¦ 
¦Red    0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00¦ 
¦HIGH SPAN GAS                                                                 ¦ 
¦Blue   0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00¦ 
¦Green  0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00¦ 
¦Red    0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00 0.00000E+00¦ 
+-------------Calibration Steps-----------------------Elapsed Time(s):---     -+ 

  1. set low span gas     (Air       )     9. feed CO2 into line    (manual) 
  2. set high span gas    (CO2       )     A. start data collection-high gas 
  3. switch valve filter                   B. clear buffer 
  4. start data collection-low gas         C. store high span gas data 
  5. clear buffer                          D. write calibration label 
  6. store low span gas data               E. save cal data (K2 & K4) to Neph 
  7. toggle blower to off (OFF)            F. zero w/ clean air 
  8. plug inlet & outlet  (manual)              F8-Avg Time F9-Restart F10-Quit 

Figure 4-18 

Calibration Option 

Note: If you are using air as the low span gas and CO2 as the high 
span gas, perform the calibration steps in the order given. If 
you are using a gas other than air as the low span gas (like 
helium), refer to calibration process given at the end of the 
Calibration Procedure. 

 
Table 4-2 
Calibration Procedure 
Step Explanation 

1. Set low span gas Select to choose the low span gas. Air is the default. When you select 
step 1, a menu is displayed with different gases. 

2. Set high span gas Select to choose a high span gas, or a gas with a higher scattering 
coefficient than the low span gas, such as CO2. When you select 
step 2, a menu is displayed with different gases.  

(continued) 
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Table 4-2 
Calibration Procedure (continued) 
Step Explanation 

3.  Switch valve filter Select to switch the filtered air valve to the zero (closed) position and 
to switch the blue DQ filter in-line with the air inlet. When you select 
step 3, a blanking time begins. The blanking time is the time it takes 
the filtered air valve to move to the zero position plus the time it takes 
to purge the Nephelometer with filtered air. The blanking time is set 
using the STB command (see Chapter 6). 

4. Start data collection-low gas Select to begin low span gas data collection. After you select step 4, 
data collection begins after the blanking time described in step 3.  
The low span gas area of the calibration screen is updated, but not 
the high span area.  

If you want to observe the filtered air purge, press <F8> to select a 
smaller averaging time of 5 seconds. The number in the Meas field 
should fluctuate, not rise and fall. When the Meas field is stable, 
press <F8> to select a 300-second averaging time and proceed to step 
5. 

5. Clear buffer Select to clear the Nephelometer internal buffers of the data collected 
during step 4. Wait at least 300 seconds (see the Elapsed Time(s) 
field), then proceed to step 6. 

6. Store low span gas data Select to store in the software, the 300-seconds of low span gas data 
collected in step 5. Selecting step 6 causes the low span gas area of 
the calibration screen to freeze and low span data is no longer 
updated.  

7. Toggle blower to off (OFF) Select to turn off the blower. High span gas should be regulated at 
the source. 

Note: Step 7 is a toggle function and can also be used to toggle on 
the blower. 

8. Plug inlet & outlet (manual) Remove the top cover of the Nephelometer using the procedure in 
Chapter 8. Plug the aerosol inlet and outlet of the Nephelometer 
(Figure 4-19). 

9. Feed CO2 into line (manual) Remove the tubing from the inlet of the blue DQ filter and connect 
the tubing from the high span gas to either the inlet tubing or to the 
inlet block (Figure 4-19). Turn on the gas until the flowrate is 
approximately 5 lpm. You should feel gas exiting through the DQ 
filter in the opposite direction of the arrow on the filter. Proceed to 
step A. 

A. Start data collection-high gas Select to begin high span gas data collection. The high span gas area 
of the calibration screen is updated, but not the low span area.  

If you want to observe the high span gas purge, press <F8> to select 
smaller averaging time of 5 seconds. The number in the Meas field 
should fluctuate, not rise and fall. When the Meas field is stable with 
minimal fluctuation, press <F8> to select a 300-second averaging 
time and proceed to step B.  

(continued) 
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Plug Inlet and Outlet

Connect High Span Gas

 

Figure 4-19 
Plugs for Inlet and Outlet and Gas Line With the Blue DQ Filter 
 
 

Table 4-2 
Calibration Procedure (continued) 
Step Explanation 

B. Clear buffer Select to clear the Nephelometer internal buffers of the data collected 
during step A. Remain at this step for at least 300 seconds (see the 
Elapsed Time(s) field), then proceed to step C. 

C. Store high span gas data Select to store to the software the 300 seconds of high span gas data 
collected in step B. Selecting step C causes the high span gas area of 
the calibration screen to freeze and high span data is no longer 
updated.  

Note: At this time, new calibration constants (K2 and K4) are 
calculated and the top section of the screen is updated. If the 
new constants are not satisfactory, you can recalibrate without 
changing the constants, as long as you do not perform step E. 

D. Write calibration label Select to write an identifying label for the calibration performed. The 
label can include the serial number of the Nephelometer, the 
calibration date, the low span and high span gases used, and the 
initials of the person performing the calibration. 

(continued) 
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Table 4-2 
Calibration Procedure (continued) 
Step Explanation 

E. Save cal data (K2 & K4) to Neph If the new K2 and K4 calibration constants are satisfactory, select E 
to write the new K2 and K4 constants to the Nephelometer.  
After selecting step E,  

1. Remove the high span gas and the inlet and outlet plugs from the 
Nephelometer.  

2. Reconnect the DQ filter to the inlet block, with the arrow of the 
filter pointing away from the inlet block.  

3. Replace the top cover of the Nephelometer, attaching the cover 
with the four screws.  

4. Select 7 to toggle on the blower and to purge the Nephelometer of 
high span gas. 

Note: To allow the Nephelometer to be completely purged of high 
span gas, wait at least 600 seconds with the blower on before 
proceeding to step F. 

F. Zero w/clean air Optional—Select to purge the Nephelometer with clean air and to 
perform a zero background measurement.  

<F9> resets the check marks. <F10> exits the calibration. 
Go to the Main Menu and choose the Configuration option for options 
to store the calibration file to disk. 

If you are using a low span gas other 
than air, perform the calibration steps 
in this order: 

1. See step 1. 

2. See step 2. 

3. See step 3. 

7. See step 7. 

8. See step 8. 

9. Remove the tubing from the inlet of the blue DQ filter and 
connect the tubing from the low span gas to either the inlet 
tubing or to the inlet block (Figure 4-19). Turn on the gas until 
the flowrate is approximately 5 lpm. You should feel gas exiting 
through the DQ filter in the opposite direction of the arrow on the 
filter.  

4. See step 4. 

5. See step 5. 

6. See step 6. 

9. See step 9. 

A. See step A. 

B. See step B. 

C. See step C. 

D. See step D. 

E. See step E. 

F. See step F. 
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C H A P T E R  5  

Using Nephelometer  
Software (Windows)  

5-1 

This chapter describes the WindowsTM version of the Nephelometer 
software including: 

❑  The setup procedure that loads the program onto your 
computer. 

❑  A “Quick Start” section to walk you through the steps necessary 
to collect data and perform other basic operations.  

❑  A reference section to describe each program menu and its 
commands. 

 
This chapter assumes you have Microsoft® WindowsTM on your 
computer and that you are familiar with how Windows works. If 
you are not familiar with Windows, please refer to the 
documentation and other information that came with Windows 
before you load and use this program.  
 
The Nephelometer software is provided in a Windows-based format 
because Windows offers a popular and easy-to-use interface to 
work from.  
 
 
 

H a r d w a r e  a n d  S o f t w a r e  R e q u i r e m e n t s  
To use this software program you will need an IBM personal 
computer or 100% IBM-compatible computer with the following 
minimum features, components, and software: 

❑  A 386 microprocessor (80386) or better.  

❑  A hard drive large enough to accommodate Windows, the 
Nephelometer program (approximately 2.5 Mb), and 
Nephelometer data files.  

❑  One 3.5-in. floppy drive. 

❑  4 Mb or more of random access memory (RAM). 

❑  A mouse or similar pointing device. 

❑  An RS-232 serial interface port (in addition to the one that may 
be required for the mouse). 

❑  MS-DOS, version 5.0 or higher. 

❑  Microsoft Windows version 3.1 or Microsoft Windows for 
Workgroups version 3.11. 
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I n s t a l l i n g  a n d  S t a r t i n g  t h e  S o f t w a r e  
Set up the Windows-based Nephelometer software as follows: 
 
1. Verify that Windows version 3.1 or Windows for Workgroups 

3.11 is installed and running and that your MS-DOS version is 
at least 5.0. To verify your version of Windows, select About 
Windows from the Windows Help menu or type: 

   WINVER  

 at the DOS prompt and press <Enter>.  

 To verify your MS-DOS version, type: 

   VER 

 at the DOS prompt and press <Enter>. 
 
2. Insert the Nephelometer setup disk in your 3.5-in. floppy drive 

(generally this is your A: or B: drive). 
 
3. Start the setup program by selecting RUN from the File menu 

and typing the following in the command box: 

   A:\SETUP <Enter> (or B:\SETUP <Enter>). 

Note: The Nephelometer program is compressed on the setup 
disk, you cannot load it without running the Setup 
program.  

 
4. A setup screen appears and indicates the drive and directory in 

which the program will be installed (the default directory), 
Figure 5-1. If you want the program installed in another 
directory or on another drive, you must enter the drive and/or 
directory name.  

 
Note: You must select a hard drive for program installation. You 

cannot install the Nephelometer program onto floppy 
diskettes or run it from a floppy drive. 
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Figure 5-1 
Select the Destination Directory for Program Installation 
 
 
5. Select Continue. The program files are automatically 

decompressed and stored on your hard drive. 
 

Note: If you are re-installing the Nephelometer software and the 
NEPHCNFG.DAT file on your computer is different than the 
one on the setup disk, you will be asked if you want to 
overwrite the existing file. Select Yes if you want to 
overwrite the NEPHCNFG.DAT file. See “Neph Config Data” 
section later in this chapter for more information on 
NEPHCNFG.DAT. 

 
When setup is complete, the README.TXT file opens 
automatically. The README.TXT file contains information that 
could not be included in this manual. Read the file and then 
close it. You can access the file anytime using a text editor such 
as NOTEPAD. 
 
The setup program creates a directory called NEPHWIN on your 
hard disk (assuming you accepted the default directory name) 
that contains the required program files. Refer to Appendix E 
for a list of program files and their contents. 

 
The Setup program also creates a new group called TSI 
APPLICATIONS and an icon for the program called NEPH for 
Windows (Figure 5-2). 

 
Note: Before creating a TSI APPLICATIONS group, the Setup 

program checks for an existing one. If one is present, it 
adds the Nephelometer icon only. 
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Figure 5-2 
Setup Creates a Program Group and Icon 
 
 
Once the program icon has been installed, you can start the 
Nephelometer program by double-clicking on its icon. 
 
 
 

Q u i c k  S t a r t  
This section is designed to give you a quick introduction to the 
basic operation of the Nephelometer Windows program. Using these 
instructions, you will: 

❑  Verify the Com Port setting of the Nephelometer. 

❑  Start collecting sample data 

❑  View the data as it is being collected and check the status of the 
Nephelometer. 

❑  Pause and Restart data collection from the Nephelometer. 

❑  Print a graph of the collected data. 

❑  Perform a manual background (zero baseline) measurement. 
 
Before you begin, verify the Nephelometer is powered up and 
connected to the computer. 
 
Start the Nephelometer program by double-clicking on its icon. The 
main menu appears (Figure 5-3). 
 



Using Nephelometer Software (Windows) 5-5 

 

Figure 5-3  
The Main Menu of the Windows-Based Nephelometer Program 
 
 

Step 1.  Verify Com Port 
Choose the Com Port command from the Config menu. The COM 
Port Setup display is shown (Figure 5-4). 
 

 

Figure 5-4 
The COM PORT Setup Display 
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Verify that the communications port indicated on this display is the 
one connected to your Nephelometer (refer to Chapter 2 if 
necessary). The default is COM2. Select another communications 
port if necessary. 
 
Note:  Most computers have only two active communications ports, 

COM1 and COM2. Typically, COM1 is used to connect a serial 
mouse, so COM2 is most likely available for the Nephelometer 
connection.  

 
Select OK to exit this display. 
 
 

Step 2.  Start Data Collection 
To start collecting data you should first open a log file and then 
start collecting data. 
 
1. Select the Log Data command from the File menu. When the 

Log Data Setup window appears, type in: 

   ONETEST.DAT  

 and press OK. Watch the lower right corner of the display, it 
will indicate Data Logging is to ONETEST.DAT. 

 
2. Select the Data Collection command from the Run menu. 

Immediately, four windows are automatically opened and 
minimized on your screen (Figure 5-5) and data collection 
begins.  

 
 The icons that appear on the screen represent the Data, Graph, 

Photon Frequency, and Neph State commands available under 
the View menu. 

 
Note: If you receive a message that the program is unable to 

communicate with the Nephelometer, the wrong COM 
PORT may have been selected in Step 1. Verify cabling 
between the computer and the Nephelometer, then verify 
the correct COM PORT is selected and that the 
Nephelometer is on. 
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Figure 5-5 
Choosing Data Collection from the Run Menu Starts Data Collection 
 
 

Step 3.  View Data and Nephelometer Status 
Follow these steps to view data and the status of the Nephelometer: 
 
1. Double-click on the Data Display icon to display current data 

(Figure 5-6).  
 
 This display lets you view Nephelometer data as it is being 

collected, and the information displayed should resemble that 
shown in Figure 5-6.  

 
 Data is updated on this display at approximately one second 

intervals but data is written to the data files at intervals set by 
the averaging time. If no data is displayed after 60 seconds, 
check that the Nephelometer is running. 
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Figure 5-6 
Select Data Display to View Data as it is Collected by the Nephelometer 
 
 
2. Double-click on the Neph State icon (you don’t need to close 

the Data Display window) to display the Neph State window, 
Figure 5-7. 

 

 

Figure 5-7 
The Nephelometer State Display Shows the Status of the Nephelometer 
 
 

This window displays the status of various Nephelometer 
components. They should all be marked with checkmark (✔ ) to 
indicate they are functional. If any are marked with an ✖ , then 
there is a problem with the component. Refer to Chapters 2, 6, 
8 and 9 for information to help you troubleshoot the problem.  
 

3. Double-click on the Photon Frequency icon (you don’t need to 
close either the Data Display window or the Neph State window) 
to display the Photon Frequency window (Figure 5-8). 
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Figure 5-8 
The Photon Frequency Display Shows the Current Photon Frequency Calculations 
 
 

This window displays the raw photon frequency calculated by 
the software from the raw photon counts collected by the 
Nephelometer.  

 
4. Double-click on the Graph Display icon (you don’t need to close 

any of the other windows) to display the information that has 
been collected by the Nephelometer so far (Figure 5-9). 

 

 

Figure 5-9 
The Graph Display Shows Current Data 
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The graph displays the data that has been collected by the 
Nephelometer up to this point.  

 
 

Step 4.  Print a Graph 
There are two ways to print this graph. You can select either Print 
or Print Screen from the File menu. 
 
Before doing either, however, select Pause from the main menu. 
You should always Pause data collection before printing. 
 
Before using the Print Screen function, the Print Screen key must 
be pressed to capture the current active screen to the clipboard. 
The Print Screen function will print the entire screen, including 
menu bars, elevators and the like. It is being used to print log data 
graphs and may be suitable for draft prints or quick snaps of data. 
 
When you choose Print, you are asked to select either a scatter 
data graph or a status graph and to enter a header message. 
 
Choose Scatter Data Graph and enter the header message “This is 
test data collected by (enter your initials).” Then press OK. The data 
will be printed in landscape mode.  
 
 

Step 5.  Perform a Background (Zero Baseline) 
Measurement 
Zero baseline measurements are important so that the 
Nephelometer’s background scattering can be deducted from 
sample data measurements. Normally, zero baseline measurements 
are performed automatically; however, to introduce you to the 
Terminal function of the Windows program, you should perform a 
manual zero baseline measurement as follows.  
 
1. Select the Terminal Mode command from the Run menu. The 

Terminal Display appears, Figure 5-10. This display allows you 
to communicate with the Nephelometer using the Serial Data 
Commands, described in Chapter 6.) 
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Figure 5-10 
The Terminal Mode Display 
 
 
2. Enter a Z command (type the letter Z) and press <Enter>. This 

begins a zero measurement. 
 
3. Select the Terminal Mode command from the Run menu to 

close Terminal Display. 
 
4. Look at the Data Display, refer to Figure 5-6. It should show the 

Time Remaining counting down toward 0 (zero). The current 
mode should first be changed to Blank Period, then to the Zero 
Measurement, and eventually to Normal Measurement when the 
time remaining reaches 0. This indicates that zero 
measurement has been taken and stored to the log data file. 
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Basic Nephelometer Operations  
Although it does not list all of the functions available in the 
Windows Nephelometer program, Table 5-1 lists many of the most 
basic operations you might want to perform. Use the instructions 
provided to get better acquainted with how the program works, or 
as a quick reference.  
 
Although you may be comfortable using the program from these 
instructions, take the time to read the detailed information 
provided in the reference portion of this chapter so you are familiar 
with it when you have specific questions about program operation. 
 
Table 5-1 
Basic Windows Nephelometer Operations 

To... Perform the Following Steps 

Log data to a file 1. Select Log Data from the File menu. 

2. Enter the filename and select OK. 

3. Select Data Collection from the Run 
menu. 

or  

Perform Step 3 then 1 then 2. 

Start collecting data (not 
logged to a file) 

Select Data Collection from the Run menu. 

Pause/resume data 
collection 

Select Pause or Resume from the main 
menu. 

View raw data currently 
being collected by the 
Nephelometer 

1. Verify Data Collection is proceeding. 

2. Double-click on the Data Display icon. 

View the Nephelometer 
configuration data 

Select Neph Config Data from the View 
menu. 

View a graph of current 
Nephelometer activity 

1. Verify Data Collection is proceeding. 

2. Double-click on the Graph Display icon. 

View data already saved to 
a file 

1. Verify Data Collection is OFF. 

2. Select Open Log File from the Log menu. 

3. Enter the name of the file and select OK. 

View a graph of data 
already saved (closed file) 

1. Verify Data Collection is OFF. 

2. Select Open Log File from the Log menu. 

3. Enter the name of the file and select OK. 

4. Select Graph from the display. 

(continued) 
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Table 5-1 
Basic Windows Nephelometer Operations (continued) 

To... Perform the Following Steps 

Send serial data 
commands to the 
Nephelometer 

1. Select Terminal Mode from the Run 
menu. 

2. Type the Serial Data Command (see 
Chapter 6) and press <Enter>. 

Print a graph 1. View a graph. 

2. Select Print from the File menu. 

3. Select Info to Print and Header Message 
(if desired) 

4. Select Print. 

Print whatever is 
displayed on the screen 

1. Press <Print Screen> key. 

2. Select Print Screen from the File menu (or 
press <F9>). 

Run a background (zero 
baseline) measurement 
manually 

1. Verify Data Collection is OFF or paused. 

2. Select Terminal Mode from the Run 
menu. 

3. Type Z and press <Enter>. 

4. Close the Terminal Display. 

5. Resume Data Collection. 

Get online help Select the Contents command from the Help 
menu  

or 

Press <F1>. 

Exit the program 1. Verify Data Collection is stopped. 

2. Close all windows. 

3. Select Exit from the File menu. 

Arrange windows or icons 
on the screen 

Select Cascade, Tile, or Arrange Icons 
command from the Window menu. 

Select a communications 
port for the Nephelometer 

1. Verify Data Collection is OFF. 

2. Select Com Port from the Config menu. 

3. Select a communications port and press 
OK. 

Set up the Nephelometer 
(or make changes to its 
set up) 

1. Select Nephelometer from the Config 
menu. 

2. Make changes to the setup and Exit the 
screen. 
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C l e a n  A i r  T e s t  
Before you begin using the Nephelometer, you should conduct a 
clean air test to make certain the instrument is calibrated properly. 
Proceed with this test step only after you have verified the program 
is communicating with the Nephelometer and it is able to collect 
data. 
 
1. Select Pause from the main menu to temporarily stop data 

collection. 
 
2. Select the Nephelometer option from the Config menu. The Set 

Nephelometer Parameters display appears (Figure 5-11). 
 

 

Figure 5-11 
The Set Nephelometer Parameters Display Shows the Current Parameters of the 
Nephelometer 
 
 
3. Change the Valve Position parameter to Zero (in the middle of 

the display) and note the Averaging Time (just to the right). The 
Averaging Time is the interval between data collection points. 
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4. Exit from the screen (use the Exit door in the lower right). 

5. Resume data collection.  
 

Clean air is now entering the Nephelometer and the Scattering 
Coefficient numbers, refer to Figure 5-6, should read in the E-7 
or E-8 range. This is the normal background noise level of the 
Nephelometer. The numbers should fluctuate about zero (from 
negative to positive).  

 
If the noise level is within this range, the Nephelometer is 
properly zeroed and calibrated and ready for use.  

 
If the numbers are greater than E-7 or E-8 (an occasional E-6 is 
okay), the Nephelometer is not calibrated properly. (The 
Nephelometer is calibrated before shipment, but the software 
settings may have been corrupted or lost.)  
 
Refer to the calibration procedure described later in this chapter 
to use the Windows-based calibration procedure or refer to 
Chapter 4 to use the DOS-based calibration procedure. The 
procedures themselves are identical. 

 
 
 

M e n u s  a n d  C o m m a n d s :   A  R e f e r e n c e  G u i d e  
This section describes the menus and commands of the Windows-
based Nephelometer software. The section is organized like the 
main menu—commands available under each menu follow the 
menu name. The seven menu items are: 

❑  File 

❑  Config 

❑  View 

❑  Run 

❑  Window 

❑  Pause/Resume 

❑  Help 
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Using the File Menu 
The File menu commands let you perform functions related to 
software file maintenance. 
 
 
Open Log File Command 

Choose the Open Log File command from the File menu to select 
the filename of an existing log file to open and display its data 
(Figure 5-12). You can type the filename (including drive and 
directory) in the filename box or select a file using the list boxes. 
Log files have a .DAT extension.  
 
If you want the AutoZero Data stored in the file (if available) to be 
displayed along with the sample data, select (mark) the Include 
AutoZero Data box. 
 
Select the OK button when done and watch the bottom of the 
display for confirmation that the file is being processed. Large files 
can take a long time to open. After the file is opened, the file’s data 
appears in the Log Data Table window.  
 
Refer to the description of the Log Data Table command under the 
View menu, see below, for the options that are available for viewing, 
graphing, copying and printing this data. 
 
 
Log Data  

Choose the Log Data command from the File menu to identify the 
file you want the Nephelometer to log data to (Figure 5-13). The 
filename defaults to the last name you specified (file extension 
.DAT).  
 
You can type the filename (including drive and directory) in the 
filename box or select a file using the list boxes. The file can be a 
new file or an existing file. 
 
Note: Before data is logged to a file, you MUST have selected a 

filename using the Log Data command. You can begin data 
collection (select Data Collection from the Run menu), but 
unless you specify a filename here, data is not saved to any 
file.  
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Figure 5-12 
Select a Filename After Choosing the Open Log File Command 
 

 

Figure 5-13 
Select a Filename After Choosing the Log Data Command 
 
 
After you select the file and press OK, observe the bottom right 
corner of the display. It should indicate the name of the currently 
selected log file. 
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To stop logging data to a file, select the Log Data command again 
and verify that the logging status is OFF. 
 
You can begin data collection with or without selecting log data file. 
 
 
Print 

Choose the Print command from the File menu to print graphs of 
the data currently being logged (the file selected with the Log Data 
command).  
 
You can print a scatter data graph or a status graph and, if desired, 
add a message header to describing the graph (Figure 5-14). The 
Date/Time Stamp box lets you automatically imprint the time and 
date the graph was printed. Graphs are printed in landscape mode. 
 

 

Figure 5-14 
Select the Print Command from the File Menu 
 
 
Before you print a graph, be certain you Pause data collection. 
(Select Pause from the main menu.) Once you send the graph to the 
printer, select Resume to continue collecting data. 
 
Select the Setup button from the Print display to set up the printer. 
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Note: Normally, you will not need to use Setup or you will only need 
to perform Setup once, since any settings you make will be 
stored with the program. Refer to your Windows 
documentation to change printer options and setup 
parameters. 

 
Figure 5-15 shows a typical scatter data graph (top) and status 
graph (bottom).  
 

 

Figure 5-15 
Types of Graphs. Scatter Data Graph (top) and Status Graph (bottom) 
 
 
Print Screen 

Press the <Print Screen> key to capture the information currently 
on your display and then select the Print Screen command from 
the File menu or press <F9> to print it.  
 
When you select the command, the screen information is captured 
and sent to the printer. Only the information visible on your display 
monitor is printed. 
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Exit 

Choose the Exit command to exit (close) the program and return to 
Windows.  
 

Using the Config Menu 
The Config menu commands let you configure the Nephelometer 
and select the communications port that the Nephelometer is 
connected to.  
 
 
Nephelometer 

Choose the Nephelometer command from the Config menu to read 
the current parameters of the Nephelometer or make changes to the 
Nephelometer settings (Figure 5-16). 
 
Note: Setup is not the same as calibration. Select the Calibration 

command from the Run menu to calibrate or recalibrate the 
Nephelometer. 

 
Table 5-2 lists the parameters that can be set or modified from this 
display. For more detailed information about these settings refer to 
Chapter 6, “Serial Data Commands.”  
 
Changes take affect immediately. Use the Exit button when 
changes are completed. 
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Figure 5-16 
Choose Nephelometer from the Config Menu 
 

Table 5-2 
Nephelometer Setup Parameters 

 
Parameter 

Equivalent Serial 
Data Command 

 
Description 

Analog Output 
Range 

SAcm,v,b.bbbe-b This group of parameters is used to set the 
ranges for PROGRAMMABLE I/O (BNC]. 
Ranges can be set for relative humidity, 
barometric pressure, sample and inlet 
temperatures, and scattering values.  

Select the Set button after making changes to 
a specific type of port.  

Type  Select Barometric Pressure, Relative 
Humidity, Sample & Inlet Temperature or 
Scattering. 

Full Scale (10V) 
Output 

 Enter a value within these ranges: 
Barometric Pressure (1–1200 Mbar) 
Relative Humidity (1–100%) 
Sample & Inlet Temperature (1–400K) 
Scattering (1–10) 

(continued) 
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Table 5-2 
Nephelometer Setup Parameters (continued) 

 
Parameter 

Equivalent Serial 
Data Command 

 
Description 

Zero Volts Output  Enter a value within these ranges: 

Barometric Pressure (0–1199 Mbar) 

Relative Humidity (0–99%) 

Sample & Inlet Temperature (0–399K) 

Scattering (4–10) 

Offset Value  Relates only to Scattering. The offset value 
added to the scattering data allows negative 
values (0.000e–11 to 9.999e–3). 

Analog Output 
Channel 

SBc,t This group of parameters is used to map 
(assign) an analog data type to a hardware 
output on the PROGRAMMABLE I/O (BNC) 
connector. 

Select the Set button after assigning a data 
type to each channel.  

Channel No.  0 = PROGRAMMABLE I/O port 

Analog Data Type  Select one of the following data types for each 
channel (the default channel number is shown 
in parenthesis): 

External Host Value (not assigned) 

Barometric Pressure (1) 

Sample Temperature (2) 

Blue σsp (3) 

Green σsp (4) 

Red σsp (5) 

Blue σbsp (6) 

Green σbsp (7) 

Red σbsp (8) 

Relative Humidity (0) 

Inlet Temperature (not assigned) 

Back Scatter Mode SMBz Select Total Scatter Only to measure only the 
total scatter. 

Select Total/Backscatter to enable the 
backscatter shutter, measuring total scatter 
and backscatter. 

(continued) 
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Table 5-2 
Nephelometer Setup Parameters (continued) 

 
Parameter 

Equivalent Serial 
Data Command 

 
Description 

AutoZero Mode SMZv Sets the mode used to zero baseline drift using 
filtered air. 

In Manual Mode, zeroing of the baseline only 
occurs when a Z command is given. 

In Normal Mode, an autozero is performed at 
the Autozero Period [0 to 9999] 

In Air-Chop Mode, [2 to 24]. Similar to normal 
mode except the last number of autozero 
baselines are averaged together to provide a 
reading. 

Valve Position Vc Normal is used for normal measurements.  

Zero is used for zeroing of the baseline. 

Data Delimiter SDx Sets the character used to delimit data in the 
output file. Select comma, space, or tab 

Date/Time STT Sets the date and time of the Nephelometer's 
internal clock. 

Enter date as mm-dd-yyyy  

Enter time as hh:mm:ss 

Time  Set the time intervals for various 
parameters/operations. 

Averaging STAttt Sets the averaging time, in seconds, over 
which the sample is measured. 

Blank Valve STBttt Sets the blanking time, in seconds, when the 
valve is switching. 

Autozero Period STPttt Sets the time, in seconds, between autozeros. 

Autozero 
Measurement 

STZttt Sets the time, in seconds, the Nephelometer 
spends measuring filtered air during a zero 
baseline measurement. 

Power L Turns the Nephelometer on or off. 

Lamp SP Turns the Nephelometer lamp on or off and 
allows you to adjust lamp power. 

Fan F Turns the fan on or off. 

Heater H Turns the heater on or off. 

Blower (xx%) B Allows you to adjust blower power from 0 (off) 
to 255 (full power) 

External Host xmv SX Sets external host analog value to a specified 
voltage (0 to 5000). 
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Com Port 

Choose the Com Port command from the Config menu to select the 
communications port that the Nephelometer is attached to 
(Figure 5-17). The default is Com Port 2. 
 

 

Figure 5-17 
Use the COM Port Setup Display to Select the Appropriate Communications Port 
 
 
If you need to change the communications port, select another 
communications port and press OK. 
 
 

Using the View Menu 
The View menu commands let you display information collected by 
the Nephelometer and check Nephelometer configuration and 
status.  
 
Note: The Data, Graph, Photon Frequency, and Neph State 

commands can be selected only when data collection is 
ongoing. 

 
 
Data 

Select the Data command from the View menu to display data as it 
is being collected by the Nephelometer (Figure 5-18).  
 
Note: When you start data collection, the Data Display window is 

automatically opened and minimized. You can double-click on 
the Data Display icon to open its window instead of selecting it 
from the View menu. 
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Figure 5-18 
The Data Display Shows Current (raw) Data Values Collected by the Nephelometer 
 
 
The Data Display shows current data values (raw data) and selected 
status information. Each parameter is described in Table 5-3. 
 
Note: The displayed data is updated approximately once a second, 

but data is written to the log data file only at the intervals set 
by the averaging time parameter. 

 

Table 5-3 
Data Display Parameters 

Parameter Description 

Data Record The parameters displayed in these fields show 
the current measurement mode, time 
remaining in the current measurement, and 
the scattering coefficients calculated by the 
Nephelometer.  

Current Mode The mode displayed in the top box can be:  
Blank Period, Zero Measurement, or Normal 
Measurement. The mode displayed in the 
bottom box can be: Total/Backscatter or Total 
Scatter. 

Time Remaining Displays the time remaining in the current 
measurement mode. 

Scattering Coefficient These parameters show the data as it is 
collected and calculated by the Nephelometer. 

(continued) 
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Table 5-3 
Data Display Parameters (continued) 

Parameter Description 

Status Record The information displayed here are current 
parameters calculated by the Nephelometer. 

Pressure (MB) The current barometric pressure in millibars 
(mb) 

Sample Temp. (K) The current sample temperature in °K 

Inlet Temp (K) The current temperature at the Nephelometer 
inlet in °K 

Rel. Humidity The relative humidity of the sample in % 

Lamp Voltage The current voltage applied to the lamp in 
volts DC 

Lamp Current The current amperage applied to the lamp in 
amperes 

BNC Input Voltage The current input voltage to the BNC 

 
 
Graph 

Select the Graph command from the View menu to display 
Nephelometer data graphically as it is being collected (Figure 5-19).  
 
Note: When you start data collection, the Graph window is 

automatically opened and minimized. You can double-click on 
the Graph Display icon to open its window instead of selecting 
it from the View menu. 

 
The default graph options show the scattering coefficients over time 
in the top graph and status parameters in the lower graph.  
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Figure 5-19 
Graph Data of the Current Log Data File 
 
 
Select Graph Options from the Graph Display to customize the 
graph (Figure 5-20). The parameters you can select are described in 
Table 5-4. To print the graph, select Print from the File menu. 
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Figure 5-20 
The Graph Options Window Lets You Customize Your Graphs 
 

Table 5-4 
Graph Options for the Graph Display 

Parameter Description 

Type (scattering 
coefficients only) 

Select linear or log(rithmic) to set the x-axis 
scale of the graph. The maximum value is 
automatically determined by the maximum 
value of the data displayed. 

Scale  Select AutoScale or User-defined to set the 
y-axis of the graph. If you select User-defined, 
you must also set the following parameters: 

Y-Axis Min.—The minimum value for the 
y-axis. 

Y-Axis Max.—The maximum value for the 
y-axis. 

Y-Axis Ticks—The value between each mark 
(tick) on the y-axis. 

Scattering Coefficients Indicates the type of data to be graphed. The 
default is all data. Select (deselect) each 
checkbox. 

(continued) 
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Table 5-4 
Graph Options for the Graph Display (continued) 

Parameter Description 

Maximum No. of Data 
Points 

The maximum number of points to include on 
the graph. If the Log Data file includes more 
than this number of data points, only the 
most current points are displayed. 

Offset Offset the y-axis from 0 (zero) by this amount. 

Refresh Rate How often (in percentage) the graph display is 
updated (refreshed). This is independent of 
the averaging data time. 

Title Enter a title for the graph. Maximum 60 
characters. 

X-Axis Text Enter a label for the x-axis. 

Y-Axis Text Enter a label for the y-axis. 

Legend Text Check this box to include the legend on the 
graph. The legend identifies the type of data 
displayed by each line. 

 
 
Photon Frequency 

Choose the Photon Frequency command from the View menu to 
display the photon frequency data (in Hz) as it is collected from the 
Nephelometer (Figure 5-21) and calculated by the software. 
 
Note: When you start data collection, the Photon Frequency window 

is automatically opened and minimized. You can double-click 
on the Photon Frequency icon to open its window instead of 
selecting it from the View menu. 

 

 

Figure 5-21 
Photon Frequency Display 
 
 
The Photon Frequency display shows the raw photon frequency 
calculated by the software from the raw photon counts collected by 
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the Nephelometer. The raw photon frequency is displayed for each 
section of the calibrate shutter (calibrate, measure, dark), at each 
wavelength (blue, green, red). The data is updated approximately 
once a second. 
 
Note: For more details about photon frequency and calibrate shutter, 

see “Signal Processing” in Chapter 7. 
 
Select Graph from this display to graphically view the data that has 
been collected in the current Log Data file (Figure 5-22).  
 

 

Figure 5-22 
The Photon Frequency Graph Displays Current Measurements 
 
Select Graph Options from the Photon Frequency Graph display to 
customize this graph. The options are nearly identical to those 
described in Table 5-4 except you must select a color (wavelength) 
to indicate the data you want shown on the graph. 
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Neph State 

Choose the Neph State command from the View menu to display 
the operational status of selected Nephelometer components (Figure 
5-23). Use this display to verify general Nephelometer status and to 
troubleshoot problems with the Nephelometer. 
 
Note: When you start data collection, the Neph State window is 

automatically opened and minimized. You can double-click on 
the Neph State icon to open its window instead of selecting it 
from the View menu. 

 

 

Figure 5-23 
The Status of the Nephelometer is Displayed by Selecting Neph State from the 
View Menu 
 
 
All items on the display should be marked with a check mark (✔ ). If 
they are marked with an ✖ , the component/parameter is reporting 
a hardware fault. Review Chapters 2 and 3 and refer to Chapter 8 
for troubleshooting procedures to correct the problem. 
 
 
Neph Config Data  

Choose the Neph Config Data command from the View menu to 
display Nephelometer configuration parameters (Figure 5-24). 
Current Nephelometer configuration parameters are stored in a text 
file named NEPHCNFG.DAT, which is the default config file used by 
the software. 
 
You can display current configuration parameters or read a 
configuration file from disk when the Use Default Config File 
option is selected.  



5-32 Model 3550/3560 Series Integrating Nephelometer 

The information in this display is useful for analyzing system 
problems because you can view all of the parameters as a group. It 
is also useful because you can store, then easily retrieve, different 
configurations if the current Nephelometer configuration should 
become lost or corrupted.  
 
Note: You cannot make changes to the Nephelometer Configuration 

Data from this display.  
 

 

Figure 5-24 
Nephelometer Configuration Data is Displayed by Selecting Neph Config Data from 
the View Menu 
 
 
The buttons across the bottom of the window let you select the 
source and destination of the displayed configuration data. If the 
Use Default Config. File is marked (✖ ), the information will be 
written to or read from the default configuration file named 
NEPHCNFG.DAT. Do not remove this file from your hard drive 
or change its name. 
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Table 5-5 
Nephelometer Configuration Data  

Read Data from Disk Select this button to read Nephelometer 
Configuration Data from a file other than the 
default configuration file. You can then review 
this data before downloading it to the 
Nephelometer. 

Enter the complete path and filename of the 
file to be read. 

Write Data to Disk Select this button to write the currently 
displayed Nephelometer Configuration Data to 
a file to save it. 

Caution: You can write over the default 
configuration file! If the "Use Default Config. 
File" box is checked and you select Write Data 
to Disk, the currently displayed configuration 
information will overwrite the default 
configuration file. The old default 
configuration file will then become a backup 
configuration file (NEPHCNFG.BAK). 

Read Data from Neph Select this button to read the configuration 
data currently being used by the 
Nephelometer. Use this button to verify the 
operating configuration parameters. 

Write Data to Neph Select this button to download the displayed 
configuration data to the Nephelometer, 
replacing the configuration parameters that 
are stored in the Nephelometer. 

Send Data to Printer Select this button to print the currently 
displayed Nephelometer Configuration Data.  

 
 
Log Data Table 

Choose the Log Data Table command from the View menu to 
display data from a previously saved log file or the data currently 
being collected (Figure 5-25).  
 
Note: To view a previously saved data file, you must open the log file 

first by choosing the Open Log File command from the File 
menu. Large files can take a long time to process and load. 
Watch the bottom of the screen to verify the file is being 
processed. 

 



5-34 Model 3550/3560 Series Integrating Nephelometer 

 

Figure 5-25 
Display Log File Records in Tabular Format by Selecting Log Data Table from the 
View Menu 
 
 
Up to eighteen (18) data records are displayed in the window at one 
time. Use the <↑> or <↓> and <→> or <←> arrow keys to view all the 
data and all rows of data in the file. The bottom right corner of the 
window indicates the total number of rows of data. 
 
The information displayed in the table depends on whether you are 
in the analysis operating mode or polled operating mode.  
 
In the analysis mode you are viewing a file that has been saved (not 
the current log file), and the following information is displayed: 

❑  Total Backscattering Coefficients for each wavelength 

❑  Backscattering Coefficients for each wavelength. 

❑  Green Sensitivity 

❑  Barometric Pressure 

❑  Sample Temperature 

❑  Inlet Temperature 

❑  Relative Humidity 
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❑  Lamp Voltage 

❑  Lamp Current 

❑  BNC Input Voltage 

❑  Status Flags 
 
In the polled data mode you are viewing the current log file and the 
following information is displayed: 

❑  Total Backscattering Coefficients for each wavelength 

❑  Backscattering Coefficients for each wavelength. 

❑  Sample Temperature 

❑  Barometeric Pressure 

❑  BNC Input Voltage 

❑  Relative Humidity 
 
The buttons and indicators at the bottom of the table allow you to 
graph the displayed data, copy the data to the clipboard or another 
file, or print the data.  
 
You can graph, copy, or print all rows of data in the table or select 
a range of rows. The Start Row and End Row boxes indicate the row 
of data that will be graphed, copied, or printed.  
 
Use the following procedures to identify the rows to include: 
 
❑  Point the cursor to the first row of data and highlight it by 

clicking the mouse button. Continue holding the mouse button 
and drag the cursor to the last record you want included.  

 
❑  Use the <↑> and <↓> arrows on the Start Row box and End Row 

box to display the first and last record you want graphed. 
 
Once you have defined the rows of data, select Graph or 
Copy/Print. 
 
If you select Graph, the Log Data Graph Options display appears 
(Figure 5-26). Select the appropriate type of graph and press OK. 
Figure 5-27 shows the type of information shown in each graph.  
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Figure 5-26 
Select the Type of Graph from the Log Data Graph Options 
 
 

 

Figure 5-27a 
Operating Status Graph 
 

 

Figure 5-27b 
Photon Counts (Calibrator) Graph 
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Figure 5-27c 
Photon Counts (Dark) Graph 
 

 

Figure 5-27d 
Photon Counts (Measure) Graph 
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Figure 5-27e 
Scattering Coefficients Graph 

 
 

If you select Copy/Print, the Destination dialog box appears 
(Figure 5-28). 
 
The Destination dialog box lets you select the type of data to be 
copied (only the record types marked will be copied), the delimiter 
that will be used between fields, and the destination of the data 
(clipboard or disk file). If you mark the “Include Header Message,” 
the header information—Row, Date/Time, TotScat...etc.—is copied 
along with the data. 
 

 

Figure 5-28 
The Destination Dialog Box 
 
 
If you select Disk File from the Destination dialog box, a Save Disk 
File dialog box appears.  
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If you select Clipboard, the data is copied to the Clipboard and can 
be pasted into another Windows application such as Microsoft 
Excel.® 
 
If you select Printer, the data is sent to the printer.  
 
 

Using the Run Menu 
The Run menu commands let you calibrate the Nephelometer, start 
data collection, and control the Nephelometer through a terminal 
(using the serial data commands described in Chapter 6). 
 
 
Calibration 

Choose the Calibration command from the Run menu to calibrate 
(or recalibrate) the Nephelometer (Figure 5-29).  

 

 

Figure 5-29 
The Nephelometer Calibration Data Display 
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The information displayed on the Calibration Data screen is the 
same as that described in Chapter 4, “Performing Calibration,” and 
you use the same procedure for calibration.  

❑  The top section of the window shows the current calibration 
settings stored in the Nephelometer and any new calibration 
settings not yet saved to the Nephelometer.  

❑  The middle section of the window shows calibration data in 
frequency (Hz) for low span and high span gas in each 
wavelength (blue, green, and red). Calibration data is displayed 
for both total scatter and backscatter modes.  

❑  The bottom section of the window lists the steps you will use to 
calibrate the Nephelometer. Perform each step in the order 
given. As you complete each step, select the button for the 
appropriate step. A check (√) is displayed next to the button as 
it is selected or executed. 

 
Calibration allows you to easily calibrate the Nephelometer using 
two span gases and compare the results between air (low span) and 
CO2 (high span). 
 
You should calibrate the Nephelometer before an intensive 
experiment, calibrate periodically to verify no drift has occurred, 
calibrate if the reference chopper is dirty or scratched, or if you 
clean the chopper as part of periodic maintenance. 
 
The Graph Meas Data button lets you observe (graphically) the low 
span or high span data as calibration is under way. This allows you 
to see graphically the low span gas purged and replaced by the high 
span gas. 
 
The Pause button lets you stop data collection during calibration. 
The button then displays “Continue.” Select Continue to restart the 
data collection.  
 
The New Avg Time button is available on this display to let you 
set/reset a new averaging time without going to the Nephelometer 
Setup display. This allows you to select a lower averaging time to 
have a better response time in viewing the low span gas being 
purged and replaced by the high span gas. 
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Note: If the averaging time is changed to a low number (such as 
5 sec) to view purging, be sure to change the averaging time 
back to a higher number (default is 300 sec). Otherwise, a low 
averaging time may generate very noisy data and result in 
bad calibration. 

 
Before calibration, use the Setup button to set up selected 
calibration parameters (Figure 5-30). From the Calibration 
Parameter display you can set up Calibration Points, Calibration 
Constants and PMT Voltages you want to use and enter a 
Calibration Label String.  

 

 

Figure 5-30 
Calibration Parameters Setup Screen 
 
 
Table 5-6 describes each of the parameters you can set. After 
entering values for each device/parameter type, you must press the 
Set button for the new values to be stored.  
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Table 5-6 
Calibration Parameters 

Parameter Description 

Calibration Points These parameters let you calibrate the four 
internal sensors by entering low and high 
calibration points. 

Sensor Type Select Barometric Pressure, Inlet 
Temperature, Relative Humidity, or 
Sample Temperature. 

r1 Sets the low value of raw A/D converter bits. 

v1 Sets the data value (actual value × 10) for low 
scale calibration point. 

r2 Sets the high value of raw A/D converter bits. 

v2 Sets the data value (actual value × 10) for 
high scale calibration point. 

Calibration Constants These parameters let you enter calibration 
constants for each of the detector 
wavelengths. 

Color Type Select Blue, Green, or Red 

K1 Sets the photon count input pulse width 
(dead time). 

K2 Sets the total scatter calibration of the 
reference chopper in units of inverse meters. 

K3 Sets the Rayleigh scatter of air at 273 °K and 
1013.25 mb. 

k4 Sets the backscatter calibration of the 
reference chopper in units of inverse meters. 

PMT Voltage These parameters set the voltage that drives 
each photomultiplier tube. 

Color Type Select Blue, Green, or Red. 

Voltage Sets the voltage level applied to the 
photomultiplier (0-1200). 

Calibration Label 
String 

Enter text to describe the calibration 
parameters, for example: Last Calibration 
12/25/94. Up to 80 characters. 

 
 
Select the Exit button when you are finished with the Calibration 
Parameters display. 
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Hardware Setup 

Set up the gas before begin you begin calibration. Gas should be 
approximately room temperature as it reaches the Nephelometer. 
One way to ensure this is to use a 6- to 9-meter (20- to 30-foot) 
length of 6-mm (¼-in.) diameter tubing from the CO2 tank to the 
Nephelometer. (The length of the tubing affects the temperature of 
the CO2.)  
 

!
 

C a u t i o n  

 Use calibration gases only in a well-ventilated area or exhaust the gases outside. 
Many gases used for calibration can cause asphyxiation if used in a confined 
area. 

 

Note: If you are using air as the low span gas and CO2 as the high 
span gas, perform the calibration steps in the order given. If 
you are using a gas other than air as the low span gas (like 
helium), refer to calibration process given at the end of this 
procedure. 

 

Table 5-7 
Calibration Procedure 

Step Explanation 

1. Set Low Span Gas Select the low span gas. Air is the default. 
The following types of gas can be selected 
from the list menu: air, CO2, CCl2F2, SF6, 
R22, He and Ar. 

2. Set High Span Gas Select a high span gas, or a gas with a 
higher scattering coefficient than the low 
span gas, CO2 is the default. The following 
types of gas can be selected from the list 
menu: air, CO2, CCl2F2, SF6, R22, He and 
Ar. 

3. Switch Valve Filter Select to switch the filtered air valve to the 
zero (closed) position and to switch the large 
white HEPA filter in-line with the air inlet. 
When you select step 3, a blanking time 
begins. The blanking time is the time it 
takes the filtered air valve to move to the 
zero position plus the time it takes to purge 
the Nephelometer with filtered air. The 
blanking time is set using the Configure 
Nephelometer Parameters window or the 
STB command (see Chapter 6). 

(continued) 
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Table 5-7 
Calibration Procedure (continued) 

Step Explanation 

4. Start Data Collection-
Low Gas 

Select to begin low span gas data collection. 
After you select step 4, data collection 
begins after the blanking time described in 
step 3.  

The low span gas area of the calibration 
screen is updated, but not the high span 
area.  

If you want to observe the filtered air purge, 
select New Avg Time to select a smaller 
averaging time of 5 seconds. The number in 
the Meas field should fluctuate, not rise and 
fall. When the Meas field is stable, select 
New Ave Time to select a 300-second 
averaging time and proceed to step 5. 

5. Clear Buffer Select to clear the Nephelometer internal 
buffers of the data collected during step 4. 
Wait at least 300 seconds, then proceed to 
step 6. 

6. Store Low Span Gas 
Data 

Select to store in the software, the 300-
seconds of low span gas data collected in 
step 5. Selecting step 6 causes the low span 
gas area of the calibration screen to freeze 
and low span data is no longer updated.  

7. Toggle Blower To Off 
(OFF) 

Select to turn off the blower. High span gas 
should be regulated at the source. 

Note: Step 7 can also be used to toggle on 
the blower. 

8. Plug inlet & outlet 
(manual) 

Remove the top cover of the Nephelometer 
using the procedure in Chapter 8. Plug the 
aerosol inlet and outlet of the Nephelometer 
(Figure 4-19). 

9. Feed High Span Gas 
into line (manual) 

Remove the tubing from the inlet of the blue 
DQ filter and connect the tubing from the 
high span gas to either the inlet tubing or to 
the inlet block (Figure 4-19). Turn on the 
gas until the flowrate is approximately 5 
lpm. You should feel gas exiting through the 
DQ filter in the opposite direction of the 
arrow on the filter. Proceed to step 10. 

continued) 
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Table 5-7 
Calibration Procedure (continued) 

Step Explanation 

10. Start Data Collection-
High Gas 

Select to begin high span gas data 
collection. The high span gas area of the 
calibration screen is updated, but not the 
low span area.  

If you want to observe the high span gas 
purge, select New Avg Time to select smaller 
averaging time of 5 seconds. The number in 
the Meas field should fluctuate, not rise and 
fall. When the Meas field is stable with 
minimal fluctuation, select New Avg Time to 
select a 300-second averaging time and 
proceed to step 11.  

11. Clear Buffer Select to clear the Nephelometer internal 
buffers of the data collected during step 10. 
Remain at this step for at least 300 
seconds, then proceed to step 12. 

12. Store High Span Gas 
Data 

Select to store to the software the 300 
seconds of high span gas data collected in 
step 11. Selecting step 12 causes the high 
span gas area of the calibration screen to 
freeze and high span data is no longer 
updated.  

Note: At this time, new calibration 
constants (K2 and K4) are calculated 
and the top section of the screen is 
updated. If the new constants are 
not satisfactory, you can recalibrate 
without changing the constants, as 
long as you do not perform step 14. 

13. Write Calibration Label Select to write an identifying label for the 
calibration performed. The label can include 
the serial number of the Nephelometer, the 
calibration date, the low span and high 
span gases used, and the initials of the 
person performing the calibration. 

(continued) 
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Table 5-7 
Calibration Procedure (continued) 

Step Explanation 

14. Save Cal Data (K2 & 
K4) to Neph 

If the new K2 and K4 calibration constants 
are satisfactory, select 14 to write the new 
K2 and K4 constants to the Nephelometer.  
After selecting step 14,  

1. Remove the high span gas and the inlet 
and outlet plugs from the Nephelometer.  

2. Reconnect the DQ filter to the inlet 
block, with the arrow of the filter 
pointing away from the inlet block.  

3. Replace the top cover of the 
Nephelometer, attaching the cover with 
the four screws.  

4. Select 7 to toggle on the blower and to 
purge the Nephelometer of high span 
gas. 

Note: To allow the Nephelometer to be 
completely purged of high span gas, 
wait at least 600 seconds with the 
blower on before proceeding to 
step 15. 

15. Zero w/Clean Air Optional—Select to purge the Nephelometer 
with clean air and to perform a zero 
background measurement.  

(continued) 
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Table 5-7 
Calibration Procedure (continued) 

Step Explanation 

 If you are using a low 
span gas other than 
air, perform the 
calibration steps in 
this order: 

1. See step 1. 

2. See step 2. 

3. See step 3. 

7. See step 7. 

8. See step 8. 

9. Remove the tubing from the inlet of the 
blue DQ filter and connect the tubing 
from the low span gas to either the inlet 
tubing or to the inlet block 
(Figure 4-19). Turn on the gas until the 
flowrate is approximately 5 lpm. You 
should feel gas exiting through the DQ 
filter in the opposite direction of the 
arrow on the filter.  

4. See step 4. 

5. See step 5. 

6. See step 6. 

9. See step 9. 

A. See step 10. 

B. See step 11. 

C. See step 12. 

D. See step 13. 

E. See step 14. 

F. See step 15. 

 
 
Select Exit when calibration is complete. 
 
 
Data Collection 

Choose the Data Collection command from the Run menu to begin 
collecting data from the Nephelometer.  
 
Note: You can collect data without logging it to a file. If you start 

Data Collection without specifying a file in which to log data, 
no data is logged. To log data, choose Log Data from the File 
menu and enter the name of the file in which you want to 
collect data.  
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When you select Data Collection, four windows are opened and 
minimized (Figure 5-31). Each window represents one of the 
following commands of the View menu: Data, Graph, Photon 
Frequency and Neph State. Refer to the description of each of these 
commands, above. You can maximize (restore) these icons to view 
the data being collected or check Nephelometer status.  
 
To verify that data collection is underway, look in the lower right 
corner of the display. It should indicate Polled. 
 

 

Figure 5-31 
Selecting Data Collection from the Run Menu 
 
 
To stop data collection, select Data Collection from the Run menu 
again. 
 
Data files can become quite large if you have a short averaging time 
and allow data to accumulate over a long period of time. As a rule 
or thumb, do not allow files to get much larger than 450 kbytes.  



Using Nephelometer Software (Windows) 5-49 

Terminal Mode 

Choose the Terminal Mode command from the Run menu to issue 
serial data commands directly to the Nephelometer (Figure 5-32).  
 
You may want to use this method of controlling the Nephelometer 
during troubleshooting. 
 
The serial data commands are described in Chapter 6. Refer to it 
for details.  
 

 

Figure 5-32 
Select Terminal Mode to Issue Serial Data Commands to the Nephelometer 
 
 
To issue a command, type the command and press <Enter>. The 
Nephelometer responds with the information requested, an OK 
acknowledgment, or an ERROR acknowledgment. 
 
 

Using the Window Menu 
The Window menu commands help you organize the open windows 
or arrange icons in open windows.  
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The commands available under this menu (Cascade, Tile, and 
Arrange Icons) are standard Windows commands. Please refer to 
your Windows documentation for complete information. 
 
 

Using the Pause/Resume Menu 
The Pause/Resume menu toggles data collection on and off. After 
you begin data collection (select the Data Collection command 
from the Run menu), data is collected from the Nephelometer. To 
stop data collection temporarily without quitting data collection, 
select Data Collection from the Pause menu.  
 
When you select to pause, the menu name changes to “Resume,” so 
when you want to start collecting data again, select Data 
Collection from the Resume menu. Data collection then continues 
and data is logged to the same log file as before. 
 
 

Using the Help Menu 
The Help menu commands provide access to the program help 
database. This help function is patterned after Windows Help, so if 
you are familiar with Help in Windows, you should find this 
function easy to use. If you are unfamiliar with Windows Help, 
review your Windows documentation.  
 
Help is context sensitive. If you select Help anywhere in the 
program, you will find help for the area you are currently using. For 
example, if you press <F1>, while you are in the Terminal screen, 
the Help screen that details the serial data commands will appear. 
 
 
Contents 

Choose the Contents command from the Help menu to view the 
contents of online help (Figure 5-33). To select the relevant help 
topic, click on the keyword. You can select any word or group of 
words that are underlined (in green color).  
 
Note: You can open help contents anytime by pressing the <F1> key. 
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Figure 5-33 
The Help Contents Display Provides a List of Help Topics 
 
 
About 

Choose the About command from the Help menu to display the 
version level and copyright notice for this Windows-based 
Nephelometer program (Figure 5-34). 
 

 

Figure 5-34 
About Shows the Current Version of Your Software and the Copyright Notice 
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C H A P T E R  6  

Using Serial Data 
Commands 

6-1 

This chapter contains information you need if you are writing your 
own software for a computer or data acquisition system. The main 
sections are: 

❑  Pin connectors  

❑  Baud rate 

❑  Parity 

❑  Command definitions, syntax and examples, as well as input 
and troubleshooting directions. 

 
Note: If you are using the software that TSI provides, refer to 

Chapter 4, "Using Nephelometer Software." 
 
 
 

P i n  C o n n e c t o r s  
The Nephelometer has a single 9-pin, D-subminiature connector 
port on the back panel labeled COM PORT (Figure 6-1). This 
communication port is configured at the factory to work with  
RS-232 type devices. Table 6-1 gives the signal connections.  
 

5 4 3 2 1

9 8 7 6
 

Figure 6-1 
COM PORT Pin Designations 
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Table 6-1 
Signal Connections for RS-232 Configurations 

Pin Number RS-232 Signal 
 1 — 
 2 Transmit Output 
 3 Receive Input 
 4 — 
 5 GND 
 6 — 
 7 — 
 8 — 
 9 — 

 
 
 

B a u d  R a t e  
The baud-rate setting is the rate of communication in terms of bits 
per second (baud).The Nephelometer uses a baud rate setting of 
9600. For proper communications, make sure that all software 
used with the instrument is also set at this rate.  
 
 
 

P a r i t y  ( 8 - B i t s  E v e n )  
Parity is the additional bit that accompanies the seven data bits to 
confirm that they are transmitted correctly. It is set so that the 
number of “1” bits (high) in a transmitted character is always an 
even number. The Nephelometer uses even parity as the only 
setting.  
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C o m m a n d s  
The Nephelometer uses an ASCII-based communications protocol 
that utilizes the RS-232 port of a computer to transmit commands 
in the form of strings.  
 
The four types of commands are: 

❑  Set commands, which set all the operating parameters for the 
Nephelometer 

❑  Action commands, which control mechanical components of the 
Nephelometer 

❑  Read (polled) commands, in which the Nephelometer sends data 
in response to a specific request from the computer 

❑  Unpolled commands, in which the Nephelometer automatically 
outputs data records at specific intervals. 

 
No line feed characters are transmitted. Either the requested data 
or an "OK" is returned if the command is understood. The word 
“ERROR” is returned if the command is not understood or if the 
command has an invalid parameter.  
 
Table 6-2 gives a quick reference of all the serial commands. 
Command definitions, syntax, and examples begin after Table 6-2. 
Directions for inputting commands and troubleshooting commands 
are given at the end of this section. 
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Table 6-2 
Serial Commands 

Set Commands 

SA 
 
SB 
 
SC 
 
SD 
 
SK 
 
SL 
SMB 
 
SMZ 
 
 
SP 
 
STA 
 
STB 
 
STP 
 
STT 
 
STZ 
 
SV 
 
SX 
 
SZ 

Set Analog output range 
SAcm,v,b.bbbe-b 

Set the analog output channel 
SBc,t 

Set Calibration points 
SCxr1,v1,r2,v2 

Set Data Delimiter 
SDx 

Set K calibration constants 
SKcaaaaa,b.bbbe-b,c.ccce-c,ddde-d 

Set calibration Label string 
Set Mode for Backscatter shutter 

SMBz 
Set Mode for autoZero baseline 

measurement 
SMZv 

Set lamp Power 
SPwww 

Set Time for Averaging 
STAtttt 

Set Time to Blank valve 
STBttt 

Set autozero Period 
STPtttt  

Set Time and date 
STTyyyy,mm,dd,hh,nn,ss 

Set Time for autoZero measurement 
STZtttt 

Set Voltage on the photomultiplier tube 
SVcbbb 

Set eXternal host analog value 
SXvvv 

Set Zero baseline (background) 
SZcx.xxxe-x,y.yyye-y,r.rrre-r 

 
Action Commands 
B 
 
F 
 
H 
 
L 
 
PD 
PU 
V 
 
Z 

Blower control 
Bxxx 

Fan control 
Fc 

Heater control 
Hc 

Lamp control 
Lc 

Power Down 
Power Up 
Valve position 

Vc 
Zero command 

Read (Polled) Commands 
RA 
RB 
RD 
RF 
RI 
RL 
RN 
RO 
 
RP 
 
RPG 
RR 
RS 
RT 
RU 
RV 
RX 
 
RY 
RZ 

Read raw Analog bit values 
Read Barometric pressure 
Read scatter Data 
Read status Flags 
Read Inlet temperature 
Read Lamp voltage and current  
Read Noise (sensitivity) level 
Read accumulated On time of 

Nephelometer 
Read all Photon counts (for blue, green, 

and red) 
Read Photon counts for Green 
Read Relative Humidity  
Read Sample temperature 
Read Time and date 
Read all enabled Unpolled records 
Read firmware Version 
Read auXiliary PROGRAMMABLE I/O 

input port  
Read AuxiliarY data record 
Read Zero background data record 

 
 

Unpolled Commands 
UB 
UD 
UE 
UP 
 
UT 
UY 
UZ 

Unpolled operation Begins 
Unpolled Data record 
Unpolled mode Ends 
Unpolled Photon counts 

UPn 
Unpolled Time and date 
Unpolled AuxiliarY status data record 
Unpolled Zero background data record 
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Set Commands 
Set commands allow you to set up operating parameters for the 
Nephelometer. If a set command is sent with no parameter, the 
current parameter is echoed.  

Note: Some of the commands directly affect or are affected by other 
commands. Refer to other commands where indicated. 

 

SA 
 
see  
also 
SB 
SX 
RX 

Set Analog output range 

SA sets the range scales of the PROGRAMMABLE I/O (BNC) port. 
Ranges may be set for relative humidity, barometric pressure, 
sample and inlet temperatures, and scattering values. 

SAcm,v,b.bbbe-b 
where: 
c = analog output  

R for relative humidity 
P for barometric pressure 
T for sample and inlet temperatures 
S for scattering 

m = data value represented by zero (0) volts output 
For R, the integer relative humidity in percent (0 - 99) 
For P, the integer pressure in mbar (0–1199) 
For T, the integer temperature in K (0–399) 
For S, the absolute value of the scattering coefficient exponent 

(integer 4–10). All scattering channels share the same range. 
v = data value represented by full scale output (BNC = 5 volts)  

For R, the integer relative humidity in percent (1 - 100) 
For P, the integer pressure in mbar (1–1200) 
For T, the integer temperature in K (1–400) 
For S, the integer number of volts per decade of scattering  

(1–10 acceptable) 
Note: For SAR, SAP, and SAT commands, v must be greater 

than m. 
b.bbbe-b = offset value added to the scattering data so that 

negative scattering values are allowed (0.000e-11 to  
9.999e-3). This parameter is only used with the SAS 
command.   

(continued on next page) 
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(continued) 

SA Examples 
To set the barometric pressure output to 0.0 volts at zero (0) 
pressure, and 5.0 volts (BNC) at 1200 mb pressure: 
SAP0,2400 

To set the sample temperature output to 0.0 volts at 220 K, and 
5.0 volts BNC at 320 K: 
SAT220,320 

To set the scattering outputs range to 0.0 volts at 10-7m-1, and to 
5.0 volts analog at 10-2m-1 (offset by 1.0e-7m-1): 
SAS7,2,1.00e-7 

 
 

SB 
 
see 
also 

SA 

SX 

RX 

Set the analog output channel 

SB maps an analog data type to a hardware output on the 
PROGRAMMABLE I/O (BNC) connector. 

SBc,t 

where: 
c = analog channel number 

0 = PROGRAMMABLE I/O port 
t = analog data type 

0 = external host analog value (set by the SX command)  
1 = Barometric pressure 
2 = Sample temperature 
3 = Blue σsp 
4 = Green σsp 
5 = Red σsp 
6 = Blue σbsp 
7 = Green σbsp 
8 = Red σbsp 
9 = Relative humidity 

10 = Inlet temperature 

 (continued on next page) 
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(continued) 

SB The following is the factory default configuration: 

Channel Type 
0 9  (Relative humidity) 

Examples 
To make channel 0 computer controlled:  

SB0,0 
Note: The SX command automatically achieves the same results 
as SB0,0. 

To assign Barometric Pressure to channel 0:  

SB0,1 

To echo the channel 1 assignment: 

SB1 
 
 

continued on next page 
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SC 
 
see 
also 

RA 

RB 

RI 

RR 

RS 

Set Calibration points 

SC allows you to calibrate the four internal sensors by entering 
low and high calibration points. 

SCxr1,v1,r2,v2, 

(continued on next page) 
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(continued) 

SC Examples 
To set the inlet temperature calibration at 0 bits to 0 K and at 
38991 bits to 297.9 K: 

SCI0,0,38991,2979 

To set the barometric pressure calibration at 15359 bits to  
126.6 mb, and at 55291 bits to 994.4 mb: 

SCP15359,1266,55291,9944 

To set the relative humidity calibration at 250 bits to 12.0% and at 
645 bits to 96.8%: 

SCR250,120,645,968 

To set the sample temperature calibration at 0 bits to 0 °, and at 
39175 bits to 297.9 °: 
SCS0,0,39175,2979 

To echo the current inlet temperature calibration: 

SCI 
 
SD Set Data Delimiter 

SD sets the character used to delimit data in the output 
responses. 

SDx 
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SK Set K calibration constants 

SK allows you to enter calibration constants for each of the 
detection colors (blue, green, and red). 

SKcaaaaa,b.bbbe-b,c.ccce-c,ddde-d 

 

SL Set calibration Label string 
 
SL enters an ASCII calibration string into the Nephelometer, where 
the string is up to 80 characters terminated with a carriage return. 
 

Examples 
To enter the string "Last calibration 12/25/93" : 

SLLast Calibration 12/25/93 

 

To echo the calibration string: 

SL 
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SMB Set Mode for Backscatter shutter 

SMBz 
where: 
z = backscatter mode (0 or 1) 

0 sets the Nephelometer to measure only in total scatter mode, 
where the backscatter shutter is parked in total scatter 
position. 

1 enables operation of the backscatter shutter, where both 
total scatter and backscatter are measured. 

Examples 
To measure only the total scatter: 

SMB0 

To enable the backscatter shutter, measuring total scatter and 
backscatter: 

SMB1 

To echo the backscatter mode: 

SMB 
 

SMZ 
 
see 
also 
STB 
STP 
STZ 
SZ 
V 
Z 

Set Mode for autoZero baseline measurement 

SMZ sets the method used to zero baseline drift using filtered air. 
See Figures 6-2 and 6-3. 

Note: The duration of zero is set by the STZ command. 

SMZv 
where: 
v = autozero mode (0 to 24) 

0 = manual mode where a zeroing of the baseline only occurs 
when a Z command is given. 

1 = normal mode where an autozero is performed at intervals 
set by the STP command. 

2 - 24 = air-chop mode, which is similar to normal mode (1), 
except that the last "v" measured autozero baselines are 
averaged together. 

Examples 
To set the autozero mode to air-chop, with a baseline zero value 
based on the average of the last twelve readings: 

SMZ12 

To echo the autozero mode: 

SMZ 
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Measurement

2
9

7

6 8

10

4

1

5

3

Nephelometer responses in unpolled mode are sent at the rate set by the averaging time (STA).
Unpolled response of data taken between times 1 and 2.
Beginning of zero baseline measurement cycle. Measurement data is suspended and valve is
  rotated to filtered air position to begin purging the Nephelometer.
Unpolled report containing data accumulated during the purge time. This data is taken during the
  transition from normal measurement to clean filtered air and can be discarded.
Zero baseline measurement begins. Transition data is cleared and filtered air data is 
  accumulated.
Last unpolled report of accumulated data taken during the filtered air measurement.
Zero baseline measurement is stopped and the valve is rotated to normal measurement
  position. The value is stored internally and used for air-Rayleigh subtraction on subsequent
  measurements. 
Unpolled report of current (or air-chopped sum) zero baseline value.
Normal measurement is reactivated. When operating in air-chop mode, the zero baseline value 
  used is the average of the last measurement and any previous measurements as set by the 
  SMZ command.
Unpolled report of measured data. This report contains the data between times 2 and 3 and
  times 9 and 10.
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Figure 6-2 
Timelines for Data Measurement 
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Initiated by Z Command

Measurement

Zero Baseline

STB STZ STB

Manual

Measurement

Normal

STP

Measurement

Air Chop

a b c

If SMZ = 3,
the zero baseline value is

Zero Baseline

Zero Baseline

a + b + c
3 

 
Figure 6-3 
Comparison of Manual, Normal, and Air Chop Modes 
 
 
SP 
 
see 
also 
F 
L 

Set lamp Power 

SP sets the input power of the lamp. 

SPwww 
where: 
www  = watts (0 to 150) 

Examples 
To set the input lamp power to 75 watts: 

SP75 

To echo the lamp power setting: 

SP 
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STA Set Time for Averaging  

STA sets the running average length, in seconds, over which the 
sample is measured. STA also affects the time between unpolled 
reports. See Figure 6-2. 

STAtttt 
where: 
tttt = averaging time (1 - 9960 seconds) 

Internally, the Nephelometer uses a sliding average called  
"boxcar," where the latest value bumps the earliest value from the 
average. Up to 300 values can be stored in each boxcar. The 
following shows averaging time versus boxcar size: 

Averaging Time Boxcar Size 
1 to 300 seconds 1 second 
302 to 600 seconds 2 seconds 
603 to 900 seconds 3 seconds 
906 to 1800 seconds 6 seconds 
1810 to 3000 seconds 10 seconds 
3020 to 6000 seconds 20 seconds 
6030 to 9000 seconds 30 seconds 
9060 to 9960 seconds 60 seconds 

Note: Averaging time entered must be an integer multiple of the 
boxcar size for the range in which the averaging time falls. If not, 
the Nephelometer will use the next smaller valid averaging time. 

Read commands RD and RP report new data only as it changes in 
the running average. Using the information above, if the averaging 
time is set to 3600 seconds, the RD and RP will reflect a change 
every 20 seconds. The analog outputs are also updated once each 
boxcar. 

Examples 
To set the averaging time to 60 seconds: 
STA60 

To echo the averaging time: 
STA 
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STB 
 
see 
also 
SMZ 
STP 
STZ 
SZ 
V 
Z 

Set Time to Blank valve 

STB sets the blanking time, in seconds, when the valve is 
switching. This includes the turning time of the valve as well as 
the purge time of the Nephelometer. During the STB interval, no 
data is taken. See Figures 6-2 and 6-3. 

STBttt 
where: 
ttt = blanking time (5 - 999 seconds) 

Note: The STB value must be less than (STP - STZ)/2  

Examples 
To set the blanking time to 30 seconds: 

STB30 

To echo the blanking time: 

STB  
 

STP 
 
see 
also 
SMZ 
STB 
STZ 
SZ 
V 
Z 

Set autozero Period 

STP sets the time, in seconds, between autozeros. The value set 
with this command is only used if the Nephelometer autozero 
mode is normal or air-chop (SMZ > 0). See Figures 6-2 and 6-3. 

STPtttt  
where: 
tttt = the range (10 - 9999 seconds) 

Note: The STP value must be greater than 2(STB) + STZ. 

Examples 
To set the time between autozeros to 3600 seconds: 

STP3600 

To echo the autozero period: 

STP 
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STT Set Time and date 

STT sets the time and date of the Nephelometer's internal clock. 

STTyyyy,mm,dd,hh,nn,ss 

where: 
yyyy is the year (1994 - 2999) 
mm is the month (1 - 12) 
dd is the date (1 - 31) 
hh is the hour (0 - 23) 
nn is the minute (0 - 59) 
ss is the second ( 0 - 59) 

Examples 
To set the internal clock to December 7, 1994, 10 pm.: 

STT1994,12,7,22,0,0 

To echo the internal clock time and date: 

STT 
 

STZ 
 
see 
also 
SMZ 
STB 
STP 
SZ 
V 
Z 

Set Time for autoZero measurement 

STZ sets the time, in seconds, the Nephelometer spends 
measuring filtered air during a zero baseline measurement. See 
Figures 7-1 and 7-2. 

STZtttt 
where: 
tttt = the range (1 - 9999 seconds) 

Note: The STZ value must be less than STP - 2(STB). 

Examples 
To set the zero baseline measurement to 300 seconds: 

STZ300 

To echo the zero baseline measurement: 

STZ 
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SV Set Voltage on the photomultiplier tube 

SV sets the voltage that drives the photomultiplier tube (PMT). 
This voltage has an effect on the PMT's gain and noise level. 

SVcbbb 
where: 
c = color channel 

B= blue 
R = red 
G = green 

bbb = voltage level applied to the PMT (0 -1200) 

Examples 
To set the blue channel PMT to 850 volts: 

SVB850 

To echo the red channel PMT voltage: 

SVR 

 
 

SX 
 
see 
also 
SA 
SB 
RX 

Set eXternal host analog value 

SX sets the external host analog value to a specified voltage. This 
value appears on the PROGRAMMABLE I/O hardware output 
(factory default) and can be configured with the SB command.  

SXvvv 

where: 
vvv = output voltage in millivolts (0 - 5000 mv for  
  Programmable I/O (BNC) 

Examples 
To set the external host analog value to 2.50 volts: 

SX2500 

To set the external host analog value to 5.0 volts: 

SX5000 

Note: Auxiliary Programmable I/O will read maximum (5 volts).  

To echo the auxiliary PROGRAMMABLE I/O output: 

SX 
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SZ 
 
see 
also 
SMZ 
STB 
STP 
STZ 
V 
Z 

Set Zero baseline (background) 

SZ allows you to externally set zero baseline (background) values, 
normally measured during an autozero measurement. SZ also 
clears previous zero data taken in air-chop mode. In air-chop 
mode, the supplied values are first in the running average of zero 
baseline values. 
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Action Commands 
Action commands control mechanical components of the 
Nephelometer. If you enter an action command without a 
parameter, the mechanical state is echoed back. 

 
B Blower control 

Bxxx 
where: 
xxx = value between 0 and 255, 0 turns the blower off; 255 

represents full power. 

Example 
To set the blower to one-half power: 

B128 

To echo the blower power: 

B 

 
F 
 
see 
also 
L 
SP 
 

Fan control 

Fc 
where: 
c = 1 or 0.  

1 turns the cooling fan on; 0 turns the cooling fan off. 

Note: Turning off the fan also reduces the lamp power to zero. 

 
H Heater control 

Hc 
where: 
c = 1 or 0.  

1 activates the heater control. The heater then operates to 
maintain the sample temperature at or above the inlet 
temperature.  

0 turns the heater control off. 

 
L 
 
see 
also  
F 
SP 

Lamp control 

Lc 
where: 
c = 1 or 0 

1 turns the lamp on to the power set by the SP command; 
0 turns the lamp off. 
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PD Power Down 

PD places the Nephelometer in a minimum power ("sleep") mode. 
When the PD command is given, this sequence occurs: 

1. Lamp power off. 
2. Heater power off (if on). 
3. Chopper and shutter motors stop. 
4. Valve switched to filtered air position (zero). 
5. After a 5 second delay, fan power off. 
6. Blower power off. 

PD 

 
PU Power Up 

PU is the only command accepted after a PD (Power Down) 
command. When the PU command is given, the hardware is 
restored to the operating state present before the PD command 
was given. When the PU command is given, this sequence occurs: 

1. Blower power on 
2. Fan power on. 
3. Lamp power on. 
4. Chopper and shutter motors on. 
5. Heater power on (if on before the PD command). 
6. Ten seconds after the PU command is given and after the 

heater has stabilized, the Nephelometer begins an autozero 
measurement and resumes operation in normal mode. If the 
Nephelometer was in manual mode before the PD command, 
the valve remains in the filtered air position. 

PU 
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V 
 
see 
also 
SMZ 
STB 
STP 
STZ 
SZ 
Z 

Valve position 

Vc 
  where:  
  c = N for Normal position and Z for Zeroing position (filtered air) 

VN changes the position of the valve to the normal measurement 
position. VN clears the averaged measured scattering values, 
but zero scattering values are not adjusted. 

VZ overrides the autozero mode and the average measured 
scattering values are cleared. 

Note: A "FAULT" message (instead of "ERROR") is returned after 
the V command if the valve position is not completed within  
10 seconds. 

Example 
To echo the current position of valve NORMAL, ZERO, or FAULT: 

V 
 

Z 
 
see 
also 
SMZ 
STB 
STP 
STZ 
SZ 
V 

Zero command 

Z causes the Nephelometer to perform a zero baseline 
measurement. In air-chop mode, the zero baseline measurement is 
averaged with the previous baseline data as defined in the SMZ 
command. 

Z 
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Read Commands (Polled) 

Read commands are polled, which means the Nephelometer sends 
data in response to a specific request from the computer 
 
Note: Some of the commands directly affect or are affected by other 

commands. Refer to other commands where indicated. 
 

RA Read raw Analog bit values 

RA allows the reading of pressure, sample temperature, inlet 
temperature, and relative humidity in analog bit value format. 

RA 

Example Response 
RA 26539,13245,13456,980  

 

RB Read Barometric pressure (mbar) 

RB 

Example Response 
RB 1013.2 

 
RD Read scatter Data 

The response to the RD command is in the Data Record (D). See  
the "Unpolled Record Formats" section in this chapter. 

RD 
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RF Read status Flags 

RF returns a four-character hexadecimal value representing the 
state of the Nephelometer. The values for the sixteen flags are as 
follows: 

Bit Position 0 (Normal) 1(Fault) 
0000 0000 0000 0001 Lamp at power Not within 10% of SP  
    setting 
0000 0000 0000 0010 Valve Ok Valve fault 
0000 0000 0000 0100 Chopper Ok Chopper fault 
0000 0000 0000 1000 Shutter Ok Shutter fault 
0000 0000 0001 0000 Heater Ok Heater active but not  
   or inactive   stabilized 
0000 0000 0010 0000 Pressure within range Pressure out of range 
0000 0000 0100 0000 Sample Temp within  Sample Temp out of  
   range   range 
0000 0000 1000 0000 Inlet temp within range Inlet temp out of range 
 
0000 0001 0000 0000 RH within range RH out of range 
0000 0010 0000 0000 Unused 
0000 0100 0000 0000 Unused 
0000 1000 0000 0000 Unused 
0001 0000 0000 0000 Unused 
0010 0000 0000 0000 Unused 
0100 0000 0000 0000 Unused 
1000 0000 0000 0000 Unused 

RF 

Examples Responses 
RF 0002 indicates all flags are normal and the  
   valve is in an unknown position. 

RF 0080 indicates the measured inlet temperature 
   is out of range, possibly due to improper 
   calibration or sensor failure. 

 

RI Read Inlet temperature (K) 

RI 

Example Response 
RI 295.4 

 

RL Read Lamp voltage and current (volts and amps) 

RL 

Example Response 
RL 12.5,4.1 indicates the lamp is operating at 12.5 
   volts and 4.1 amps. 
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RN 
 
see 

also 

SP 

STA 

SV 

Read Noise (sensitivity) levels 
 
Read noise levels based on photon counting statistics. This 
command requires clean filtered air and varies with the lamp 
power (SP), averaging time (STA), and PMT voltages (SV). 

RN 

Example Response 
RN ????. 

 
RO Read accumulated On time of Nephelometer (not including power 

down time) 

RO 

Example Response 
RO 3425,48 indicates the Nephelometer has been on 
   for 3425 hours and 48 minutes. 

 
RP Read all Photon counts (for blue, green, and red) 

RP 

Examples Response 
RP B, G, or R photon count records. See the Photon    
Count Records in the "Unpolled Record Formats"    section 
of this chapter. 

 

RPG Read Photon counts for Green (only) 

RPG 

Example Response 
RPG See the Photon Count Records in the "Unpolled  
   Record Formats" section of this chapter. 

 
RR Read Relative Humidity (0 - 99.9%) 

RR 

Example Response 
RR 15.6 
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RS Read Sample temperature (K) 

RS  

Example Response 
RS 298.0 

 

RT Read Time and date 

RT 

Example Response 
RT See the Time Record (T) in the "Unpolled Record  
   Formats" section of this chapter. 

 
RU Read all enabled Unpolled records 

RU 

Example Response 
RU This command will send all unpolled records that 

have been enabled with the corresponding 
unpolled command. 

 
RV Read firmware Version 

RV 

Example Response 
RV Version 1.3 July 4, 1994 

 
RX 
 
see 
also 

SA 

SB 

SX 

Read auXiliary PROGRAMMABLE I/O input port (millivolts) 

RX 

Example Response 
RX 2543 (indicating an input voltage of 2.543 volts) 

 
RY Read AuxiliarY data record 

RY 

Example Response 
RY See the Status Record (Y) in the "Unpolled Record 
    Formats" section of this chapter. 
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RZ Read Zero background data record 

RZ 

Example Response 
RZ See the Zero Background Data Record (Z) in the 
   "Unpolled Record Formats" section of this 
   chapter 
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Unpolled Commands 
Use unpolled commands to cause the Nephelometer to 
automatically output data records at specific intervals. In unpolled 
mode, 0 disables a record and 1 enables the record. During 
unpolled operation, records that have been enabled are sent at the 
end of each averaging time. 
 
Note: UE is the only command allowed during unpolled operation. 

All other commands receive a “no response.” 
 
UB Unpolled operation Begins 

The only command accepted after UB is UE. 

UB 

 
UD Unpolled Data record 

UD0 disables the record; UD1 enables a record to be sent at the 
end of each averaging time. See Data Record (D) in the "Unpolled 
Record Formats" section of this chapter. 

 
UE Unpolled mode Ends 

UE is the only command allowed during unpolled operation. All 
other commands receive a “no response.” 

UE 

 
UP Unpolled Photon counts 

UPn 
where: 
n = 0, 1, or 3 

0 = disabled 
1 = sends photon counts for green channel only 
3 = sends all three photon count records (blue, green, and  
   red) 
See Photon Count Records in the "Unpolled Record Formats" 
section of this chapter. 

 
UT Unpolled Time and date 

UT1 enables the T record sent at the end of each averaging time; 
UT0 disables the record. See Time Record (T) in the "Unpolled 
Record Formats" section of this chapter. 
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UY Unpolled AuxiliarY status data record  

UY1 enables the record sent at the end of each averaging time; 
UY0 disables the record. See Auxiliary Status Record (Y) in the 
"Unpolled Record Formats" section of this chapter. 

 

UZ Unpolled Zero background data record  

UZ1 enables sending of the zero background data record one time 
after the end of a zero background measurement. 
UZ0 disables sending of the zero background data record. 

See Zero Background Data Record (Z) in the "Unpolled Record 
Formats" section of this chapter. 

 
 
 

Unpolled Record Formats 
The following are examples of unpolled record formats. These 
records are shown with the data delimiter set to space (SD1). 
Delimiters other than a space, cause the record to be packed with 
no added white space. 
 
 
Time Record (T) 

T YYYY MM DD HH NN SS 
 
where: 
T =   Time record 
YYYY =   Year 
MM =   Month 
DD =   Day 
HH =   Hour 
NN =   Minute 
SS =   Second 
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Photon Count Records (B, G, and R) 

B CCCCCCCCC SSSSSSSSS DDDDDD RRRRR LLLLLLLL MMMMMMMMM NNNNNN VVVVV PPPP.P TTT.T 
 
where: 
B =   Photon count record for B , R or G  (Blue, Red, or 

 Green) 
CCCCCCCCC =   Photon counts from calibrator (total scatter) 
SSSSSSSSS =   Photon counts from measure (total scatter) 
DDDDDD =   Photon counts from dark 
RRRRR =   Revolutions of chopper for total scatter 
  measurement 
LLLLLLLL =   Photon counts from calibrator(unused backscatter 

 cycle) 
MMMMMMMMM =   Photon counts from measure (backscatter) 
NNNNNN =   Photon counts from dark (backscatter cycle) 
VVVVV =   Revolutions of chopper for backscatter 

 measurement 
PPPP.P =   Pressure in millibar 
TTT.T =   Sample temperature in degrees K 
 
Notes: In total scatter only mode L, M and N are set to 0 and RR 

reflects revolutions of the calibrator.  
 
 It is possible that for averaging times in excess of 1000 

seconds, the photon count data will overflow the space 
delimited fixed format. In this case the format is extended 
to include the required extra digits. 
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Data Record (D) 

D wxyz TTTT +B.BBBe-B +G.GGGe-G +R.RRRe-R +A.AAAe-A +B.BBBe-B +C.CCCe-C 
 

where: 
D =   Total scatter data record 
w =   Current mode. N if in normal measurement mode, 

     Z if in Zero mode; B if in blanking mode 
x =   T if in total scatter mode; B if in backscatter mode 
y =   X Currently unused 
z =   X Currently unused 
TTTT =   Time remaining in current state 
+B.BBBe-B =   Scattering coefficient in blue 
+G.GGGe-G =   Scattering coefficient in green 
+R.RRRe-R =   Scattering coefficient in red 
+A.AAAe-A =   Scattering coefficient in blue (backscatter) 
+B.BBBe-B =   Scattering coefficient in green (backscatter) 
+C.CCCe-C =   Scattering coefficient in red (backscatter) 
 
Note: In normal mode the Rayleigh scattering signal is subtracted to 

give the scattering coefficient, whereas in zero mode it is not. 
In blanking mode the scattering coefficients retain their value 
from the previous mode. 

 
 

Auxiliary Status Record (Y) 

Y 9999999 PPP.P TTT.T III.I RR.R VV.V AA.A BBBB FFFF 
 
where: 
Y =   Auxiliary status record 
9999999 =   Sensitivity based on green channel (proton 

frequency) 
PPPP.P =   Barometric pressure (mbar) 
TTT.T =   Sample temperature (degrees K) 
III.I =   Inlet temperature (degrees K) 
RR.R =   Relative humidity (%) 
VV.V =   Lamp voltage 
AA.A =   Lamp current 
BBBB =   BNC input voltage (millivolts) 
FFFF =   Status flags (hex) 
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Zero Background Data Record (Z) 

Z +B.BBBe-B +G.GGGe-G +R.RRRe-R +A.AAAe-A +B.BBBe-B +C.CCCe-C  
   +D.DDDe-D +E.EEEe-E +F.FFFe-F  

where: 

Z =   Zero background record 
+B.BBBe-B =   Scattering value from last zero (blue) 
+G.GGGe-G =   Scattering value from last zero (green) 
+R.RRRe-R =   Scattering value from last zero (red) 
+A.AAAe-A =   Scattering value from last zero (blue  

 backscatter) 
+B.BBBe-B =   Scattering value from last zero (green 

 backscatter) 
+C.CCCe-C =   Scattering value from last zero (red 

 backscatter 
+D.DDDe-D =   Rayleigh scattering value from last zero (blue) 
+E.EEEe-E =   Rayleigh scattering value from last zero 

 (green)) 
+F.FFFe-F =   Rayleigh scattering value from last zero (red) 
 
 
T, B, G, R, D, Y and Z Records 

(Shown in order of data transmitted) 
 

T 1994 12 31 23 59 59 

B 999999999 999999999 999999 10990 99999999 999999999 999999 10991 1013.7 299.7 

G 999999999 999999999 9999999 10990 9999999 999999999 999999 10991 1013.7 299.7 

R 999999999 999999999 9999999 10990 9999999 999999999 999999 10991 1013.7 299.7 

D NTXX 9999 +1.111e-1 +2.222e-2 +3.333e-3 +4.444e-4 +5.555e-5 +6.666e-6 

Y 9999999 222.2 333.3 444.4 55.5 66.6 77.7 8888 9999  

Z +1.111e-1 +2.222e-2 +3.333e-3 +4.444e-4 +5.555e-5 +6.666e-6 +7.777e-7 +8.888e-8 

 +9.999e-9 
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How to Input Commands and 
Troubleshoot the Results  
Use the following information as a guide to inputting software 
commands and for troubleshooting possible problems. 
 
 
Input Guidelines 

❑  Input all alpha characters as capital letters (SMZ, not smz). 

❑  Separate parameters with commas, not spaces.  

❑  If you are in a command string, use the <Backspace> key to 
back up and make changes. Do not use <arrow> keys. 

❑  At the end of a command string, press <Enter> to complete the 
string. 
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Troubleshooting Input 

Use Table 6-3 as a troubleshooting guide. 
 

Table 6-3 

Troubleshooting Software Commands 

Symptom Possible Problem Refer to 

"Error" message 
after pressing 
<Enter> 

• An invalid command; command does 
not exist. 

• An invalid parameter, which includes 
too many parameters or a parameter 
that is out-of-range. 

• Incorrect syntax 

• Table 6-3??? in this section. 
 

• The command showing the range 
and an example. 
 

• "Input Guidelines" in this section. 

No response 
after pressing 
<Enter> 

• In unpolled mode • Use the UE command to exit 
unpolled mode. Reenter the 
command if an "OK" is returned. 

 • Serial cable • Check the cable and the cable 
connection. See Chapter 2, 
"Unpacking and Setting Up the 
Hardware." 

 • Incorrect COM port • Check the COM port specified in 
the software.  

 • Incorrect baud rate • Software must be set at 9600 
baud. Also check computer 
hardware. 

 • RS232 chip on the Nephelometer • Contact TSI. Refer to Chapter 9, 
"Contacting Customer Service." 

 • Nephelometer is locked up • Remove power from the 
Nephelometer, then apply power 
to the instrument. If the problem 
continues, contact TSI. 

 • In power down mode (PD command) • Enter the PU (power up) command 
to start the Nephelometer. Reenter 
the command if an "OK" is 
returned. 

 
 
 





C H A P T E R  7  

Theory  of  Operat ion  

7-1 

This chapter contains the theory of operation for the 
Model 3550/3560 Series Integrating Nephelometer with these main 
sections: 

❑  History 

❑  Theory of Integration 

❑  Signal Processing 

❑  Detection Optics 

❑  Calibration 

❑  Theory of Wavelength 
 
 
 

H i s t o r y  

Note: Background information for this section has been taken 
from the paper:  “Three-Wavelength Nephelometer Suitable 
for Aircraft Measurement of Background Aerosol Scattering 
Coefficient,” Bodhaine, Ahlquist, & Schnell, Atmospheric 
Environment, Vol 25A, No 10, pp 2268-2276, 1991. 

 
The integrating Nephelometer has been used extensively for 
measurement of the aerosol light scattering/extinction coefficient  
(σsp) and visual range in ground-based and airborne applications. 
The technique of nephelometery was begun by Beuttell and Brewer 
in 1949, refined by Crosby and Koerber in 1963, and improved by 
Charlson and Ahlquist in 1967. Multiwavelength nephelometers, 
predecessors of the TSI nephelometers, were developed beginning in 
1969. The high-sensitivity integrating nephelometer (Figure 7-1) 
was standardized and commercialized by TSI in 1993 by 
incorporating design improvements and technology advances 
developed over more than two decades. 
 
The integrating nephelometer is a high-sensitivity device capable of 
detecting the scattering properties of aerosol particles. The 
nephelometer detects by measuring the light scattered by the 
aerosol and then subtracting light scattered by the walls of the 
measurement chamber, light scattered by the gas, and electronic 
noise inherent in the detectors.  
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Figure 7-1 
Nephelometer Schematic 

 
 
The three-color detection version of the TSI nephelometers detects 
scattered light intensity at three wavelengths. Normally the 
scattered light is integrated over an angular range of 7–170° from 
the forward direction. But with the addition of the backscatter 
shutter feature to the Nephelometer, this range can be adjusted to 
either 7–170° or 90–170° to give total scatter and backscatter 
signals. This provides additional useful information about the 
particle scattering behavior. 
 
 
 

C o n s t r u c t i o n  
The integrating nephelometer is constructed primarily of aluminum 
parts for purposes of rigidity, ruggedness, and weight. The main 
body of the nephelometer consists of 10 cm diameter thin walled 
aluminum tubing, which is approximately 90 cm long. Aperture 
plates are set along the axis of the tube, held and spaced by 8 cm 
diameter tubing. Receiving optics are located at one end of the main 
tube with a light trap located at the other end to provide a very 
dark reference against which to view the light scattered by particles 
and gas.  
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A 75 watt quartz-halogen lamp, with a built-in elliptical reflector, 
provides illumination for the aerosol. The reflector focuses the light 
onto one end of an optical pipe where the light is carried into the 
internal cavity of the instrument. The optical pipe is used to 
thermally isolate the lamp from the sensing volume. 
 
The output end of the optical light pipe is an opal glass diffuser 
that acts as a cosine (Lambertian) light source. Within the 
measuring volume, the first aperture on the detection side of the 
instrument limits the light integration to angles greater than 7°, 
measured from the horizontal at the opal glass. On the other side, a 
shadow plate limits the light to angles less than 170°. The 
measurement volume is defined by the intersection of this light 
with a viewing volume cone defined by the second and fourth 
aperture plates on the detection side of the instrument. The fourth 
aperture plate incorporates a lens to collimate the light scattered by 
aerosol particles so that it can be split into separate wavelengths. 
 
The nephelometer uses a reference chopper to calibrate scattered 
signals. The chopper makes a full rotation 23 times per second. The 
chopper consists of three separate areas labeled: signal, dark, and 
calibrate (Figure 7-2).  
 

100°
80°

Dark
Cal
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(Open)

180°

Rotation Direction
From Light Side

 

Figure 7-2 
Reference Chopper Zones  
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The signal section covers 180° and simply allows all light to pass 
through unaltered. The dark section covers 100° and is a very black 
background that blocks all light. This section provides a 
measurement of the photomultiplier tube (PMT) background noise. 
The third section, calibrate, covers 80°. The light source directly 
illuminates this section providing a measure of lamp stability over 
time. To reduce the lamp intensity to a level that will not saturate 
the photomultiplier tubes, the calibrate section incorporates a 
neutral density filter that blocks approximately 99.9% of the 
incident light.  
 
To subtract the light scattered by the gas portion of the aerosol, a 
high-efficiency particulate air (HEPA) filter is switched periodically 
in line with the inlet. This allows compensation for changes in the 
background scattering of the nephelometer, and in gas composition 
that will affect Rayleigh scattering of air molecules with time. The 
HEPA filter is switched into line using an automated valve, 
activated by a gear motor and positioned, using an optical position 
sensor. When the HEPA filter is not in line with the inlet, a small 
amount of filtered air leaks through the light trap to keep the 
apertures and light trap free of particles. A smaller HEPA filter 
allows a small amount of clean air to leak into the sensor end of the 
chamber between the lens and second aperture. This keeps the lens 
clean and confines the aerosol light scatter to the measurement 
volume only. 
 
 
 

T h e o r y  o f  I n t e g r a t i o n   
The property of interest in using the integrating nephelometer is 
usually the extinction of light over a short distance. Light extinction 
is caused by the properties of both light absorption and light 
scattering caused by air or other gas and by the particles within the 
gas. The total extinction coefficient, σ, is the sum of these 
properties. The effect is generally described by the Beer-Lambert 
law: 

I
Io e ext x

 =  
(-  )σ

 [equation 7-1] 
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where:  

σext = σscat + σabs = ln(I/Io)/x 
x = distance in meters (length of light path) 
I = intensity of light after distance 
Io = intensity of incident light 
 

σscat and σabs are called the scattering and absorption coefficients 
and are described by: 
 
 σscat = σrg + σsp [equation 7-2] 

 σabs = σag + σap [equation 7-3] 
 
where:  
 σrg = term for Rayleigh scattering  
 σsp = term for scattering by particles 
 σag = term for absorption by gases  
 σap = term for absorption by particles  
 
The integrating nephelometer measures the σscat term and 
generates the σsp term by subtracting the σrg term from σscat using 
(equation 7-2).  
 
Since it is often assumed that σsp 〉 σap or that σsp 〉〉 σap for areas 
other than those having high concentrations of soot particles, the 
measure of σsp often gives a good estimate of the aerosol 
contribution to σext. Also, σag is usually negligible. 
 
The basic geometry of the TSI integrating nephelometer was first 
described by Beuttel and Brewer (1949). Since this geometry 
integrates the intensity of the scattered light over close to 4π 
steradians, it gives a good approximation of the scattering 
component of extinction, σsp. Figure 7-3 shows a schematic of this 
geometry which results in the integration of the angular scattering 
function, β(φ), such that the sensor detects the flux B due to the 
light source with intensity Io located at a distance y from the 
detector axis: 

 

B Io
y d= z β φ φ φ

φ

φ
( )sin

1

2
 [equation 7-4] 
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Since the nephelometer has a Lambert (cosine φ) source, and if we 
make the assumption that φ1≈0 and that φ1≈π, then:  

 
B ≈ (Io/y) * (σscat/2π) [equation 7-5] 

 
These equations are derived formally by Middleton (1958) and by 
Butcher and Charlson (1972). 
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Figure 7-3 
Nephelometer Geometry 
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T h e o r y  o f  W a v e l e n g t h  D e p e n d e n c e  
The theory of wavelength dependence of light scattering is simple to 
define in the broad sense, and has substantial detail in application. 
The simple explanation is that smaller particles scatter differently 
than larger particles which results in different amounts of 
scattering at different wavelengths. 
 
Light scattered by particles less than 0.05 µm is described in 
relatively simple terms by Rayleigh's theory. Particles larger than 
10 µm must be described by geometric optics. Particles between 
these sizes can be analyzed using the much more complicated Mie 
scattering theory. The scattering of these particles is complicated 
because the size of particle and the wavelength of light have the 
same order of magnitude. 
 
However, if we consider a polydisperse aerosol, which is usually the 
case for atmospheric aerosols, the wavelength dependence in the 
Mie region is dictated entirely by the size distribution and can be 
analyzed in a simpler fashion than the full blown Mie theory. 
 
All materials have a describing characteristic called the index of 
refraction (m). This is the ratio of the speed of light in a vacuum (c) 
to the speed of light in a particular material (Vp). 
 

m
c

Vp

=
 [equation 7-6] 

 
c ≅ 3 ×1010 cm/s, is the speed of light in a vacuum. 
 
The scattering of particles is governed by the ratio of the particle 
size (d) to the wavelength of light (λ). This dimensionless number is 
called the size parameter a. 
 

a = (π*d)/λ [equation 7-7] 
 
As can be seen from the equation, for a << 1 particles are in the 
Rayleigh region and for a ≅ 1 they are in the Mie region. 
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Rayleigh's equation is as follows: 
 

I
I d m

R m
d m

o
θ

π

λ
θ µa f

e j
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 [equation 7-8] 
 
Where m is the index of refraction and R is the distance of the 
particle, at angle θ, from the light. 
 
It is already evident even for the case of Rayleigh scattering that 
particle size relative to wavelength is a key concern. 
 
A simple description of the way that particle size distribution 
controls the wavelength dependence of σsp for a ≅ 1  can be stated, 
starting with the empirical observation that σsp for atmospheric 
aerosols is often close to a power-law function of wavelength: 
 
σsp = C λ–å [equation 7-9] 

 
where: 

C = a quantity describing the amount of scattering 
å = Angstrom exponent 

 
The number distribution of atmospheric aerosol often can be 
crudely described as a power-law function of size: 
 

dN/dlog r = c r–β [equation 7-10] 

 
where: 

N = number concentration 
r = particle radius 
c = related to total concentration 
β = slope of the number distribution on a log-log plot. 

 
If this is approximately true, which is usually the case for a ≅ 1, 
then it can be shown that: 
 

å = β–2 [equation 7-11] 
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Thus, what controls å is the slope of the number distribution; in 
other words the relative amounts of fine and course particles. 
Typically values of å for gases are very nearly 4, for urban aerosols 
are on the order of 2, for rural haze 1–2, and close to 0 for very 
course aerosols like wind blown dust or sea salt. For large values of 
å, there will be a large difference in scattering at different 
wavelengths and for small values of å, for example near 0, 
scattering at different wavelengths are nearly equal. 
 
Because the Model 3550/3560 Series Nephelometers can calculate 
the logarithm of σsp as an analog output, a simple numerical 
exercise yields the quantity å: 
 
since  
 
σsp = Cλ–å 
log σsp = log C–å log λ [equation 7-12] 

 
so taking the derivative (dlog C = 0) 
 

dlog σsp = –å dlog λ [equation 7-13] 
 
Since the Nephelometer measures at different specific wavelengths, 
we can approximate the derivative with a finite difference: 

&
log

log

log log

log log
a sp sp sp≅ =

−

−

∆

∆

σ

λ

σ λ σ λ

λ λ
2 1

2 1

c h c h  [equation 7-14] 

 
Why measure å? 
 
One of the main reasons to measure σsp is to quantify and 
understand how it governs the transfer of light through the air. 
Examples are the partial transmission of sunlight to the earth’s 
surface, transmission of lasers or other light beams horizontally or 
the appearance of haze in front of distant vistas. Because σsp is a 
function of wavelength, λ, different amounts of blue versus red light 
are transmitted. Usually, atmospheric aerosols scatter more blue 
light than green or red light, that is σsp for blue light is greater than 
σsp for green light etc. However since å is variable and visible light 
spans quite a range of wavelengths (roughly 400–700 nm) it is 
necessary to know å in order to quantify the transmission of all the 
wavelengths. 
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Measurement of å also provides a continuous record of variations 
in the size distribution via estimation of variations of β. 
 
In conclusion for a << 1, e.g., for λ = 0.6 µm, d << 0.1 µm, the 
Rayleigh theory is typically valid. The intensity of the Rayleigh 
scatter is proportional to the sixth power of the particle diameter 
and inversely proportional to the fourth power of the incident 
wavelength. 
 
For α ≅ 1, where the particle diameter and the wavelength are of the 
same magnitude, say 0.1–1 µm, atmospheric aerosol scattering can 
often be described by a simple power-law function, which is 
governed solely by the slope of the number distribution of the 
aerosol on a log-log plot. 
 
 
 

S i g n a l  P r o c e s s i n g  
This section describes the microprocessors and equations used in 
the Nephelometer firmware to calculate various scattering 
coefficients from the raw scatter data and calibration data. 
 
 

Description 
All electronics are located inside the nephelometer. Two 
microprocessors are used to control all functions. A Motorola 
68HC711D3 microprocessor is used to control the brushless DC 
motors used to spin the reference chopper and optional backscatter 
shutter. A Motorola 68HC16Z1 microprocessor is used to control all 
other signal processing and input/output operations. All setup and 
configuration is done through the serial interface to an external 
computer with all parameters stored in the Nephelometer's battery-
backed-up RAM.  
 
 

Equations/Calculations 
This section contains firmware and calibration equations for the 
Nephelometer. 
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Firmware Calculations 

The Nephelometer calculations begin with the raw signals received 
from the photomultiplier tubes (PMT) for each color, for each 
section of the reference chopper and for each rotation of the 
backscatter shutter. Therefore, there are eighteen values. In 
addition, the number of cycles of the chopper are given for each 
color. This is the data that is sent from the nephelometer as raw 
count data. Examples are shown in Table 7-1. 
 

Table 7-1 
Examples of Raw Count Data 

Color           Total Scatter              Backscatter  

 Calibrate Signal Dark Cycles Calibrate Signal Dark Cycles 

Blue 523939 12691 28 693 413847 6350 16 693 

Green 1022163 12185 52 693 807927 6146 27 693 

Red 514975 5271 1038 693 401071 3835 1021 693 

 
 
These values are the raw photon counts for each portion of the 
reference chopper for each color. Since the angular width of each 
portion of the chopper is different, the values are normalized for 
gate width and number of cycles during the measurement. This 
converts the photon counts to cycles/second (Hz) using the 
equation: 
 

Cs = (360*C*S)/(G*N) [equation 7-15] 
 
where: Cs = scaled count rate (Hz) 
 C = raw photon count rate 
 S = speed of reference chopper (22.994 RPS) 
 G = gate width in degrees 
  40° for calibrate section 
  140° for signal section 
  60° for dark section 
 N = number of revs in measurement 
 
Notes: The gate widths defined in equation 7-15 do not add up to 

360° as one might imagine. This is because there is a 40° 
period between each of the sections to blank the overlap.  

 The calibrate signal taken during the backscatter cycle is not 
entirely used in the measurement cycle because the chopper 
is not illuminated during the backscatter cycle. 
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Table 7-2 shows the comparisons between gate width and physical 
dimensions of the three sections. 
 

Table 7-2 
Comparisons Between Gate Width and Physical Dimensions 

Shutter 
Area 

 
Gate Width [°] 

 
Physical Width [°] 

 
Blank Width [°] 

Calibrate 40 80 40 

Signal 140 180 40 

Dark 60 100 40 

Total 240 360 120 

 
Note: Blank width is 20° at the beginning and 20° at the end of each 

gate. 
 
Next, each of the scaled count rates is corrected for dead time (due 
to photomultiplier pulse width) by the approximation: 
 

F = Cs*(Cs*K1 + 1) [equation 7-16] 
 
where: K1 = constant based on pulse width (picoseconds/counts) 
 Cs = scaled count rate (Hz) 
 F = corrected count rate (Hz) 
 
When the numbers from the Table 7-1 are run through 
equation 7-15 and equation 7-16, the results are shown in 
Table 7-3. 
 

Table 7-3 
Counts Normalize to Photon Frequency (Hz) 

Color Total Scatter Backscatter 

 Calibrate Signal Dark Calibrate Signal Dark 

Blue 156950 1083 6 123890 542 3 

Green 307105 1040 10 242430 524 5 

Red 154257 450 207 120056 327 203 

 
 
Next, the nephelometer calculates averages of the data using a 
simple boxcar running average with up to 300 elements. Each of 
the eighteen values in Table 7-4 are averaged, depending on the 
averaging time selected. 
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Table 7-4 
Boxcar Averages 

Selected Boxcar Average Seconds per Boxcar 

1 to 300 1 

302 to 600 2 

603 to 900 3 

906 to 1800 6 

1810 to 3000 10 

3020 to 6000 20 

6030 to 9000 30 

9060 to 18000 60 

 
 
Next, the nephelometer uses the scaled and corrected count rates 
to calculate the raw scattering signals for each of the three colors. 
Periodically, the aerosol sampled by the nephelometer is filtered to 
determine the background scattering portion of the total scattered 
light. At all times, the nephelometer automatically monitors the 
temperature and pressure to allow correction of these 
environmental parameters. This is important since the Rayleigh 
scattering by gas molecules is dependent on temperature and 
pressure. Also, the user periodically performs a manual calibration 
with a span gas such as CO2. 
 
The nephelometer calculates two raw scattering signals: one for the 
aerosol and the other for filtered air: 
 

Bf = K2*(Sf – Df)/(Cf – Df) [equation 7-17] 
 

where: Bf = filtered air raw scatter signal 
 K2 = constant determined by span gas 
 Cf = calibrate (Hz) scaled count rate for filtered air 
 Sf = signal (Hz) scaled count rate for filtered air 
 Df = dark (Hz) scaled count rate including the dark 

measured during total scatter and backscatter 
 

Ba = K2*(Sa – Da)/(Ca – Da) [equation 7-18] 
 

where: Ba = aerosol raw scatter signal 
 K2 = constant determined by span gas 
 Ca = calibrate (Hz) scaled count rate for aerosol 
 Sa = signal (Hz) scaled count rate for aerosol 
 Da = dark (Hz) scaled count rate for aerosol 
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The Rayleigh scattering is calculated for the filtered air 
measurement and for the clean air using the equations including 
temperature and pressure: 
 

Rf = (K3*Pf*Ts)/(Tf*Ps) [equation 7-19] 
 
where: Rf = filtered air Rayleigh scatter 
 K3 = Rayleigh scatter of air for given color 
 Pf = pressure of filtered air 
 Ts = standard temperature (273.2 K) 
 Tf = temperature of filtered air 
 Ps = standard pressure (1013.3 mbar) 
 
 

Ra = K3*(Pa/Ta)*(Ts/Ps) [equation 7-20] 
 

where: Ra = aerosol Rayleigh scatter 
 K3 = Rayleigh scatter of air for given color 
 Pa = pressure of aerosol 
 Ta = temperature of aerosol 
 Ps = standard pressure (1013.3 mbar) 
 Ts = standard temperature (273.2 K) 
 
 
These parameters allow us to calculate a variety of interesting 
numbers for each of the three colors: 
 

W = Bf – Rf [equation 7-21] 
 

where: W = filtered air wall scatter 
 Bf = filtered air raw scatter signal 
 Rf = filtered air Rayleigh scatter 
 

Bs = Ba – W [equation 7-22] 
 
where: Bs = total scatter (particles + Rayleigh) 
 Ba = aerosol raw scatter signal 
 W = filtered air wall scatter 
 
σsp = Bs – Ra [equation 7-23] 
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where: σsp = aerosol scatter 
 Bs = total scatter (particles + Rayleigh) 
 Ra = aerosol Rayleigh scatter 
Equations 7-21, 7-22, and 7-23 can also be calculated for 
backscatter only by using the backscatter signal from Table 7-3 
and multiplying all Rayleigh scatter by K4.  
 
Note: W and Ra will be different for backscatter than for total scatter.  
 
 
Calibration Calculations 

The previous equations use the four calibration factors: K1, K2, K3, 
and K4. These constants are obtained by calibration or 
measurement of the nephelometer. 
 
The constant, K1, is a one time calibration factor based on the 
measured pulse width of the photomultiplier tubes for each color. 
This parameter is set at the factory and used to correct for the dead 
time when a pulse is registered on the photomultiplier tube, 
preventing a second pulse from being registered. 
 
K2 is calculated during calibration using a equation similar to 
equation 7-8 and a table of wavelength-dependent, theoretical 
Rayleigh-scattering coefficients (from Table 2, Bodhaine, et. al.) 
 
The constant K3 represents the known scattering value for air at a 
standard temperature and pressure condition for the wavelength in 
question.  
 
K4 is a constant near 0.5 representing the ratio of Rayleigh 
backscatter to Rayleigh total scatter.  
 
 
Calculation of K2 using total scatter data (equations 7-22 and 7-23) 
can be expanded to: 
 

ltlsp RWB −−=σ  [equation 7-24] 

 
For low span gas 
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For high span gas 
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where: Bl = low span gas raw scatter signal 
 Bh = high span gas raw scatter signal 
 Rl = low span gas Rayleigh scatter 
 Rh = high span gas Rayleigh scatter 
 Wt, Wb = wall scatter (total or backscatter) 
 Cl = low span gas calibration average scaled count rate 
 Dl = low span gas dark average scaled count rate 
 Sl = low span gas signal average scaled count rate 
 Slb = low span gas backscatter signal average scaled count 

rate 
 Pl = low span gas calibration pressure 
 Tl = low span gas calibration temperature 
 K3l

 = low span gas scattering coefficients at standard 
pressure and temperature 

 Ch = high span gas calibration average scaled count rate 
 Dh = high span gas dark average scaled count rate 
 Sh = high span gas signal average scaled count rate 
 Shb = high span gas backscatter signal average scaled 

count rate 
 Ph  = high span gas calibration pressure 
 Th  = high span gas calibration temperature 
 K3h

 = high span gas scattering coefficients at standard 
pressure and temperature 

 Ps = standard pressure (273.2K) 
 Ts  = standard temperature (1013.3 mbar) 
 
Equations 7-25 and 7-26 are equal to zero because there are no 
particles present, and therefore, no scattering by particle (σsp = 0). 
Scattering is only from the wallscatter and the Rayleigh scatter of 
the gas. 
 
We have two equations, two unknowns K2 and Wt (wall). Subtract 
equation 7-25 from 7-26 to eliminate Wt. 
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To get: 
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Solve for K2: 
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Generally, the low span gas in filtered air and the high span gas is 
CO2 or CCl2F2. 
 
 
K4 can be calculated using the backscatter data and K2 calculated 
from above. 
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Again, subtract equation 7-29 from 7-30 to eliminate Wb (wall). 
Solve for K4: 
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D e t e c t i o n  O p t i c s  
The detection optics depend on the model of the nephelometer. The 
single wavelength unit (TSI Models 3551/61) consists of a 
broadband-coated 400 mm focal-length lens used to collimate the 
diverging light defined by apertures in the body of the instrument. 
This light is then passed through a 40 nm bandpass filter centered 
at 550 nm before entering a photomultiplier tube (green channel).  
 
The three wavelength instrument (TSI Models 3553/63) contains 
the same lens as the single wavelength device. From the lens, the 
scattered light is separated by dichroic filters to three bandpass 
filters and separate photomultiplier tubes. The first wavelength is 
reflected by a color splitter that passes 500-800 nm light and 
reflects 400–500 nm light, through a 40 nm bandpass filter, 
centered at 450 nm, into a photomultiplier (blue channel). Light 
that passes through the first color splitter is split again by a filter 
that passes 500–600 nm light and reflects 600–800 nm light, 
through a 40 nm bandpass filter centered at 700 nm to a PMT (red 
channel). The light that passes through both color splitters 
(500-600 nm) continues to a 40 nm bandpass filter, centered at 
550 nm and a PMT (green channel). 
 
 
 

C a l i b r a t i o n  
The Nephelometer is a photon counting instrument. Particles and 
gas molecules scatter photons that are detected and counted using 
highly sensitive photomultiplier tubes. These photon counts are 
converted into counting frequencies and correlated to light 
scattering coefficients using calibration constants. These constants 
are determined by filling the nephelometer’s interior measurement 
volume with two span gases, one at a time, that have largely 
different scattering coefficients and measuring a few key 
parameters. By measuring the photon frequency, temperature, and 
pressure for each span gas measurement, and knowing the 
scattering coefficient for each of the span gases at a known 
temperature and pressure (e.g., STP), and using two simple 
equations, the calibration constants are easily calculated. For more 
detail on the calculations see “Calibration Calculations” earlier in 
this chapter. 
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Performing 
Maintenance 

8-1 

Use the procedures in this chapter to maintain the 
Model 3550/3560 Series Integrating Nephelometer. Most 
maintenance procedures do not have specific time guidelines, but 
should be performed based on software or hardware failures, 
degradation in overall performance, or as a result of the special 
environments in which the Nephelometer may be used.  
 
Table 8-1 gives an overview of the procedures in this chapter. The 
organization of the table reflects the order in which the procedures 
are presented. 

Table 8-1 
Maintenance Overview 

Maintenance Procedure Perform: 

With the top and bottom covers on: 

Calibrate the Nephelometer 

 

Periodically, or if the reference chopper is dirty or 
scratched. 

Clean or replace the fan filters If a visual check shows the filters are clogged. 
  
With the top cover off: 

Replace the main microprocessor EPROM 

 

As part of a firmware update. 

Replace the motor control microprocessor As part of a firmware update. 

Replace the lamp If there is a status failure in the software, or periodically 
based on the power rating and the hours of use. 

Replace the aerosol filters Periodically, or if there is a significant drop in pressure. 

Clean the light pipe lens As needed, depending on the cleanliness of the 
environment in which the Nephelometer is operated. 

Check for leaks If the instrument is disassembled and is to be used in a 
low pressure environment. 

  
With the top and bottom covers off: 

Clean the reference chopper 

 

If the calibrate signal changes dramatically while using 
the lamp at a constant power. 

Clean the light pipe outlet and the 
backscatter shutter 

As needed, depending on the cleanliness of the 
environment in which the Nephelometer is operated. 

Clean the flocked paper If the background signal rises over time. 
  

With the photomultiplier tube (PMT) cover 
off: 

Replace PMTs 

 
 

If a failure occurs. 

Check, clean, or replace bandpass filters Periodically, or if using in a high-humidity environment. 

Clean the lens If there is an overall reduction in the signal of all three 
wavelengths over time.  
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R e m o v i n g  N e p h e l o m e t e r  C o v e r s :  T o p ,  
B o t t o m ,  a n d  P M T  

This section give instructions for removing Nephelometer top, 
bottom or PMT covers, necessary for most maintenance or 
hardware troubleshooting procedures (Figure 8-1).  

Note: The steps needed to remove covers are also included, when 
appropriate, in each maintenance procedure. 

 

 

Figure 8-1 
Nephelometer Showing Top, Bottom, and PMT Covers 
 
 

Removing the Top Cover 
To remove the top cover of the Nephelometer: 

1. Remove power from the Nephelometer and from any 
instruments connected to the Nephelometer. 

2. Loosen the four screws fastening the Nephelometer cover and 
remove the cover (Figure 8-2). 
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C a u t i o n  
To avoid damage to the electronic circuitry, use electrostatic discharge (ESD)        
precautions when removing the top or bottom Nephelometer cover: 

❑  Use only a table top with a grounded conducting surface. 

❑  Wear a grounded, static-discharging wrist strap. 
 
 

Top Cover Screws (4) 

Bottom Cover Screws (4) 

Fan Panel Screws (2) I/O Panel Screws (3) 

 

Figure 8-2 
Top Cover Screws, Bottom Cover Screws, Fan Cover Screws, and I/O Panel 
Screws 
 
 

Removing the Bottom Cover 
To remove the bottom cover of the Nephelometer: 

1. Remove power from the Nephelometer and from any instruments 
connected to the Nephelometer. 

2. Remove the top cover using the procedure in this section. 
 
 

 

C a u t i o n  
To avoid damage to the electronic circuitry, use electrostatic discharge (ESD)        
precautions when removing the top or bottom Nephelometer cover: 

❑  Use only a table top with a grounded conducting surface. 

❑  Wear a grounded, static-discharging wrist strap. 
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3. The bottom cover of the Nephelometer is pliable and fits very 
tightly around the bottom of the instrument. Remove the 
bottom cover in one of two ways: 

❑  The more difficult method is to pry off the bottom cover 
without removing the I/O panel and the fan panel. Unscrew 
the four bottom cover screws (Figure 8-2). Carefully remove 
the bottom cover, working alternately at both ends. Pry the 
edges of the cover apart, and ease the cover away from the 
body of the Nephelometer. 

❑  The easier method takes more time. After removing the I/O 
panel, the fan panel and the end plate, slide the bottom 
cover off the body of the instrument. Using Figure 8-2 as a 
reference: 

a. Unscrew the three screws securing the I/O panel to the 
backbone, loosen the panel, and let the panel hang over 
the side of the instrument. 

b. Unscrew the two screws securing the fan panel to the 
backbone, loosen the panel, and let the panel hang over 
the side of the instrument.  

c. Unscrew the three screws securing the end plate to the 
inlet section of the instrument and remove the end plate. 

d. Unscrew the four bottom cover screws, and carefully 
slide the cover off the end of the instrument. 

Note: Attach the bottom cover of the Nephelometer reversing the 
steps in step 3 of this procedure. Remember that the cover 
is pliable and fits tightly around the bottom of the 
instrument. 
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Removing the PMT Cover 
To remove the PMT cover: 

1. Remove power from the Nephelometer and from any instruments 
connected to the Nephelometer. 

2. Unscrew the four screws attaching the PMT cover to the sensor 
and remove the cover (Figure 8-3).  

 
 

 

C a u t i o n  
To avoid damage to the electronic circuitry, use electrostatic discharge (ESD)        
precautions when removing the Nephelometer cover: 

❑  Use only a table top with a grounded conducting surface. 

❑  Wear a grounded, static-discharging wrist strap. 
 

PMT Cover Screws (4)

 

Figure 8-3 
PMT Cover 
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C a l i b r a t i n g  t h e  N e p h e l o m e t e r  
Calibrate the Nephelometer before an intensive experiment, 
calibrate periodically to verify no drift has occurred, calibrate if the 
reference chopper is dirty or scratched, or if you clean the chopper 
as part of periodic maintenance. 
 
Perform calibration using TSI software. The "Calibration" option 
under the Main Menu screen allows you to easily calibrate the 
Nephelometer using two span gases, comparing the results between 
air (low span) and CO2 (high span). 
 
Refer to the "Performing Calibration" section in Chapter 4. 
Hardware setup instructions are included as part of the calibration 
process. 
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C l e a n i n g  F a n  F i l t e r s  

The Nephelometer circuitry is cooled by a fan, which has two fan 
filters located on the outside of the Nephelometer (Figure 8-4). 
Running the fan with clogged filters can significantly reduce the life 
of the lamp.  

If power is applied to the Nephelometer and the lamp is working 
properly, but you cannot see light (at any angle) coming through 
the filters, the foam inserts are clogged and should be cleaned or 
replaced.  

Note: You can clean fan filters while power is applied to the 
Nephelometer. 

 

Fan Covers and
Foam Inserts

 

Figure 8-4 
Fan Covers and Foam Inserts 
 

Tools and Parts 
You need a vacuum or a compressed air source, and if you replace 
the foam inserts, TSI P/N 1602071. One set of foam inserts is 
included in the accessory kit. 

 
1. Snap off the fan covers and remove the open-cell foam inserts 

from the covers (Figure 8-4). 

2. To clean the foam inserts, use a vacuum to remove 
accumulated dirt or a compressed air source to blow away the 
dirt.  

Note: Cleaning solvents will dissolve the foam inserts. 

3. Replace the foam inserts in the fan covers and snap the fan 
covers back in place. 
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R e p l a c i n g  t h e  M a i n  M i c r o p r o c e s s o r  E P R O M  
The Nephelometer sensor contains a 68HC16Z1 main 
microprocessor that controls signal processing and input/output 
operations. The main microprocessor has separate battery-backed-
up RAM-storage and EPROM chip. 
 
Over time, TSI may update the firmware to enhance the 
performance of the Nephelometer. Updating the main 
microprocessor firmware requires replacing a separate EPROM chip 
on the digital PC board. 
 
Note: Replacing an electronic chip should only be performed by 

someone who is technically qualified and who is familiar with 
the operation of the Nephelometer. 

 

Tools and Parts 
You need a Phillips-head screwdriver, a replacement chip, a small 
flat screwdriver, a static-discharging wriststrap, and an antistatic 
mat. 
 

To replace the main microprocessor EPROM: 

1. Apply power to the Nephelometer and start the Nephelometer 
software (Chapter 4). 

2. Select "Configuration Menu" from the Main Menu. 

3. Select "Read Config. Data from Nephelometer" from the 
Configuration Menu screen.  

4. After data is read from the Nephelometer, select "Save Config. 
Data to Disk File" from the Configuration Menu screen. 

5. After data is saved, select "Print Config. Data" from the 
Configuration Menu screen to make a hard copy of the data 
record. 

6. Confirm that data was written and saved to the 
NEPHCNFG.DAT file and exit the software. 

7. Remove power from the Nephelometer and from any 
instruments connected to the Nephelometer. 
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  8. Loosen the four screws fastening the Nephelometer top cover 
and remove the cover (Figure 8-5). 

 
 

 

C a u t i o n  
To avoid damage to the electronic circuitry, use electrostatic discharge (ESD)      
precautions when removing the Nephelometer cover: 

❑  Use only a table top with a grounded conducting surface. 

❑  Wear a grounded, static-discharging wrist strap. 
 
 

Top Cover Screws (4) 

 
Figure 8-5 
Top Cover Screws  
 

  9. Locate the main microprocessor EPROM on the digital circuit 
board (Figure 8-6). Remove the main microprocessor EPROM 
by inserting the tip of a small flat screwdriver under the short 
side of the chip and gently twisting.  

10. Remove the new chip from the static protective wrapper. 

11. Align the new chip in the socket, making sure notch in the 
microprocessor EPROM matches the position in Figure 8-6. 
Apply pressure to the center of the chip until it snaps down 
into the socket. Press firmly to make sure it is seated properly 
and check to see that there are no bent or unseated pins. 
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12. Apply power to the Nephelometer and observe the LEDs: 
POWER lights when power is applied, VALVE lights as the 
valve turns, and STATUS lights when the Nephelometer is 
ready for operation. 

Note: If the LEDs do not function, remove power from the 
Nephelometer and make sure the chip is seated 
correctly. 

13. Remove power from the Nephelometer, and replace the top 
cover, attaching the cover with the four screws. 

14. Apply power to the Nephelometer and start the Nephelometer 
software. 

15. Select "Configuration Menu" from the Main Menu. 

16. Select "Read Config. Data from Disk File" from the 
Configuration Menu screen.  

17. After data is read from the Nephelometer, select "Write Config 
Data to Nephelometer" from the Configuration Menu screen. 

18. After data is written, press <Esc> to go to the Main Menu and 
choose "Data Collection" to verify that the Nephelometer is 
operating properly. 
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R e p l a c i n g  t h e  M o t o r  C o n t r o l  
M i c r o p r o c e s s o r  

The Nephelometer sensor contains an HC711D3 microprocessor 
that controls the motor functions of the calibrator and backscatter 
shutters. Over time, TSI may update the firmware to enhance the 
performance of the Nephelometer. Updating the firmware may 
require replacing the motor microprocessor chip on the digital PC 
board.  
 
Note: Replacing an electronic chip should only be performed by 

someone who is technically qualified and who is familiar with 
the operation of the Nephelometer. 

 
Tools and Parts 
You need a Phillips-head screwdriver, a replacement chip, a 44-pin 
chip extractor (provided with the replacement chip), a static-
discharging wriststrap, and an antistatic mat. 

 

To replace the microprocessor: 

1. Remove power from the Nephelometer and from any 
instruments connected to the Nephelometer. 

2. Loosen the four screws fastening the Nephelometer top cover 
and remove the cover (Figure 8-5). 

 
 

 

C a u t i o n  
To avoid damage to the electronic circuitry, use electrostatic discharge (ESD)        
precautions when removing the Nephelometer cover: 

❑  Use only a table top with a grounded conducting surface. 

❑  Wear a grounded, static-discharging wrist strap. 
 
 

3. Locate the motor microprocessor chip on the digital circuit 
board (Figure 8-6). Use the 44-pin chip extractor to remove the 
chip. 

 
4. Remove the new chip from the static protective wrapper. 
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5. Align the new chip in the socket, making sure the clipped 
corner of the motor microprocessor matches the position in 
Figure 8-6. Apply pressure to the center of the chip until it 
snaps down into the socket. Press firmly to make sure it is 
seated properly and check to see that there are no bent or 
unseated pins. 

 

Main Microprocessor EPROM

Motor Microprocessor

 
Figure 8-6 
Microprocessor and EPROM Locations on the Digital Circuit Board 
 

6. Apply power to the Nephelometer and observe the LEDs: 
POWER lights when power is applied, VALVE lights as the valve 
turns, and STATUS lights when the Nephelometer is ready for 
operation. 

Note: If the LEDs do not function, remove power from the 
Nephelometer and make sure the chip is seated correctly. 

7. Remove power from the Nephelometer, and replace the top 
cover, securing the cover with the four screws. 
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R e p l a c i n g  t h e  L a m p  

The lamp is a projector-type halogen bulb with a built-in elliptical 
dichroic mirror. The lamp is rated at 75 watts with a recommended 
maximum of 12 volts. The lamp has an estimated life of 2000 hours 
of continuous operation at the maximum power (75 watts). 

Tools and Parts 
You need a Phillips-head screwdriver and a replacement lamp 
(P/N 2201111). A replacement lamp is included in the accessory 
kit. 

1. Remove power from the Nephelometer and from any 
instruments connected to the Nephelometer. 

2. Loosen the four screws fastening the Nephelometer top cover 
and remove the cover (Figure 8-7). 

 

Top Cover Screws (4) 

 

Figure 8-7 
Top Cover Screws 
 

3. Unscrew the two screws attaching the lamp shield. Remove the 
shield, supporting the shield so that it does not hang by the 
sensor wires (Figure 8-8). 

 

!
 

C a u t i o n  
Lamp and shield at high temperatures, which can cause burns.  

 To avoid personal injury, disconnect power to the Nephelometer and allow the 
halogen lamp and the lamp shield to cool before handling.  
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Lamp Shield Screws (2)

 

Figure 8-8 
Lamp Shield 
 

4. Allow the lamp to cool and push up the lamp lever to force the 
lamp from the socket. 

5. Plug in a new lamp and push down the lamp lever to secure the 
lamp. 

6. Replace the lamp shield and attach the shield with the two 
screws. 

7. Replace the Nephelometer top cover and attach with the four 
screws. 

8. After applying power to the Nephelometer, check the operation 
of the lamp either by observing the light inside the sensor or by 
selecting “Data Collection” from the Main Menu of the TSI 
software. 
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R e p l a c i n g  A e r o s o l  F i l t e r s  

The Nephelometer has two aerosol filters: 

❑  A large white HEPA filter that can be switched into the inlet to 
filter all sample air coming into the sensor. 

❑  A small blue DQ filter that is used to purge a small flow of clean 
air into the light pipe apertures. This airflow keeps the lens 
clean.  

There is no software indication or error message if either filter is not 
functioning. However, if there is a significant increase in pressure 
drop through the filter from the time you set up Nephelometer to 
the present, check the white HEPA filter and fittings to see if the 
inlet flow is blocked. 

Replace the white HEPA filter every six months of operation and 
replace the blue DQ filter every 12 months. If the Nephelometer is 
sampling very dirty aerosols, shorten these times. If the 
Nephelometer is sampling very clean aerosols, extend the times. 

 
Tools and Parts 
You need a Phillips-head screwdriver, adjustable wrench, small 
needle-nose pliers, RTV silicone sealer, and replacement filters, 
white HEPA: TSI P/N 1602051, and blue DQ: TSI P/N 1602080. 
Replacement filters are included in the accessory kit. 

 

To replace the white HEPA filter or the blue DQ filter: 

1. Remove power from the Nephelometer and from any instruments 
connected to the Nephelometer. 

2. Loosen the four screws fastening the top cover of the 
Nephelometer and remove the cover (Figure 8-9). 
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Top Cover Screws (4) 

 

Figure 8-9 
Top Cover Screws 

 

3. To replace the white HEPA filter:  

a. Loosen the end plate by removing the two bottom cover 
screws (Figure 8-10). 

b. Unscrew the three screws fastening the end plate and 
remove the end plate.  

 

Bottom Cover Screws (2)
 

Figure 8-10 
Bottom Cover Screws Securing End Plate 
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c. Use an adjustable wrench to remove the nylon nut 
connecting the elbow fitting to the filter outlet (Figure 8-11). 

d. Pull back on the elbow to separate the elbow fitting from the 
filter. 

e. Unscrew the filter from the brass fitting on the inlet block 
(Figure 8-11). 

f. Coat the threads on the brass fitting on the inlet block with 
RTV silicone sealer. 

g. Making sure the arrow on the new filter is pointing away 
from the inlet block, screw the new filter into the brass 
fitting on the inlet block (Figure 8-11). 

h. Remove the nylon fitting from the old filter, coat the threads 
of the fitting with RTV silicone sealer, and screw the nylon 
fitting into the outlet of the new filter. 

i. Use the nylon nut to attach the elbow fitting to the outlet of 
the filter. 

j. Reattach the end plate using the three screws. 

k. Replace the two bottom cover screws. 
 

Brass Fitting

Elbow Fitting

 

Figure 8-11 
White HEPA Filter 
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4. To replace the blue DQ filter: 

a. Remove the 1⁄8 in. ID silicone tubing from both ends of the 
blue filter (Figure 8-12). 

b. Making sure the arrow of the new filter is pointing away 
from the inlet block, install the new DQ filter, reattaching 
the silicone tubing. 

 

Inlet Block

Silicone Tubing

 
Figure 8-12 
Blue DQ Filter 
 

5. Replace the top cover of the Nephelometer and attach with the 
four screws. 
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C l e a n i n g  t h e  L i g h t  P i p e  L e n s  

The light pipe is a solid glass rod that transfers light from the lamp 
to the measurement volume, providing a thermal break between the 
lamp and the measurement volume. The light pipe lens, which 
receives a high volume of cooling air, may require frequent 
cleaning.  

 

Tools 
You need a Phillips-head screwdriver, soft cloth, cotton swabs, 
isopropyl alcohol, and O-ring grease. 

 

1. Remove power from the Nephelometer and from any instruments 
connected to the Nephelometer. 

2. Loosen the four screws fastening the top cover of the 
Nephelometer and remove the cover (Figure 8-13). 

 

Top Cover Screws (4) 

 

Figure 8-13 
Top Cover Screws  
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3. Unscrew the two screws attaching the lamp shield (Figure 8-14). 
Remove the shield, supporting the shield so that it does not 
hang by the sensor wires.  

 

Lamp Shield Screws (2)

 

Figure 8-14 
Lamp Shield 

 

4. Allow the lamp to cool and push up the lamp lever to force the 
lamp from the socket.  

 
 

!
 

C a u t i o n  
Lamp and shield at high temperatures, which can cause burns.  

 To avoid personal injury, disconnect power to the Nephelometer and allow the 
halogen lamp and the lamp housing to cool before handling.  

 



 

Performing Maintenance 8-21 

5. Locate the light pipe lens below the lamp socket. Use the cotton 
swab and alcohol to clean the lens (Figure 8-15). 

 

Light Pipe Lens

 

Figure 8-15 
Light Pipe Lens 

 

6. Plug in the lamp and push down the lamp lever to secure the 
lamp. 

7. Replace the lamp shield securing it with the two screws. 

8. Replace the top cover of the Nephelometer and attach with the 
four screws. 

9. After applying power to the Nephelometer, check the operation 
of the lamp either by observing the light inside the sensor or by 
typing the RF command on the computer and checking the 
status flags (see “Read Commands” in Chapter 6). 
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C h e c k i n g  f o r  L e a k s  
This section describes procedures for checking the vacuum 
integrity of the Nephelometer. 
 

Tools needed 
A vacuum pump (capable of 18 in. Hg vacuum), manometer or 
vacuum gauge, leak check solution (bubble solution) pump capable 
of 5 psi pressure, 1” NPT plugs. 

 
To check if the instrument has a leak: 

1. Remove the blower from the instrument and plug the lower 
connection port. 

2. Connect a vacuum pump and vacuum gauge to the inlet. 

3. Draw the pressure down to about 18 in. Hg below atmospheric 
pressure. 

4. Wait for about ten minutes for any pressure/temperature 
changes with the instrument. 

5. Record the reading on the vacuum gauge. 

6. Wait five minutes and record again. 

7. If the gauge has dropped by more than 0.2 in. Hg in five 
minutes, there is probably a leak. 
 

To check for leaks: 

1. Make sure that the vacuum system itself does not leak. 

2. Remove the top and bottom covers from the instrument. 

3. Connect the pump in place of the vacuum pump and pressurize 
the instrument to no more than 5 psi. 

4. Drip bubble solution over all silicone sealed joints or O-ring 
joints until the leak is found. 

5. Repair/replace seals or O-ring as needed. 

6. Retest with vacuum as described above. 

7. Reassemble covers. 
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C l e a n i n g  t h e  R e f e r e n c e  C h o p p e r  
The reference chopper contains three areas: one area provides a 
signal from light scattered by an aerosol, one area provides an 
indication of the lamp power, and one area provides a measure of 
the PMT dark current.  
 
Make sure the chopper is operating properly and clean the calibrate 
portion of the chopper if, over time, the calibrate signal from the 
Nephelometer rises (from light scattered by dirt) or falls (from light 
blocked by dirt) significantly using the same lamp power. 
 
Note: Recalibrate the Nephelometer after you clean the reference 

chopper. Refer to Chapter 4, "Using Nephelometer Software 
(DOS)," for the calibration procedure using TSI software 
commands. 

 
 

Tools and Parts 
You need a Phillips-head screwdriver, isopropyl alcohol, and cotton 
swabs. 

 
 

1. Remove power from the Nephelometer and from any instruments 
connected to the Nephelometer. 

2. Loosen the four screws fastening the top cover of the 
Nephelometer and remove the cover (Figure 8-16). 
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Top Cover Screws (4) 

Bottom Cover Screws (4) 

Fan Panel Screws (2) I/O Panel Screws (3) 

 

Figure 8-16 
Top Cover Screws, Bottom Cover Screws, Fan Cover Screws, and I/O Panel 
Screws 

 
3. The bottom cover of the Nephelometer is pliable and fits very 

tightly around the bottom of the instrument. Remove the bottom 
cover in one of two ways: 

❑  The more difficult method is to pry off the bottom cover 
without removing the I/O panel and the fan panel. Unscrew 
the four bottom cover screws (Figure 8-16). Carefully remove 
the bottom cover, working alternately at both ends. Pry the 
edges of the cover apart, and ease the cover away from the 
body of the Nephelometer. 

❑  The easier method takes more time. After removing the I/O 
panel, the fan panel and the end plate, slide the bottom 
cover off the body of the instrument. Using Figure 8-16 as a 
reference: 

a. Unscrew the three screws securing the I/O panel to the 
backbone, loosen the panel, and let the panel hang over 
the side of the instrument. 

b. Unscrew the two screws securing the fan panel to the 
backbone, loosen the panel, and let the panel hang over 
the side of the instrument.  
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c. Unscrew the three screws securing the end plate to the 
inlet section of the instrument and remove the end plate. 

d. Unscrew the four bottom cover screws, and carefully 
slide the cover off the end of the instrument. 

  4. If the Nephelometer is resting on its feet, support the 
underside of the instrument. 

  5. Loosen the two screws attached to the analog and digital 
circuit boards (Figure 8-17). 

 

Circuit Board Mounting Screws (2)

 

Figure 8-17 
Circuit Board Mounting Screws 
 

  6. Disconnect the J25 connector attaching a wide ribbon cable 
from the PMT box to the digital circuit board. 

  7. Remove the three screws attaching the PMT end plate to the 
outlet section of the Nephelometer (Figure 8-17a). 

 



8-26 Model 3550/3560 Series Integrating Nephelometer 

End Plate Screws (3)
 

Figure 8-17a 
PMT End Plate Screws 

 

  8. Using one hand to hold the PMT box, use the other hand to 
slide the aperture assembly from the outlet section of the 
Nephelometer.  

Note: Be careful not to let the inner tube drag inside the outer 
tube and scrape the paint. 

  9. Set the aperture assembly on a flat surface, PMT end down 
(Figure 8-18). 
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Aperture Plate
Nuts and Washers (2)

 

Figure 8-18 
Aperture Assembly 
 

10. Using an adjustable wrench, remove the two nuts and washers 
attaching the plate to the aperture assembly (Figure 8-18). 

11. The aperture plate fits snugly. As you remove the plate, 
disconnect the motor connector (J13) from the circuit board. 

12. To access the reference chopper: 

a. Set the plate assembly, circuit board side up, on a flat 
surface (Figure 8-19).  

b. Remove the three screws and washers attaching the circuit 
board and plate 1 to plate 2 (Figure 8-19). 

c. Separate plate 1 and circuit board from plate 2 and turn  
plate 1 so that the shutter is facing you (Figure 8-20). 
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Plate 1
Circuit Board and

Plate 2

Screws (3)

 

Figure 8-19 
Aperture Plates and Circuit Board 

 

 

Reference
Chopper

Plate 2

Plate 1

 

Figure 8-20 
Reference Chopper 
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13. Use a cotton swab and alcohol to clean only the frosted or 
reflective aluminum surfaces of the reference chopper. 

Note: Although TSI recommends isopropyl alcohol to clean the 
chopper, alcohol will remove black paint from 
components. 

14. Optional 

 If you need better access to the frosted surface of the reference 
chopper, loosen the screw in the counterweight and remove the 
chopper from plate 1. 

Note: If you remove the reference chopper from plate 1, 
reattach the chopper by placing two sheets of paper as a 
spacer between the chopper and plate 1 so the hub of 
the chopper is very close to plate 1 without touching. 
Then tighten the setscrew and remove the paper. Make 
sure the chopper turns freely. 

15. Use the three screws and washers to reattach the circuit board 
and plate 1 to plate 2. Using a cotton swab, turn the chopper 
by the hub or plate to make sure that the chopper does not 
come in contact with any plate surface.  

16. Reconnect the motor connector (J13) to the circuit board and 
seat the plate assembly in the aperture assembly. 

Note: Make sure the motor connector cable does not block an 
aperture inside the aperture assembly. 

17. Reattach the two nuts and washers securing the aperture plate 
to the aperture assembly. 

18. Reinsert the aperture assembly into the outlet end of the 
Nephelometer being careful not to bend the flocked paper 
insert in the middle of the Nephelometer sensor. 

19. Reattach the PMT end plate with the three screws. 

20. Reattach the analog and digital circuit boards to the end plate 
using the two screws (Figure 8-17). 

21. Attach the bottom cover of the Nephelometer reversing the 
steps in step 3 of this procedure. Remember that the cover is 
pliable and fits tightly around the bottom of the instrument. 
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22. Replace the top cover of the Nephelometer and attach with the 
four screws. 

23. Recalibrate the Nephelometer after you clean the reference 
chopper. Refer to Chapter 4, "Using Nephelometer Software 
(DOS)," for the calibration procedure using TSI software 
commands. 
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C l e a n i n g  t h e  L i g h t  P i p e  O u t l e t  a n d  t h e  
B a c k s c a t t e r  S h u t t e r  

The light pipe is a solid glass rod that transfers light from the lamp 
to the measurement volume, providing a thermal break between the 
lamp and the measurement volume. The backscatter shutter, easily 
accessed while you are cleaning the outlet to the light pipe, collects 
dust when it is spinning in backscatter mode. 

 

Tools 
You need a Phillips-head screwdriver, soft cloth, cotton swabs, 
isopropyl alcohol, and O-ring grease. 

 

1. If you are going to clean the outlet of the light pipe and the 
backscatter shutter, park the shutter in "Sleep" mode using the 
PD software command (refer to the "Action Commands" in 
Chapter 6).  

Note: The PD command positions the backscatter shutter so 
that you can remove the lamp base assembly from the 
Nephelometer without damaging the shutter. 

2. Remove power from the Nephelometer and from any instruments 
connected to the Nephelometer. 

3. Loosen the four screws fastening the top cover of the 
Nephelometer and remove the cover (Figure 8-21). 
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Top Cover Screws (4) 

Bottom Cover Screws (4) 

Fan Panel Screws (2) I/O Panel Screws (3) 

 

Figure 8-21 
Top Cover Screws, Bottom Cover Screws, Fan Cover Screws, and I/O Panel 
Screws 
 
4. Unscrew the two screws attaching the lamp shield (Figure 8-22). 

Remove the shield, supporting the shield so that is does not 
hang by the sensor wires.  

 

Lamp Shield Screws (2)

 

Figure 8-22 
Lamp Shield 
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5. The bottom cover of the Nephelometer is pliable and fits very 
tightly around the bottom of the instrument. Remove the bottom 
cover in one of two ways: 

❑  The more difficult method is to pry off the bottom cover 
without removing the I/O panel and the fan panel. Unscrew 
the four bottom cover screws (Figure 8-21). Carefully remove 
the bottom cover, working alternately at both ends. Pry the 
edges of the cover apart, and ease the cover away from the 
body of the Nephelometer. 

❑  The easier method takes more time. After removing the I/O 
panel, the fan panel and the end plate, slide the bottom 
cover off the body of the instrument. Using Figure 8-21 as a 
reference: 

a. Unscrew the three screws securing the I/O panel to the 
backbone, loosen the panel, and let the panel hang over 
the side of the instrument. 

b. Unscrew the two screws securing the fan panel to the 
backbone, loosen the panel, and let the panel hang over 
the side of the instrument.  

c. Unscrew the three screws securing the end plate to the 
inlet section of the instrument and remove the end plate. 

d. Unscrew the four bottom cover screws, and carefully 
slide the cover off the end of the instrument. 
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6. Using Figure 8-23 as a reference:  

a. Remove the connector for the lamp on the analog board.  

b. Remove the ribbon cable connector from the inlet block. 

c. Remove the motor controller ribbon cable connector from 
the lamp block. 

d. Disconnect these sensor connectors (as marked): 1 (lamp 
temperature), 2 (valve position), 3 (valve motor), 4 (heater), 
and 6 (fan). 

e. Disconnect the blue DQ filter silicone tubing at the elbow 
connector on the backbone and at the elbow connector on 
the inlet. 

 

 

Figure 8-23 
Disconnect Connectors and Tubing 

 

7. To separate the Nephelometer inlet section from the outlet 
section, loosen the three screws attaching the two sections to 
each other (Figure 8-24) and carefully pull the sections apart 
(Figure 8-25). The flocked paper insert will be visible. 
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Section Screws (3)

 

Figure 8-24 
Nephelometer Sections Together 
 

Flocked Paper

 

Figure 8-25 
Nephelometer Sections Apart 
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8. To clean the light pipe outlet: 

a. Unscrew the four screws, one on each corner, on the 
aluminum lamp base. Two of the screws are recessed 
(Figure 8-26).  

b. Check to make sure the backscatter shutter is located 
underneath the light pipe. If not, rotate the shutter with 
your fingers. 

 

Lamp Base Screws (4)

Ribbon Cable Connector
 

Figure 8-26 
Lamp Base  
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c. Using one hand to support the backscatter shutter from 
below, use the other hand to carefully remove the lamp base 
assembly, angling the assembly as you pull it out of the 
sensor body (Figure 8-27). 

Note: Be careful not to catch the shadow lightstop plate on 
the backbone. 

 

Backbone

 

Figure 8-27 
Removing the Lamp Base Assembly From the Sensor  
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d. Locate the light pipe outlet on the underside of the lamp 
base assembly (Figure 8-28). Use a cotton swab and alcohol 
to clean the outlet, making sure the swab does not touch 
black components. 

Note: Although TSI recommends isopropyl alcohol to clean 
the outlet, alcohol removes black paint from 
components. 

e. Use a soft dry cloth to clean the backscatter shutter. If 
necessary, use a soft cloth and a mild detergent solution 
followed by a soft dry cloth.  

 

Backscatter Shutter

Light Pipe Outlet

Shadow Lightstop Plate

 

Figure 8-28 
Light Pipe Outlet and Backscatter Shutter 
 

f. Grease the O-ring on the backbone of the sensor (Figure 8-
29) and replace the O-ring. 

g. Rotate the backscatter shutter so it is positioned under the 
light pipe and gently reinsert the lamp base assembly, at an 
angle, into the sensor. 

h. Tighten the four screws, one at each corner of the aluminum 
lamp base. 
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O-ring

Sensor Backbone

 

Figure 8-29 
O-ring on the Sensor Backbone  

 

  9. Put a light coating of grease on the O-ring between the 
Nephelometer inlet and outlet sections and replace the O-ring 
in the groove (Figure 8-25). 

10. Use the three screws to attach the Nephelometer outlet to the 
inlet. 
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11. Using Figure 8-23 as a reference:  

a. Attach the connector for the lamp to the analog board.  

b. Attach the ribbon cable connector to the inlet block. 

c. Attach the motor controller ribbon cable connector to the 
lamp block. 

d. Connect these sensor connectors (as marked): 1 (lamp 
temperature), 2 (valve position), 3 (valve motor), 4 (heater), 
and 6 (fan). 

e. Connect the blue DQ filter silicone tubing at the elbow 
connector on the backbone and at the elbow connector on 
the inlet. 

12. Attach the bottom cover of the Nephelometer reversing the 
steps in step 5 of this procedure. Remember that the cover is 
pliable and fits tightly around the bottom of the instrument. 

13. Replace the top cover of the Nephelometer and attach with the 
four screws. 

 
 
 



 

Performing Maintenance 8-41 

C l e a n i n g  t h e  F l o c k e d  P a p e r  
Black flocked paper inside the main tube has a direct effect on the 
amount of wallscatter light. If the paper collects dust, more light is 
scattered, affecting counts from the wall. 
 

Tools and Parts 
You need a Phillips-head screwdriver, a vacuum or a compressed 
air source, and O-ring grease. 

 

1. Remove power from the Nephelometer and from any instruments 
connected to the Nephelometer. 

2. Loosen the four screws fastening the top cover of the 
Nephelometer and remove the cover (Figure 8-30). 

 

Top Cover Screws (4) 

Bottom Cover Screws (4) 

Fan Panel Screws (2) I/O Panel Screws (3) 

 

Figure 8-30 
Top Cover Screws, Bottom Cover Screws, Fan Cover Screws, and I/O Panel 
Screws  
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3. The bottom cover of the Nephelometer is pliable and fits very 
tightly around the bottom of the instrument. Remove the bottom 
cover in one of two ways: 

❑  The more difficult method is to pry off the bottom cover 
without removing the I/O panel and the fan panel. Unscrew 
the four bottom cover screws (Figure 8-30). Carefully remove 
the bottom cover, working alternately at both ends. Pry the 
edges of the cover apart, and ease the cover away from the 
body of the Nephelometer. 

❑  The easier method takes more time. After removing the I/O 
panel, the fan panel and the end plate, slide the bottom 
cover off the body of the instrument. Using Figure 8-30 as a 
reference: 

a. Unscrew the three screws securing the I/O panel to the 
backbone, loosen the panel, and let the panel hang over 
the side of the instrument. 

b. Unscrew the two screws securing the fan panel to the 
backbone, loosen the panel, and let the panel hang over 
the side of the instrument.  

c. Unscrew the three screws securing the end plate to the 
inlet section of the instrument and remove the end plate. 

d. Unscrew the four bottom cover screws, and carefully 
slide the cover off the end of the instrument. 

4. If the Nephelometer is resting on its feet, support the underside 
of the instrument. 

5. Using Figure 8-31 as a reference:  

a. Remove the connector for the lamp on the analog board.  

b. Remove the ribbon cable connector from the inlet block. 

c. Remove the motor controller ribbon cable connector from 
the lamp block. 

d. Disconnect these sensor connectors (as marked): 1 (lamp 
temperature), 2 (valve position), 3 (valve motor), 4 (heater), 
and 6 (fan). 

e. Disconnect the blue DQ filter silicone tubing at the elbow 
connector on the backbone and at the elbow connector on 
the inlet. 
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Figure 8-31 
Disconnect Connectors and Tubing 

 

6. To separate the Nephelometer inlet section from the outlet 
section, loosen the three screws attaching the two sections to 
each other (Figure 8-32) and carefully pull the sections apart 
(Figure 8-33). The flocked paper will be visible. 
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Section Screws (3)

 

Figure 8-32 
Nephelometer Sections Together 
 
 

Flocked Paper

O-ring
 

Figure 8-33 
Nephelometer Sections Apart 
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7. Pull the flocked paper from the outlet section (Figure 8-34). 
 

 

Figure 8-34 
Flocked Paper Outside the Nephelometer 

 

  8. To clean the flocked paper, use a vacuum to take up or a 
compressed air source to blow away the dirt. 

Note: If the paper has bald patches, it should be replaced. 
Contact TSI for assistance. 

  9. Put a light coating of grease on the O-ring between the 
Nephelometer inlet and outlet sections and replace the O-ring 
in the groove (Figure 8-33). 

10. Carefully reinstall the flocked paper, fitting the paper around 
the PMT aperture plate in the outlet section of the 
Nephelometer. 

11. Use the three screws to attach the Nephelometer outlet section 
to the inlet section. 

12. Using Figure 8-31 as a reference:  

a. Attach the connector for the lamp to the analog board.  

b. Attach the ribbon cable connector to the inlet block. 

c. Attach the motor controller ribbon cable connector to the 
lamp block. 
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d. Connect these sensor connectors (as marked): 1 (lamp 
temperature), 2 (valve position), 3 (valve motor), 4 (heater), 
and 6 (fan). 

e. Connect the blue DQ filter silicone tubing at the elbow 
connector on the backbone and at the elbow connector on 
the inlet. 

13. Attach the bottom cover of the Nephelometer reversing the  
steps in step 3 of this procedure. Remember that the cover is 
pliable and fits tightly around the bottom of the instrument. 

14. Replace the top cover of the Nephelometer and attach with the 
four screws. 
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R e p l a c i n g  a  T e m p e r a t u r e  o r  H u m i d i t y  
S e n s o r  

The Nephelometer has two built-in temperature sensors and a 
humidity sensor. The sensors are mounted on PC boards to make 
service easy. Although the sensors are rugged, they may have to be 
replaced sometime during the life of the instrument. The first 
temperature sensor is located at the inlet of the instrument. The 
second temperature sensor and the humidity sensor are located 
near the outlet, on the same PC board. 
 

Tools and Parts 
You need a Phillips-head screwdriver, a replacement sensor 
mounted on its PC board, and O-ring grease. 

 
1. Remove power from the Nephelometer and from any instruments 

connected to the Nephelometer. 

2. Loosen the four screws fastening the top cover of the 
Nephelometer and remove the cover (Figure 8-35). 

 

Top Cover Screws (4) 

Bottom Cover Screws (4) 

Fan Panel Screws (2) I/O Panel Screws (3) 

 

Figure 8-35 
Top Cover Screws, Bottom Cover Screws, Fan Cover Screws, and I/O Panel 
Screws  
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3. Disconnect the ribbon cable from the appropriate sensor (Figure 
8-36). 

4. Remove the four screws from the appropriate PC board and 
remove the sensor assembly. 

 

Temperature/Humidity Sensor

Temperature Sensor

 

Figure 8-36 
Humidity and Temperature Sensor Locations 
 

5. Lightly grease the sealing O-ring if necessary. 

6. Replace the sensor assembly with the replacement sensor. 

7. Replace the four screws. 

8. Replace the cover and run the Nephelometer software to verify 
that the sensor is operating correctly. 

9. Calibrate the sensor, if needed (refer to SC command in 
Chapter 6). 
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R e p l a c i n g  a  P h o t o m u l t i p l i e r  T u b e  

As a photomultiplier tube (PMT) ages, it becomes less sensitive. You 
may find that you can compensate for the gain by increasing the 
voltage. At this time, there is no data on life expectancy of a PMT or 
how the tube may be affected by different environments. If there is 
a substantial increase in dark current (see the RP command under 
"Read Commands" in Chapter 6), replace the PMT. 

Notes: Replacing a PMT should only be attempted by someone who 
is technically qualified and who is familiar with the 
operation of the Nephelometer. 

 

Tools and Parts 
You need a Phillips-head screwdriver and a replacement PMT: 

 • Blue PMT R1527P TSI P/N 3009004 

 • Green PMT R1527P  TSI P/N 3009004 

 • Red PMT R2949  TSI P/N 3009005 
 
 

 

W A R N I N G  
High voltages that can shock or burn. 

 The box that houses the photomultiplier tubes (PMT) contains a high voltage 
source. Components within this box should only be serviced by a qualified 
technician. Disconnect all power to the Nephelometer and contact TSI 
personnel before disassembling the PMT box. 

 
 

!
 

C a u t i o n  
Light sensitive components.  

 To avoid damage to the photomultiplier tubes (PMT), remove power from the 
Nephelometer and open the PMT box in subdued lighting. Exposing the 
photomultiplier tubes to direct light may affect tube performance.  

 
1. Remove power from the Nephelometer and from any instruments 

connected to the Nephelometer. 
 
2. Unscrew the four screws attaching the PMT cover to the sensor 

and remove the cover (Figure 8-37)  
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PMT Cover Screws (4)

 

Figure 8-37 
PMT Cover 
 

3. Each PMT fits inside a magnetic shield (Figure 8-38). To remove 
the shield and PMT, support the sensor frame with one hand 
and use your other hand to gently rock the shield from side to 
side as you pull it from its socket. 

5. To remove the PMT from the shield, loosen the three setscrews 
at the base of the shield (Figure 8-38) and withdraw the tube. 

6. Carefully insert a new PMT into the shield. Position the tube so 
that the light-sensing portion (criss-crossed wires) of the tube 
faces the slotted opening on the shield. Gently tighten the three 
setscrews so that the end of the tube is 1⁄8 in. from the end of 
the shield. 

Notes: If the tube is not inserted far enough, the setscrews will 
touch glass and may shatter the tube when they are 
tightened.  

 Tighten the setscrews only enough to support the tube. If 
you overtighten the screws you may crack the plastic 
base. 
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Set Screws (3 each)

Green

Red

Blue

 

Figure 8-38 
Red, Blue and Green PMTs with Setscrews 
 

7. Plug the tube into the socket, noting the alignment of the center 
pin of the tube into its mating socket. 

8. Replace the PMT cover and attach with the four screws. 
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C h e c k i n g ,  C l e a n i n g ,  a n d  R e p l a c i n g  
B a n d p a s s  F i l t e r s  

Three bandpass filters are centered at 450 nm (blue), 550 nm 
(green), and 700 nm (red) wavelengths. Although located within a 
protective can, the filters may need periodic cleaning if they 
accumulate dust or dirt. In addition, exposure to high humidity can 
attack the coatings on the filters causing them to cloud.  
 

Tools and Parts 
You need a Phillips-head screwdriver, an S-shaped Phillips-head 
screw driver, and a bandpass filter: 

 • Blue filter P/N 2502486 

 • Green filter P/N 2502485 

 • Red filter P/N 2502487 
 
 

 

W A R N I N G  
High voltages that can shock or burn. 

 The box that houses the photomultiplier tubes (PMT) contains a high voltage 
source. Components within this box should only be serviced by a qualified 
technician. Disconnect all power to the Nephelometer and contact TSI 
personnel before disassembling the PMT box. 

 

!
 

C a u t i o n  
Light sensitive components.  

 To avoid damage to the photomultiplier tubes (PMT), remove power from the 
Nephelometer and open the PMT box in subdued lighting. Exposing the 
photomultiplier tubes to direct light may affect tube performance.  

 

1. Remove power from the Nephelometer and from any instruments 
connected to the Nephelometer. 

2. Remove the PMT cover by unscrewing the four screws attaching 
the cover to the sensor (Figure 8-39).  
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PMT Cover Screws (4)

 

Figure 8-39 
PMT Cover 
 

3. To check the bandpass filters, you must remove the PMTs with 
their magnetic shields (Figure 8-40). To remove a shield and 
tube, support the sensor frame with one hand and use your 
other hand to gently rock the shield from side to side as you pull 
it from its socket. 

4. Visually inspect the filter but avoid touching the filter with your 
fingers. 

❑  If there is dust, use a lens cloth to remove the dust. If the 
filter looks clean and transparent, it does not need to be 
replaced. Go to step 7 of this procedure.  

❑  If the filter is cloudy, remove the filter for a closer 
inspection. Go to step 5 of this procedure. 

 



8-54 Model 3550/3560 Series Integrating Nephelometer 

Set Screws (3 each)

Green

Red

Blue

 

Figure 8-40 
Red, Blue and Green PMTs with Setscrews 
 

5. Use the S-shaped Phillips-head screwdriver to unscrew the two 
screws holding the filter in place, and remove the filter 
(Figure 8-41).  

6. Hold the filter up to the light. If the filter is not transparent, or if 
there is clouding around the edges, replace the filter. Attach the 
new filter in the holder using the two screws and washers. 

7. Plug the tube into the socket, noting the alignment of the center 
pin of the tube into its mating socket. 

8. Replace the PMT cover and attach with the four screws. 
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Figure 8-41 
Bandpass Filter 
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C l e a n i n g  t h e  L e n s  
The lens collimates light from apertures that define the viewing 
volume in the body of the instrument. The light is collimated before 
it is split into separate colors to ensure that each photomultiplier 
tube sees the same area of light scatter from the viewing volume. 
 
Note: Under normal circumstances, you do not have to periodically 

check or clean the lens. Check the lens if there is an overall 
reduction in the signal in all three wavelengths over time. 

 
Tools and Parts 
You need a Phillips-head screwdriver, flashlight, lens cloth, and 
cotton swabs. 
 
 

 

W A R N I N G  
High voltages that can shock or burn. 

 The box that houses the photomultiplier tubes (PMT) contains a high voltage 
source. Components within this box should only be serviced by a qualified 
technician. Disconnect all power to the Nephelometer and contact TSI 
personnel before disassembling the PMT box. 

 
 

!
 

C a u t i o n  
Light sensitive components.  

 To avoid damage to the photomultiplier tubes (PMT), remove power from the 
Nephelometer and open the PMT box in subdued lighting. Exposing the 
photomultiplier tubes to direct light may affect tube performance.  

 

1. Remove power from the Nephelometer and from any instruments 
connected to the Nephelometer. 

2. Remove the PMT cover by unscrewing the four screws attaching 
the cover to the sensor (Figure 8-42). 
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PMT Cover Screws (4)

 

Figure 8-42 
PMT Cover 
 

3. To access the lens, you must remove the red PMT tube with its 
magnetic shield (Figure 8-43). To remove the tube, support the 
sensor frame with one hand and use your other hand to gently 
rock the shield from side to side as you pull the shield and tube 
from its socket. 

Note: If you need further access to the lens, you can remove the 
screw attaching the lens holder. 

4. Use a flashlight to inspect the lens for signs of dust. 

5. If the lens is dusty, carefully clean the lens with a cotton swab 
you have covered with lens paper. 

Note: Although TSI normally recommends isopropyl alcohol to 
clean lenses, alcohol or acetone removes black paint from 
components. 

6. Replace the tube into its socket, noting the alignment of the 
center pin of the tube with its mating socket. 

7. Replace the PMT cover and attach with the four screws. 
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Set Screws (3 each)

Green

Red

Blue

 

Figure 8-43 
Red, Blue and Green PMTs with Setscrews 
 
 
 



C H A P T E R  9  

Contact ing  Customer  
Serv ice  

9-1 

This chapter gives directions for contacting people at TSI 
Incorporated for technical information and directions for returning 
the Model 3550/3560 Series Integrating Nephelometer for service. 
 
 
 

T e c h n i c a l  C o n t a c t s  a t  T S I  

❑  If you have any difficulty installing the Nephelometer, or if you 
have technical or application questions about this instrument, 
contact an applications engineer at TSI Incorporated, 1-800-678-
2708 or (651) 490-2833.  

❑  If the Nephelometer fails, or if you are returning it for service, 
contact TSI Particle Instrument Division, Customer Service, at 1-
800-874-3893 (USA) or (651)-490-3893.  

 
 
 

R e t u r n i n g  t h e  N e p h e l o m e t e r  f o r  S e r v i c e  
Call Customer Service for specific return instructions. Customer 
Service will need this information when you call: 

❑ The instrument model number 

❑ The instrument serial number 

❑ A purchase order number (unless under warranty) 

❑ A billing address 

❑ A shipping address. 
 
Use the original packing material to return the instrument to TSI. If 
you no longer have the original packing material, seal off the inlet 
and fan on the sensor to prevent debris from entering the 
instrument and ensure that the indicator lights and the connectors 
on the instrument back panel are protected. 
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A P P E N D I X  A  

Speci f icat ions  

A-1 

Table A-1 lists the specifications for the Nephelometer sensor and 
Table A-2 lists the power supply. These specifications are subject to 
change. 
 
Table A-1 
Specifications for the Nephelometer Sensor 

Wavelengths 
Models 3551....................................  550 nm (green) 
Models 3563....................................  450 nm (blue), 550 nm (green), 

and 700 nm (red/infrared) 

Bandwidth ........................................  50 nm (all wavelengths) 

Sensitivity at 30-sec averaging time  
(aerosol scattering coefficient, σsp) 

Blue and green wavelengths ............  1.0 × 10-7 m-1 

Red/Infrared wavelength .................  3.0 × 10-7 m-1 

Averaging time..................................  1 to 4096 sec (selectable) 

Drift...................................................  <2.0 × 10-7 m-1 at 30-sec 
averaging time for up to one hour 
after filtered-air reference 
measurement for green 
wavelength 

Optical background signal 
Blue and green wavelengths ............  <5.0 × 10-5 m-1 

Red/Infrared wavelength .................  <1.0 × 10-5 m-1 

Angular integration ..........................  7 to 170° 

Backscatter shutter ..........................  Changes angular integration from 
7 to 170° to 90 to 170° 
(Models 3561 and 3563 only) 

Reference shutter .............................  Allows measurement of light 
intensity of a reference object 
illuminated by main lamp or of 
photodetector's dark signal 

Filtered air reference chopper..........  High-efficiency particle filter 
switches into sample air stream 
automatically on host computer 
demand or at intervals selected by 
user 

Response time ..................................  <10 sec 

Recommended flowrate ....................  20 to 200 L/min 

Inlet/Outlet Dimensions ..................  25 mm diameter 

Particle transport efficiency ............  >95% of unit-density particles 
from 0.05 to 5 µm in diameter 

(continued) 
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Table A-1 
Specifications for the Nephelometer Sensor (continued) 

Temperature and pressure sensors... Built-in sensors allow corrections 
for changes in the Rayleigh-
scattering coefficient of air within 
sample volume 

Humidity sensor................................ Measures relative humidity of 
sample from 5 to 95% ±5% 

Time and date ................................... Provided by internal, real-time 
clock with battery backup 

Vacuum integrity .............................. <10 mm Hg/hr at a negative 
pressure of 700 mm Hg (not 
including optional blower) 

Dimensions........................................ 1100 mm × 300 mm × 250 mm 
(43 in. × 12 in. × 10 in.) 

Weight................................................ <18 kg (<40 lb) 

Power requirements .......................... Operates on 24.0 ±4.0 VDC at 
<5.0 A (125 W maximum), 
supplied by power supply 
(included) 

Environmental conditions ............... Indoor use 
Altitude up to 2000 m (6500 ft) 
Ambient temperature 5–40°C  
Ambient humidity 0–90% RH  
  noncondensing 
Overvoltage category II 
Pollution degree II 

 
 
 
Table A-2 
Specifications for the Power Supply 

Output .............................................  24.0 ±4.0 VDC at <5.0 A 

Dimensions......................................  300 mm × 150 mm × 100 mm 
(12 in. × 8 in. × 5 in.) 

Weight..............................................  <5 kg (<11 lb) 

Power requirements ........................  85–260 VAC, 50–60 Hz at <100 W 

Fuse (not replaceable by user) ...........  ~F 7A FB/250V 
(Internal—not accessible by operator) 

TSI and the TSI logo are registered trademarks of TSI Incorporated. 
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Schemat ics  

C-1 

This appendix contains the following drawing and schematics: 

❑  Nephelometer sensor connectors 

❑  9060583, revision B, 1 sheet 

❑  9060584, revision B, 1 sheet 

❑  9060585, revision B, 4 sheets 

❑  9060586, revision A, 1 sheet 

❑  9060587, revision B, 1 sheet 

❑  9060601, revision D, 3 sheets 
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A P P E N D I X  D  

Windows Program 
Fi les  

D-1 

The program files required for the Windows version of the 
Nephelometer software are described below.  
 
Note: In addition to these files, your directory will also contain data 

files and possibly other files. 
 
The .vbx and .dll files are support files required for program 
operation. The .vbx files are: 
 

 cmdialog.vbx 
cschk.vbx 
cscmd.vbx 
cscombo.vbx 
csdialog.vbx 
csform.vbx 
csgroup.vbx 

csopt.vbx 
csspin.vbx 
cstext.vbx 
graph.vbx 
mscomm.vbx 
ssdata2.vbx 
threed.vbx 

 
The .dll files are: 
 
gswdll.dll 
qpro200.dll 
vbrun300.dll 
 
The .exe files are required for program execution. The .exe files are: 
 
gsw.exe Required for graphical display. 
nephmain.exe The main execution file for the program. 
 
The .dat files are data files. The only two data files provided with 
the program are: 
 
nephcnfg.dat The current Nephelometer configuration 

information. 
rayscat.dat 
 
sample.dat The sample log data file. 
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Reader ’s  Comments

Please help us improve our manuals by completing and returning this questionnaire to the address
listed in the “About This Manual” section. Feel free to attach a separate sheet of comments.

Manual Title                                                                               P/N                      Rev.     

1. Was the manual easy to understand and use?

❑ Yes            ❑ No

Please identify any problem area(s) ____________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

2. Was there any incorrect or missing information? (please explain) ________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

3. Please rate the manual according to the following features:

Good Adequate Poor
Readability ❑ ❑ ❑

Accuracy ❑ ❑ ❑

Completeness (is everything there?) ❑ ❑ ❑

Organization (finding what you need) ❑ ❑ ❑

Quality and number of illustrations ❑ ❑ ❑

Quality and number of examples ❑ ❑ ❑

Comments: ___________________________________________________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

4. Which part(s) of this manual did you find most helpful? ________________________________________

_______________________________________________________________________________________________

_______________________________________________________________________________________________

5. Rate your level of experience with the product:

❑ Beginning ❑ Intermediate ❑ Expert

6. Please provide us with the following information:

Name _____________________________________ Address _________________________________________

Title ______________________________________ __________________________________________

Company _________________________________ __________________________________________
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